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Introduction 

Microsoft was committed to making Office for Mac 2011 a significant improvement 
over previous versions. To that end, the company focused on collaboration, com-
patibility, and ease of use, and laid out a four-pronged approach: 

• Incorporate features from Office 2007 that were not added to Office 2008 
for Mac. 

• Incorporate Office 2007 features that did not get added, as well as the lat-
est updates to those features that were made in Office 2010. 

• Incorporate the new features introduced in Office 2010 for maximum com-
patibility. 

• Add new features to Office for Mac 2011 that are unique to it. 
Additionally, Microsoft had the goal of making Office for Mac truly Mac-like. Mac BU 
(Mac Business Unit), the Microsoft team responsible for developing Office for Mac, 
consists of team members who are really Mac users. They personally know and 
understand what Mac users want and consistently seek out and use customer 
feedback to identify, prioritize, and improve Office specifically for Mac users. 
In my opinion, Microsoft met and exceeded its goals with this release. It achieved a 
high degree of parity between the PC and Mac versions while integrating uniquely 
Mac functions, such as the Spotlight. Users who must switch between platforms will 
find the majority of the tasks they need to perform on a daily basis to be nearly 
identical. 
If I had to point to the most outstanding achievements in this release of Office, I 
would name Outlook and the return of Visual Basic for Applications (VBA). Although 
the Mac version of Outlook doesn't have every single feature as the PC version, at 
least Mac users are fully integrated into systems that use Exchange Server now. 
Programmers who use VBA to design full-blown applications that sit on top of Office 
are ecstatic about VBA's return. Office 2008 for Mac dropped VBA completely, 
making all previously designed VBA applications useless. 
For nonprogrammers and non-Exchange users, I point to the suite-wide implemen-
tation of the ribbon as the most impressive achievement. Features with rich func-
tionality, previously buried in the menu system, bubble up to the top in the ribbon 
where users can see them and use them more easily. The ribbon evolved from the 
Elements Gallery in Office 2008 but now includes many more features (on a par 
with the ribbon from the Windows version of Office). The collaboration features take 
a very close second to the ribbon—only because collaboration is not a necessity for 



a large number of users. If reviewed on merit alone, the collaboration features are 
wonderfully easy to use and fill a great need in the editorial process. Now using col-
laboration on SharePoint or SkyDrive, there is only one version of a file—no more 
Proposal-Final.docx, Proposal-Final-2.docx, or Proposal-Really-the Final-One.docx. 

How This Book Is Organized 
This book introduces you to the Office for Mac 2011 applications, including Word, 
Outlook, PowerPoint, and Excel, and shows you how to use the most prominent 
features of each. It's a lot to cover in so few pages, but I cover the functions in each 
application that will make you productive the fastest. 
Using Microsoft Office for Mac 2011 is broken into five sections: one section for 
each of the four applications and a fifth section that teaches you how to use the col-
laboration features of Office. For Word, PowerPoint, and Excel, each section in-
cludes an introductory chapter to make you comfortable with the basics and 
subsequent chapters that teach you how to enhance your work and use productivity 
tools. The Exchange section covers E-mail, Contacts, Calendar, Tasks, and Notes. 
In the book, I provide you with the following: 

• Basic concepts for novice users 
• More advanced information for experienced users 
• My personal recommendations for how to do things 
• Real-life examples to help you understand the usefulness of features 
• Explanations of why you do something and not just how to do it 

Using This Book 
This book enables you to customize your own learning experience. The step-by-
step instructions in the book give you a solid foundation in using Office for Mac 
2011, while rich and varied online content, including video tutorials and audio side-
bars, provide the following: 

• Demonstrations of step-by-step tasks covered in the book 
• Additional tips or information on a topic 
• Practical advice and suggestions 
• Direction for more advanced tasks not covered in the book 

Here's a quick look at a few structural features designed to help you get the most 
out of this book: 

• Chapter overview: At the beginning of each chapter is a brief summary of 
topics addressed in that chapter. This overview enables you to quickly see 
what is covered in the chapter. 



• Notes: Notes provide additional commentary or explanation that doesn't fit 
neatly into the surrounding text. Notes give detailed explanations of how 
something works, alternative ways of performing a task, shortcuts, work-
arounds, ways to avoid pitfalls, and cautions. 

• Cross-references: Many topics are connected to other topics in various 
ways. Cross-references help you link related information together, no mat-
ter where that information appears in the book. When another section is re-
lated to one you are reading, a cross-reference directs you to a specific 
page in the book on which you can find the related information. 

  

LET ME TRY IT 

Tasks are presented in a step-by-step sequence so you can easily follow along. 
 

SHOW ME  Media—This Is a Show Me 

Video walks through tasks you've just got to see, including bonus ad-
vanced techniques. 

TELL ME MORE  Media—This Is a Tell Me More 

Audio delivers practical insights straight from the experts. 

Special Features 
More than just a book, your Using product integrates step-by-step video tutorials 
and valuable audio sidebars delivered through the Free Web Edition that comes 
with every Using book. For the price of the book, you get online access anywhere 
with a web connection—there are no books to carry, content is updated as the tech-
nology changes, and you receive the benefit of video and audio learning. 

About the Using Web Edition 
The Web Edition of every Using book is powered by Safari Books Online, ena-
bling you to access the video tutorials and valuable audio sidebars. Plus, you can 
search the contents of the book, highlight text and attach a note to that text, print 
your notes and highlights in a custom summary, and cut and paste directly from Sa-
fari Books Online. 
To register this product and gain access to the Free Web Edition and the audio and 
video files, go to quepublishing.com/using. 

 



1 In this chapter, you take a tour of Word's window, 
learn how to create and e-mail a document, and set 
the preferences for Word. 

Getting Started with Word 
Word! There it is. For good or ill, it's the undisputed king of the word processing 
world. Now the Mac version is no longer the pretender to the throne of its  
Microsoft brother, but a full-fledged joint ruler. Let's examine the royal pedigree. 

This chapter covers the application window; basics tasks of creating, saving,  
e-mailing, and printing a document; and some of the Word preferences I recom-
mend you set right away. 

Selecting a Document Template 
When you start Word, the Word Document Gallery, shown in Figure 1.1, opens 
by default. This window enables you to select a template for the document you 
want to create. Word has templates for all types of documents, such as calen-
dars, invitations, posters, flyers, catalogs, newsletters, brochures, fax cover 
sheets, and so on. 

To select a template, first select the category in the Templates pane on the far 
left, click the template you want to use in the middle pane, and click the Choose 
button. Word names the new document Document1 for you, but you can give it a 
more appropriate name when you save the document. 

If you don't think you want to be bothered with the Document Gallery, you could 
click the Don't Show This When Opening Word check box at the bottom of the 
screen. The next time you start Word, the Word Document Gallery will not open, 
and Word will create a document for you automatically. 

 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

If you have turned off the Word Document Gallery, you can turn it 
back on by setting a preference. See the "Setting the Word Docu-
ment Gallery Preference" section later in this chapter. 



 
 
 
 
 
 
 
 
 
 
 

 

Figure 1.1 The plain, vanilla Word document template is called, surprisingly enough, 
Word Document. 

 

 
 

Exploring the Word Window 
Before you start using Word to type a document, you might need to take a short 
tour of the Word window. It's designed to give you information about your docu-
ment and make commands available to you. Word does this with a number of dif-
ferent screen elements, most of which can be turned on or off. 

Before starting the tour, if you want your screen to match Figure 1.2, click the 
Print Layout View button in the lower-left corner. Then you can refer to the figure 
as the tour takes you from the top of the screen and moves down. If your screen 
doesn't display all the elements described, don't worry; the element just hasn't 
been turned on in the View Preferences. (You learn how to set these preferences 
later in this chapter.)  

At the top of the window, you can see the Word menu bar. It displays in the Mac 
menu bar, as all good little Mac applications do. (On a Mac, you never have 
more than one menu bar displaying at a time. Only the current application's 
menu is displayed.) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 

Figure 1.2 The print layout view shows more screen elements than any other view. 

 

The title bar, which displays the name of the current document, is below the 
menu bar. This bar also contains the red, yellow, and green buttons that close, 
minimize, and zoom the Word window. 

The toolbar area is just under the title bar. It can expand to display two toolbars, 
each on a separate line. 

An element called the ribbon is located just below the toolbar area. Of all the 
screen elements, it's definitely the dominant one. You learn more about the rib-
bon later in this chapter. 

Below the ribbon is the horizontal ruler that displays the indents and tabs. The 
vertical ruler appears on the left side of the screen, but it displays only in the print 
layout view. 

The vertical scroll bar appears on the right side of the screen. At the bottom of 
the bar are two navigation buttons for scrolling up and down in the document and 
the Browse Object control. 

 To learn more about using the Browse Object control, see "Using Browse 
Objects" in Chapter 2, "Editing Documents." 



Across the bottom of the screen is the horizontal scroll bar, which appears only 
when necessary and, therefore, is not shown in Figure 1.2. Below that is the 
status bar, which contains the view buttons on the far left, followed by various 
document information and status indicators (discussed later in this chapter), and 
the zoom control on the far right. 

Touring the Menus 
I'm going to spare you a long discussion of the menu bar because I assume you 
didn't just fall off the turnip truck. (Bless your heart, as we say in the South.) I will 
say that the menu bar changes slightly when you use different templates. For 
example, if you use the Calendar template, a new menu option called Calendar 
appears on the menu bar. 

 

 

 
 

 

The only specific menu I'm going to call your attention to is the Script menu. 
That's the one represented by the three-dimensional "S" just to the left of the 
Help menu, as shown in Figure 1.3. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

Figure 1.3 The Script menu contains Automator workflows. 

 
 

If you're upgrading from a version of Word or Office for Mac that predates the 
2008 version, you've never seen this menu before. It contains Automator work-
flows. Office comes with a library of Automator workflows, which, similar to  
macros, perform repetitive tasks. The Word workflows are preloaded for you on 
the Scripts menu, and you can create your own workflow to add to the menu. 

If you'd like to learn more about Automator workflows, listen to the audio file I've 
recorded for you. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Menus are also good sources for finding keyboard shortcuts. Many 
commands list their shortcuts on the right side of the menu.  



TELL ME MORE  Media 1.1—Creating Automator Workflows 
Access this audio recording through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

Getting Familiar with the Toolbars 
By default, Word displays only the Standard toolbar. This toolbar contains tools 
for commands you use in the general course of creating and editing a document: 
Save, Copy, Cut, Paste, Undo, Redo, and so on. The only other toolbar that  
exists in Word 2011 is the Formatting toolbar. If you turn it on, it displays on a 
second line under the Standard toolbar. 

Getting Familiar with the Ribbon 
The ribbon is like a toolbar on steroids, containing all the tools that previously 
appeared on individual toolbars in earlier versions of Office. If you are upgrading 
from Office for Mac 2008, you'll notice the similarity between the Elements  
Gallery (now passé) and the ribbon. 

The ribbon contains tabs that have tools for specific uses. To access the tools, 
you click the appropriate tab at the top of the ribbon. For example, if you click the 
Layout tab, the ribbon displays tools to set the page orientation, page size, mar-
gins, background colors, and so on. The Home tab on the ribbon displays all the 
tools found on the Formatting toolbar and then some, effectively rendering the 
Formatting toolbar useless, unless you don't want to use the ribbon at all. (If 
that's the case, you can turn it off completely by choosing View, Ribbon.) 

If you want to use the ribbon, but it takes up too much room on the screen, you 
can easily minimize it to just the tabs and expand it again when you want to use 
it. To minimize the ribbon, click the current tab. To expand the ribbon, click any 
tab. Alternatively, you can click the caret icon on the far right side of the ribbon 
bar to minimize it. When the ribbon is minimized, the icon changes to a "V." If 
you click the V, the ribbon expands. 

After you start creating documents, you will notice that the ribbon is intuitive. If 
you insert a table, for example, a new tab named Table Layout appears on the 
ribbon. The ribbon doesn't open that tab automatically but draws your attention to 
it by coloring it light purple. Then, if you want to use the tools on that tab, you can 
click the tab to display them. 



Changing the View 
Word 2011 has six buttons on the status bar that change the view of the docu-
ment and one option available only on the View menu. Each view has features 
that are useful in different situations. Table 1.1 describes the views and when to 
use them. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Table 1.1 Using Views 

View Description 

Draft This view does not display unused whitespace on the page such 
as the margins at the top, bottom, and sides of the page. Addition-
ally, it does not display the header or footer, or floating graphics. 
Use this view when you need to see the maximum amount of text 
possible. 

Outline In this view, you can create an outline using tools that help you 
assign levels to your outline headings, collapse and expand sec-
tions, promote or demote headings, as well as move entire sec-
tions with the least amount of effort. The outline view is also useful 
for viewing documents created with heading styles (Heading 1, 
Heading 2, and so on), which, by default, have hierarchical levels 
assigned. Using this view, you can quickly review the structure of a 
document that uses headings and subheadings. For example, you 
could check a document in the Outline view to be sure that you 
have at least two subheadings for each heading.  

Publishing Layout Use this view for documents that you format with a publishing tem-
plate such as a brochure or newsletter. If you click this view button 
in a document that is not a publishing type document, Word asks if 
you want to create a new publishing document or edit the current 
document in publishing layout view. This view contains desktop 
publishing tools on the ribbon's Layout tab that are not included in 
other views.  

Print Layout The print layout view shows the document as it will look when it 
prints. It displays the margins, unused space on a page, graphics, 
headers, and footers, as well as a visual page break between 
pages.  

Notebook Layout This view is available only for documents that you format with the 
notebook template. If you click the NotebookLayout View button in 
a document that is not a notebook, Word asks if you want to con-
vert the current document to a notebook or create a new document 
formatted as a notebook. If you convert the current document, 
some existing formatting may be lost. This view presents your 
document on the screen visually as a bound notebook with sec-
tions. In this view, you can take notes, flag items, and record audio 
notes.  

Full Screen The full screen view hides all screen elements except the docu-
ment and displays across the top of the screen a toolbar that en-



ables you to work in Write or Read mode. You can press the Esc 
key to exit this view. 

Web Layout This view is sort of a leftover from the old days when you could use 
Word as a web browser. It's the one that is accessible only from 
the View menu. You can use it to view or create HTML documents, 
but here's a tip: Don't even think about creating HTML documents 
in Word!  

. 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 1.4 shows the difference in the amount of text that you can see in the draft 
view versus the print layout view. Notice that the draft view doesn't show the 
header or footer, whitespace, or the graphic. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Figure 1.4 Use the draft view to see more text, but use the print layout view when 
you want to see how the document will look when printed. 

 

Figure 1.5 shows the same document in the outline view. Notice that the head-
ings are indented like an outline, and the graphic doesn't show in this view either. 

Figure 1.6 shows the publishing layout and notebook views. They look similar 
because both views have a workspace that the document or notebook sits on. 
You can easily recognize the notebook view, however, because the document 
actually looks like a notebook. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 1.5 Use the outline view to create an outline or quickly review the structure of 
a document created with heading styles. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Figure 1.6 You can customize the workspace in both the publishing layout and the 
notebook views. 



Deciphering the Status Bar 
The appearance of the status bar changes depending on the view you are using; 
however, all views display the view buttons on the far left. The name of the view 
you are currently using also displays as the first piece of information on the sta-
tus bar. 

In the draft, outline, and print layout views, the status bar contains the following 
document information: 

▪ The current section number of the document 

▪ The current page number and total number of pages 

▪ The number of the current word (where the insertion point is) and the total 
number of words in the document 

▪ The status of spelling errors 

▪ The zoom percentage 

In the publishing layout and notebook views, a small subset of the preceding in-
formation displays in the status bar in addition to special buttons that apply only 
to the specific views. 

In the full screen view, there is no status bar displayed at all! 

Viewing Other Screen Features 
Three more screen features deserving mention are the Toolbox, the Sidebar, and 
the Media Browser. Figure 1.7 shows all three of these features. 

▪ Toolbox—The Toolbox has five tabs: Styles (shown in Figure 1.7), Cita-
tions, Scrapbook, Reference Tools, and Compatibility Report. To open the 
Toolbox, click View and click the name of the tab you want. Each tab has a 
different function; most are explained in later chapters as needed. 

▪ Sidebar—The Sidebar can display the Document Map pane, the Thumb-
nail pane (shown in Figure 1.7), the Reviewing pane, or the Search pane. 
To open the Sidebar, click View, Sidebar, and then click the pane you want 
to view. Each pane has a different purpose, and most of them are ex-
plained in later chapters as needed. 

▪ Media Browser—The Media Browser has six tabs: Photos, Audio, Movies, 
Clip Art, Symbols, and Shapes. To open the Media Browser, click View, 
Media Browser. The Media Browser groups media of different kinds in one 
place so you can insert them easily in your documents. 



 

 

 To learn more about using the Media Browser, see "Inserting Media from 
the Media Browser" in Chapter 6, "Creating Documents for Publication." 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 1.7 It is doubtful you would display the Sidebar, Toolbox, and Media Browser 
at the same time because they take up so much screen real estate. 

 

Working with Documents 
Now that you've had the tour, you're ready to work with documents. This section 
looks at the most rudimentary tasks that deal with documents: creating, saving, 
printing, and e-mailing. 

Creating a New Document 
At the beginning of this chapter, you learned that Word automatically creates a 
new document for you when you open the application. You determine the type of 
document when you select a template from the Word Document Gallery. 



If you don't have the Word Document Gallery activated, Word creates a "normal" 
document (that is, it uses the Word Document template). If you don't want to use 
a normal document, you can create a different kind of document from within 
Word and then close the normal document. This is a little more trouble than sim-
ply selecting the exact type of document you want to begin with, which is why I 
recommend you continue to use the Word Document Gallery if you regularly cre-
ate documents from different templates. 

  

LET ME TRY IT 

Creating a Different Type of Document from Within Word 
To select a different type of document to create, follow these steps: 

1. Click File on the menu bar and click New from Template, click the New 
from Template button (shown in Figure 1.8), or press Shift-Cmd-P. The 
Word Document Gallery opens. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Figure 1.8 The New from Template button is on the Standard toolbar. 

 
 
 
 

2. Select the category in the left pane, and in the middle pane, click the tem-
plate that you want. 

3. Click the Choose button. 

Word keeps each document that you create in its own window, and you can have 
multiple windows open at the same time. 

Saving a Document 
I recommend saving a new document very soon after you create it. I like to type 
the title of the document first, if it has one, and then save it because Word auto-
matically uses the first few words in a document as the suggested name for the 
document when you save it. 

 
 
 
 
 
 
 
 
 
 
 
 
  



LET ME TRY IT 

Saving a Document for the First Time 
To save a document for the first time, follow these steps: 

1. Click File, Save, click the Save button in the Standard toolbar, or press 
Cmd-S to open the Save dialog box shown in Figure 1.9. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 1.9 You can expand the Save dialog box to show the Finder. 

 

2. Type a name for the document in the Save As text box or accept the sug-
gested name. 

3. If your dialog box looks like Figure 1.9, click the button to the right of the 
Save As text box so the "mini-Finder" replaces the Where text box, as 
shown in Figure 1.10. 

4. Navigate to the location where you want to save the file or click the New 
Folder button, type a name for the new folder, and click Create. 

5. Click the Format pop-up button if you need to select a format that makes 
the document compatible with older software, or if you just need to save the 
document in a special format, such as an earlier version of Word. 

 

 

 
 

6. Click Save. 
 
 
 
 
 

If you see a red warning about compatibility issues in the Save dialog box, 
click the Compatibility Report button. A window opens with a report, as 
shown in Figure 1.11. Select an issue to see an explanation, and then fix 
the issue if possible. 



 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

Figure 1.10 The expanded dialog box uses the Finder format to make all locations on 
the Mac accessible. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Figure 1.11 The Compatibility Report window lists issues that you can fix or ignore. 

After you save a document for the first time, it's a good idea to continue saving it 
as you work on it. Even though, by default, Word saves an AutoRecovery file for 
you every 10 minutes, this is not a substitute for saving the document yourself. 



The AutoRecovery file is not the actual file you are working on. It's a temporary 
file that Word uses to recover the file you're working on if Word shuts down un-
expectedly or gets hung up and causes you to have to force quit. To save a file 
that has been saved before, just click the Save button in the Standard toolbar or 
press Cmd-S. 

Printing a Document 
You might think that printing a document is a simple topic, but Word offers quite 
a few print features that you should know about. First, consider the fact that you 
can quickly print one copy of the current document by clicking the Print button in 
the Standard toolbar. If you have several printers attached to your Mac, Word 
sends the document to the one you have specified as the default printer. If you 
don't remember which one that is, you can point to the button to see a ScreenTip 
telling you which printer Word is going to send the document to before you click 
the button (see Figure 1.12). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Figure 1.12 The ScreenTip tells you which printer Word is going to use. 

 

If you want to print a document using a different printer, or you want to print more 
than one copy, you should use the Print command. The Print command displays 
the Print dialog box, which has many different options in it. 

 

SHOW ME  Media 1.2—Printing a Document with the Print  
Command 
Access this video file through your registered Web Edition at 
my.safaribooksonline.com/9780132174718/media. 

  

LET ME TRY IT 

Printing a Document with the Print Command 
To print a document using the Print dialog box, follow these steps: 

1. Open any document. 



2. Click File on the menu bar, and then click Print or press Cmd-P to open the 
Print dialog box, as shown in Figure 1.13. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 1.13 This Print dialog box is "collapsed." Figure 1.14 shows the expanded  
dialog box. 

 

3. Click the Printer pop-up button to display the list of printers installed on 
your Mac and select the printer you want to use. 

4. If necessary, click the button to the right of the Printer drop-down menu to 
expand the Print menu, as shown in Figure 1.14. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 1.14 After you expand the Print dialog box, it remembers this setting and dis-
plays the expanded view every time you use it. 

 



5. In the Copies & Pages section, enter the number of copies that you want to 
print. Notice that the Collated check box is checked by default. If the docu-
ment has several pages and you print more than one copy, Word prints one 
complete copy of the document at a time. In other words, it does not print 
multiple copies of the first page, followed by multiple copies of the second 
page, and so on. 

6. In the Pages section: 

▪ Print the entire document by selecting All. 

▪ Print the page that the insertion point is on by selecting Current Page. 

▪ Print a range of pages by entering a starting and ending page in the 
From and To fields. 

▪ Print nonconsecutive pages or more than one range by entering the 
page numbers or ranges separated by commas. (For example, to print 
pages 1 through 3 as well as 6 and 9 and pages 12 through 15, you 
would enter 1–3, 6, 9, 12–15. Although entering the pages in order might 
be most logical, it is not necessary.) 

7. Scroll through the Quick Preview if you want to see the document one last 
time before you print it. 

8. Click Page Setup to set the options shown in Figure 1.15, including the pa-
per size, orientation, and scale. Click OK when finished. 

9. Click Print to send the document to the printer. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 1.15 Go to the Page Setup dialog box when you want to change the orienta-
tion of the printed page. 

 



Taking a Closer Look at the Incredible Print Dialog Box 
Even though the previous task had nine steps, this description has only 
scratched the surface of what the print dialog box can do for you. Much of the 
functionality of the dialog box is buried in the third menu control, which defaults 
to Copies & Pages. If you click the pop-up button on this control, you see some-
thing similar to the options displayed in Figure 1.16. (Different printers may dis-
play different options.) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 1.16 Fine-tune the printing of your document to the nth degree with these  
options. 

The Microsoft Word option enables you to specify what you want to print, to print 
odd or even pages, and to set Print preferences, as shown in Figure 1.17. The 
Print What pop-up menu has some interesting options, explained in Table 1.2. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 1.17 The Microsoft Word option in the Print dialog box has options for printing 
more than just a document. 



Table 1.2 Print What Pop-Up Menu Options 

Option Description 

Document Prints the current document. 

Document Properties Prints the information in the Properties dialog box, includ-
ing the document type, location, size, creation date, last 
modification date, attributes, number of revisions, total 
editing time, number of words, number of pages, and so 
on.  

Document Showing Markup Prints the document with all comments that have been 
added and all revisions that have been made with Track 
Changes activated. If a document has revision marks, 
this is the default option for printing the entire document. 
For more information about the Track Changes feature, 
see Chapter 16, "Using Review Features." 

List of Markup Prints a list of all revisions that have been made with 
Track Changes activated. Word also prints the name of 
the person who made the revision or comment.  

Styles Prints a list of all styles used in the document and the 
attributes of each style. For more information about using 
styles, see Chapter 3, "Formatting Documents." 

AutoText Entries Prints all the AutoText entries that have been saved in 
the file. See "Using AutoText" in Chapter 4, "Exploring 
Other Features," to learn more about AutoText entries. 
For more information about the AutoText feature, see 
Chapter 4. 

Key Assignments Prints a list of all key assignments you assign to macros 
that have been saved in the file. See Chapter 4 to learn 
more about macros. 

The Layout option, among other things, enables you to specify the number of 
pages per sheet to print and the order in which the pages should print on the 
page. In Figure 1.18, the settings are four pages per sheet and the direction is up 
and down, left to right. 

Additional options may include the following (depending on the printer): 

▪ Color Matching—Enables you to select the color profile that your printer 
should use. 

▪ Paper Handling—Includes options for the order in which pages should 
print and the option to scale the page to fit the paper size. 

▪ Paper Feed—Enables you to specify which pages print from which paper 
trays. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 

 

Figure 1.18 The Two-Sided option is not available unless your printer has duplexing 
capability. 

 

▪ Cover Page—Enables you to print a cover page (before or after a docu-
ment) and include billing information. The title at the top of the cover page 
is determined by the type of cover page you select (standard, classified, 
confidential, secret, top secret, and unclassified), and the other information 
on the cover page includes the print job ID, the title of the document, your 
initials, the print from location, and billing information (if you have specified 
any). 

▪ Scheduler—Enables you to specify a time that the document will print and 
to set a priority (which is important if other users are also sending docu-
ments to the same printer). 

▪ Color/Quality or PaperType/Quality—Includes options for paper type, 
resolution, and printing in color or black and white. 

▪ Finishing—Enables you to specify the paper path. 

▪ Supply Levels—Shows the level of ink or toner remaining in the printer. 

▪ Summary—Lists all the options you have selected for Color Matching, Pa-
per Handling, Paper Feed, and so on, as shown in Figure 1.19. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 1.19 Clicking the arrow for a Setting shows the choices that you have made in 
the Value column. 

 
 

E-mailing a Document 
One of the features that I have always liked about Word is the ability to e-mail the 
currently open document right from within Word. You can send it as an attach-
ment or as HTML. 

 

SHOW ME  Media 1.3—E-mailing a Document 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

  

LET ME TRY IT 

E-mailing a Document 
To send the current document in an e-mail message, follow these steps: 

1. Click File on the menu bar, and then click Share. 

2. Select E-mail (as Attachment) or E-mail (as HTML). 

3. Address the e-mail message that opens, type a subject, add text to the 
message as needed, and click the Send button. Return to Word to continue 
working. 

 

 



 
 

Creating Special Documents from Templates 
Templates are preformatted documents that you can use to create a specific kind 
of document that may be more complicated than you would ordinarily want to 
tackle on your own. Chapter 6, "Creating Documents for Publication," covers 
many of the publishing templates, but in this chapter, just as an introduction, you 
look at creating a calendar from a template. 

 

SHOW ME  Media 1.4—Creating a Calendar from a Template 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

  

LET ME TRY IT 

Creating a Calendar from a Template 
I can't remember birthdays to save my life, so creating a monthly calendar is a 
must for me. To create a calendar from a template, follow these steps: 

1. Click File, New from Template. The Word Document Gallery opens. 

2. Click Calendars in the Templates sidebar, and then click the style you want 
to use in the middle pane. 

3. Click the Colors pop-up in the right sidebar and click a color palette, such 
as Breeze. The thumbnail in the right sidebar updates to show the color 
combination that you selected. 

4. Click the Fonts pop-up in the right sidebar and select the font you want to 
use. The thumbnail of the calendar in the right sidebar updates to show the 
font you selected. 

5. Click the Choose button. The Select Calendar Date dialog box opens. 

6. Select the Month and Year and click OK. An information box opens, telling 
you how to select new dates. Click OK. 

Several of the preloaded workflows, found on the Script menu, also 
interact with e-mail. You can send a PDF or HTML version of the 
document in e-mail or send selected text from the document in a 
message. 

 



7. If the calendar template that you selected has a photo in it, click the Media 
Browser button in the Standard toolbar to access your photos. Click the 
Photo tab, if necessary, and drag a photo to a photo placeholder. 

8. If the calendar template has a text placeholder, click it and enter your own 
text. 

9. On the calendar grid, click in a box for a specific date and type a birthday, 
appointment, event, and so on. 

 

 

 
 

 

10. Save and print the file. 

Setting Preferences for Word 
Preferences are very important on a Mac. They determine how an application 
works and how it looks. When you install Office 2011 for Mac, predetermined 
preferences are loaded, but you can change them so the applications behave the 
way you want them to. 

Exploring the Preferences Dialog Box 
The Word preferences in the Preferences dialog box, shown in Figure 1.20, are 
divided into three categories: Authoring and Proofing Tools, Output and Sharing, 
and Personal Settings. Each category has several options. When you have some 
time, you should look at each one of the options in each category just to familiar-
ize yourself with what's available for your customization. 

To select an option in any category, click the icon. To go back to viewing all the 
options, click the Show All button in the toolbar. 

 
 
 

When you need to set a preference but you're not sure where it is, 
just type a search word in the Spotlight text box in the upper-right 
corner. Word highlights all the options that relate to the search 
phrase and even shows you a list of possible preferences that you 
might want to select. 

Press the Tab key to go to the next box in the row. If you are in the 
last box in a row (Saturday), pressing Tab moves you to the first 
box in the next row, but watch out! It also selects the date. You 
should click under the date before you start typing. 



 
 
 
 
 
 
 
 
 
 
 
 

 
 

Figure 1.20 The Preferences dialog box can be a little overwhelming, but the Spot-
light can help you find things quickly. 

 
 

Setting a Few Preferences 
Before you start exploring all the preferences, let me recommend a few that you 
should look at first. The particular preferences that I want to call your attention to 
are in the General, View, and Save categories. 

  

LET ME TRY IT 

Setting the Word Document Gallery Preference 
If you want to take my advice about using the Word Document Gallery, and you 
have already turned it off, you can turn it on again by following these steps: 

1. Click Word on the menu bar and click Preferences to open the Preferences 
dialog box. 

2. Click General in the Authoring and Proofing Tools row. 

3. Click the Open Word Document Gallery When Application Opens check 
box to enable this option. (The check box should be blank if you have dis-
abled the Gallery previously.) 

4. Click OK or click the Show All button to go back to the Word Preferences 
dialog box. 

The View preferences I want you to set are for Nonprinting Characters and Win-
dow. Nonprinting characters are the symbols for tabs, paragraphs, spaces, and 



 

so on. Often it is helpful to have some of these nonprinting characters visible on 
the screen while you are working. The Window preferences display or hide 
screen elements, such as the status bar, live word count, and the vertical ruler. 

  

LET ME TRY IT 

Setting the View Preferences 
To set View preferences, follow these steps: 

1. Click Word on the menu bar and then click Preferences to open the Prefer-
ences dialog box. 

2. Click View in the Authoring and Proofing row to open the preferences 
shown in Figure 1.21. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Figure 1.21 By default, none of the nonprinting characters display. 

 
 
 
 
 
 

3. Click the check boxes for the nonprinting characters that you want to see 
on the screen while you are working. I personally like to see the paragraph 
marks, but I don't like seeing the spaces. 

 

 To learn more about the nonprinting characters called "hidden text," see 
"Formatting Characters" in Chapter 3, "Formatting Documents." 



 

4. Click the check boxes for the Window options you want to display. I like to 
display all the screen elements, but I don't select Wrap to Window or spec-
ify a width for the Style Area. 

 

 To learn more about the Style Area, see "Applying Styles" in Chapter 3. 

5. Click OK or click the Show All button to go back to the Word Preferences 
dialog box. 

The AutoRecover preference is preset for you at an interval of 10 minutes. If you 
do a lot of typing in 10 minutes (as I do) and your electricity goes out a lot (as 
mine does), you might want to set the AutoRecover to an interval of 5 minutes 
(as I have). 

  

LET ME TRY IT 

Setting the Save AutoRecover Frequency 
There is really no advantage that I can see to increasing the interval of the Auto-
Recover, but if you want to decrease the interval, which I think is a very good 
idea, follow these steps: 

1. Click Word on the menu bar and then click Preferences to open the Prefer-
ences dialog box. 

2. Click Save in the Output and Sharing row. 

3. Decrease the number of minutes in the Save AutoRecover Info text box. 

4. Click OK, or click the Show All button to go back to the Word Preferences 
dialog box. 



2 Learn the techniques to navigate and preview  
a document, as well as delete, copy, move, 
find/replace text, and check your spelling.

Editing Documents 
If you've ever typed even one document in Word, you know that part of the crea-
tion process is editing. This chapter tells you how to navigate a document using 
several different methods, select text, find and replace text, copy and move text, 
and check the spelling and grammar in the document. 

Navigating 
Moving around in a document quickly is a key factor in being able to edit a doc-
ument efficiently. Sometimes you simply want to scroll the document itself to see 
different locations, but other times you actually want to move the insertion point 
so that you can make an edit at a specific location. 

Before I continue, I probably need to clarify three terms used frequently in this 
chapter. The insertion point is the vertical bar that always follows your typing. 
Some people also refer to this symbol as the cursor, but I always refer to it as the 
insertion point. 

The term cursor is also used interchangeably with the term pointer, which refers 
not to the insertion point, but to the symbol that floats over your document and is 
controlled by the mouse. For clarity, I always refer to this as the pointer. 

Sometimes, the pointer takes the shape of an I-beam, a single-headed arrow, a 
double-headed arrow, or an icon such as a pencil or eraser, depending on the 
circumstance. When you hover the pointer over text, it takes the shape of an  
I-beam, indicating that you can click in the text and the insertion point will move 
to that location. 

Word provides several techniques for navigating, including 

▪ Scroll bars 

▪ Keystrokes 

▪ Browse objects 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



▪ Window techniques 

▪ The Find command 

No matter what the situation, Word has a useful method or combination of meth-
ods that you can use to navigate the document. 

Using Scroll Bars 
You probably already know how to use scroll bars. Just to review: In the vertical 
scroll bar, you can scroll through large portions of the document by dragging the 
bubble in the bar, click the up or down arrows to move a line at a time, or click in 
the whitespace above or below the bubble in the bar to move a screen at a time. 
Remember that the scroll bars cause the pages in a document to move, not the 
insertion point. Generally, you scroll to a location in the document, point to the 
desired location, and click the mouse to position the insertion point. Also, I want 
to remind you that you can turn both the vertical and horizontal scroll bars on and 
off in the View Preferences. 

 

 

 
 

Using Keystrokes to Navigate 
Table 2.1 lists some of the most commonly used keystrokes to move around in a 
document. When you use keystrokes to navigate, the insertion point moves to a 
specific location. 

 
 
 
 
 
 
 
 
 
 
 

Table 2.1 Navigation Keystrokes 
To Move To Press 

End of the document Cmd-End 

Beginning of the document Cmd-Home 

Beginning of a line Cmd-Left Arrow 

Did you know that you also can position the up and down scroll  
arrows? They can appear either together at the bottom of the bar, 
or the up arrow can be at the top of the bar and the down arrow 
can be at the bottom of the bar. You make this setting in the  
Appearances preferences in the Apple System Preferences (not 
Word Preferences) located on the Apple menu. If you select the At 
Top and Bottom option, the left and right arrows also are split on 
the horizontal scroll bar. 



End of a line Cmd-Right Arrow 

Next word Opt-Right Arrow 

Previous word Opt-Left Arrow 

Next screen PgDn 

Previous screen PgUp 

Bottom of the current page Cmd-Opt-PgDn 

Top of the current page Cmd-Opt-PgUp 
. 
 

 
 

 
 

Using Browse Objects 
At the bottom of the vertical scroll bar is a very handy browsing tool that often is 
underused. The tool consists of a double-arrow pointing up, a Select Browse  
Object button, and a double-arrow pointing down. If you click the Select Browse 
Object button, you see a selection of objects, as shown in Figure 2.1. By default, 
the Page object is selected, so the up and down double-arrow buttons move the 
insertion point backward and forward to the top of the previous or next page. If 
you point to the double-arrow buttons, a ScreenTip that says Previous Page or 
Next Page appears. This indicates what object is currently selected for browsing.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

Figure 2.1 The browse objects include (from left to right) Go To, Find, Edits, Heading, 
Graphic, and Table, and on the second line, Field, Endnote, Footnote, Comment,  
Section, and Page. 

 

After you select an object, clicking the double-arrow buttons moves the insertion 
point to the previous or next object in the document. If, for example, you select 
Table as the object, the ScreenTips change to Previous Table and Next Table, 
and clicking those buttons takes you to the previous or next table in the  

Some Mac keyboards do not have keys labeled Home, End, Page 
Up, or Page Down, but you can use other keyboard combinations to 
get the same function.  



document. This would be helpful if you have a document that has 10 tables in it 
and you need to change the background color of the first row in each. 

 

 

 
 

 
 

SHOW ME  Media 2.1—Using Browse Objects to Navigate 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

  

LET ME TRY IT 

Using Browse Objects to Navigate 
To browse for a particular type of object in a document, follow these steps: 

1. Click the Select Browse Object button. 

2. Scroll across the objects in the palette to see the name of the object at the 
top of the palette. When you find the object you want, click it to select it. 

3. Click the up or down double-arrow button in the Browse Objects tool to 
move to the previous or next object. 

 

 

 
 

Using Window Techniques 
Now suppose you have a long document that you are editing, and you need to  
refer to the first paragraph while you are editing the last paragraph. What do you 
do? Well, you can scroll back and forth, but splitting the window is a more effi-
cient way to work. To split the window into two windows, double-click the blue 

If you click the Find object in the browse control palette, the Spot-
light field on the right side of the Standard toolbar becomes active, 
and you can type the text you want to find. If you click the Go To 
object, the Go To tab of the Find and Replace dialog box opens. In 
this dialog box, you can specify what you want to go to, such as a 
page, and then specify the exact page number. 

When you're finished using a browse object, such as the Table 
browse object, I recommend that you immediately change the 
browse object back to Page. 



button at the top of the vertical scroll bar. (Figure 2.2 shows the button.) After you 
split the window, the button moves to the bottom of the scroll bar in the upper 
window. To remove the split, double-click the button again. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 2.2 When the pointer actually touches the button that splits the window, the 
pointer changes to a double-headed arrow. 

 

 

 
 

Now suppose that you actually need to see three different locations in the docu-
ment at the same time. You can't split the window into more than two windows, 
but there is another technique you can use. You can open several windows on 
the same document by choosing Window, New Window. The title bar for each 
window shows the document name followed by a colon and a number to indicate 
which window is which. After opening several windows on the same document, 
you might want to tile them on the screen by manually sizing them and moving 
them, or you can let Word arrange them for you—choose Window, Arrange All. 

Finding and Replacing Text 
When you are editing or formatting a document, often you know the exact text 
that you want to go to in the document. Think of a printed copy of a document 
that has been edited by hand in red ink. To enter the edits in the electronic 
document, you can use the Find command to search for the specific text that has 
been edited in red ink. 

  

Changes you make in any window automatically update in the other 
windows. 



LET ME TRY IT 

Searching for Text with the Find Command 
To find a specific string of text in a document, follow these steps: 

1. Click in the Spotlight field on the right side of the Standard toolbar and type 
the text string. Word highlights all occurrences of the string in the document 
simultaneously. 

 

 

 
 

2. Go to the next or previous occurrence by clicking the right or left arrow in 
the Spotlight tool. 

3. To eliminate the highlighting of all the strings of text and exit the search 
mode, click the X in the Spotlight field. 

Sometimes you need to be a little more precise about the text you are searching 
for in a document. Perhaps you want to find only the capitalized instances of a 
word. For that kind of precision, you need to use the Advanced Find and Replace 
Command. 

 

SHOW ME  Media 2.2—Using the Advanced Find and Replace 
Command 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

  

LET ME TRY IT 

Using the Advanced Find and Replace Command 
To define a more specific search, follow these steps: 

1. Take note of the position of your insertion point and move it if you need to. 

2. Click Edit, Find, Advanced Find and Replace to open the dialog box shown 
in Figure 2.3. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

The integration of Spotlight in Word is a new feature. It's one of my 
favorite Mac features, and I've always missed it in Word. 



 
 
 
 
 
 
 
 
 
 
 

 

Figure 2.3 If your dialog box does not look like this one, click the arrow that expands 
the dialog box. 

 

3. Type the text string in the Find What text box. Note that if you select text 
before you open the Find and Replace dialog box, the text appears auto-
matically in the Find What text box. 

4. Remove the check in the Highlight All Items Found In check box (if neces-
sary) and select an option from the Search pop-up menu to specify what  
direction to search. Your options are Current Document Down, Current 
Document Up, and Current Document All. 

 

 

 
 

5. Select other options to narrow your search, such as Match Case. 
 

 

If you didn't position your insertion point correctly before starting the 
process, you should choose Current Document All. Then, Word will 
search down and circle back to the top of the document to continue 
searching. 



 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

Figure 2.4 In this search, Find looks for all highlighted occurrences of the word rental. 
 

6. Click the Find Next button to go to the first occurrence. At this point, I prefer 
to close the dialog box and use the double-arrow buttons in the Browse Ob-
jects tool to go to the next or previous occurrence. 

The Replace feature works with the Find feature to find a specified string of text 
and replace it with another specified string of text. It's very useful if you need to 
make the same correction several times in the same document. For example, 

Additionally, you can narrow the search by specifying options in 
the Find area (at the bottom of the dialog box). Here, you can 
narrow the search to text that has specific formatting, such as 
highlighting or a particular font, or you can search for special 
characters, such as paragraph marks or tab characters. 

After you make selections from the format options in the Find 
area, your choices are listed under the Find What text box at the 
top of the dialog box, as shown in Figure 2.4. If you make a se-
lection from Special, a representation of the special character is 
shown in the Find What text box (^p for paragraph marks, ^t for 
tabs, ^g for graphics, and so on). 



say you are working on a brochure for an organization called the Veterans of 
Toddler Wars (an organization for parents who have survived the "terrible twos"). 
Throughout the brochure, you have referred to the organization as the "VTW," 
but now you've decided that you should always spell out the full name. To make 
the change quickly, you can use the Replace command to find all occurrences of 
VTW and replace them with Veterans of Toddler Wars. 

  

LET ME TRY IT 

Replacing Text 
To replace specific text in a document with a different string of text, follow these 
steps: 

1. Click Edit, Find, Replace or use the keyboard shortcut Shift-Cmd-H. This 
opens the Search pane in the sidebar on the left side of the screen, as 
shown in Figure 2.5. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 2.5 The Replace command in the sidebar doesn't have all the options that the 
Find and Replace dialog box offers. 

 

2. Type the text you want to find in the Search Document text box, or click the 
Search Document pop-up button and select an option from the list, such as 
Paragraph Mark or Tab Character. 

3. Type the text you want to replace it with in the Replace With text box, or 
click the Replace With pop-up button and select an option from the list. 

4. To be more specific about the search string, click the Action button (the one 
with a gear icon on it) and select the options that you want. Your options 
are Whole Word Only, Ignore Case, Sounds Like, and All Word Forms. 



5. Click the Replace button to replace the first instance that occurs below the 
current position of the insertion point. Word replaces the first occurrence 
and highlights the next occurrence. To replace the highlighted occurrence, 
click the Replace button again, but if you want to skip the occurrence, click 
the Find button instead. To replace all occurrences in the document, click 
the Replace All button. 

Perhaps you noticed earlier in this chapter that the Find and Replace dialog box, 
shown in Figure 2.3, has a tab for Replace. You can get to that tab by choosing, 
Edit, Find, Advanced Find and Replace, and clicking the Replace tab. This tab 
includes the Format and Special options, which enable you to specify formatting 
and special characters in both your Find What and Replace With strings. 

The Find and Replace options can perform some tedious tasks for you if you 
know how to use them. Here's just one example. In Chapter 3, "Formatting 
Documents," you learn that it is better to use a style with paragraph spacing than 
to put two returns after each paragraph in a document. You have some very im-
portant, lengthy documents that you need to clean up. The task of applying the 
proper styles to all the text is not particularly daunting, but deleting the extra 
paragraph returns between paragraphs is. Here's where the Replace command 
can really help. All you have to do is search for two paragraph returns and re-
place them with one paragraph return. The Replace dialog box would look like 
Figure 2.6. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 2.6 In the Find What text box, two paragraph marks appear as ^p^p. 

 



Deleting, Copying, and Moving 
Deleting, copying, and moving text are the editing functions that you probably will 
use most often. Generally, deleting, and most certainly copying and moving, in-
volves selecting text first. You can use the mouse or the keyboard to select por-
tions of text, as explained in Table 2.2. 

 

 

 
 

Table 2.2 Text Selection Methods 
To Select With the Mouse With the Keyboard 

A word Double-click the word. 
This also selects the 
space after the word. If 
you don't want to include 
the space after the word, 
use the keyboard 
method. 

Position the insertion point at the be-
ginning of the word and press Shift-
Opt-Right Arrow. Note that this also 
selects the space after a word, so you 
might want to release the Opt key 
while you continue to press Shift and 
press Left Arrow once. Selecting very 
short words might be easier if you just 
position the insertion point at the be-
ginning of the word and press Shift-
Right Arrow until you get to the end of 
the word. 

A line Click beside the line in 
the whitespace to the left 
of the line. Tip: Watch 
the I-beam as you move 
the pointer to the left. 
When it changes to an 
arrow, you are far 
enough to the left to 
click. 

Position the insertion point at the be-
ginning of the line and press Shift-End. 

A sentence Click anywhere in the 
sentence and then press 
Cmd while you click 
anywhere in the sen-
tence again.  

N/A 

A paragraph Triple-click anywhere in 
the paragraph. 

Position the insertion point at the be-
ginning of the paragraph and press 
Shift-Cmd-Down Arrow.  

 

When selecting text, you might find it helpful to show nonprinting 
characters. Click the button in the Standard toolbar that has the 
paragraph symbol on it. 



An entire document Click the insertion point 
at the end of the docu-
ment. Then scroll to the 
top of the document 
(without moving the in-
sertion point) and press 
Shift-Cmd in the 
whitespace to the left of 
the first line of text.  

Press Cmd-A. 

A block of text Drag the I-beam through 
the text. 

Position the insertion point at the be-
ginning of the block you want to select. 
Press Shift-any combination arrow 
keys to move to the end of the block. 
To select all the text from the insertion 
point to the end of the document, 
press Shift-Cmd-End. 

A vertical block of text Drag the I-beam through 
the text while pressing 
Opt. 

Position the insertion point at the be-
ginning of the vertical block you want 
to select. Press Shift-Cmd-F8 and then 
use the arrow keys to move right and 
down. To cancel the selection, press 
Cmd-Period.  

. 

Deleting Text 
To delete one character at a time, you can use the Delete key. The standard  
Delete key deletes the text to the left of the insertion point. The secondary Delete 
key deletes the character to the right. (If your keyboard doesn't have a second 
Delete key, you can press Fn-Delete instead.)  

To delete more than one character at a time, select the text you want to delete 
and press the Delete key. If you want the text back again, you can click the Undo 
button in the Standard toolbar or press Cmd-Z. 

Sometimes, when you're deleting text, you can economize on your keystrokes. 
For example, if you want to delete the phrase "kiss my grits" and then type "leave 
me alone," you can simply select "kiss my grits" and, while it is selected, type the 
new phrase. More bang for your buck! 

Copying and Pasting Text 
Word provides several methods for copying and pasting text: 

▪ Buttons in the Standard toolbar 

▪ Keyboard shortcuts 



▪ The commands on the Edit menu 

▪ The Scrapbook 

When you copy text, Word stores it temporarily in a memory area referred to as 
the Clipboard. When you paste the text, Word inserts a copy of it from the Clip-
board. (That's why the Paste button in the Standard toolbar looks like a clipboard 
instead of a paste brush!) Because Word doesn't actually remove the text from 
the Clipboard, you can paste it over and over again. You can even paste it into 
other Office or non-Office programs. The text remains in the Clipboard until you 
cut or copy something else or until you turn off your computer. 

  

LET ME TRY IT 

Copying and Pasting Text the Simple Way 
To copy and paste text, follow these steps: 

1. Using any selection method you prefer, select the text you want to copy. 

2. Use one of the following methods to copy it: 

▪ Click the Copy button in the Standard toolbar. (That's the one that looks 
like two sheets of paper.) 

▪ Press Cmd-C. 

▪ Click Edit in the menu bar and click Copy. 

3. Move the insertion point to the location where you want to paste the text. 

4. Use one of the following methods to paste it: 

▪ Click the Paste button in the Standard toolbar. (That's the one that looks 
like a clipboard with a piece of paper.) 

▪ Press Cmd-V. 

▪ Click Edit in the menu bar and click Paste. 

5. If desired, continue pasting in other locations, in other documents, or in 
other Office files of any kind (Excel, PowerPoint, e-mail, and so on). 

 

 

 

This section exclusively describes copying and pasting text, but you need 
to know that you can use these same steps to copy and paste any item in 
a document that you can select. For example, you can copy and paste a 
photograph that you've inserted in the document. 



Have you ever selected text on a web page and copied it into a document? The 
copied web text probably didn't look like the rest of the text in your document be-
cause it still had the formatting it used on the web page. Well, here's how you 
can overcome that problem. 

  

LET ME TRY IT 

Using Paste Special 
To paste formatted text into a document so that the text comes in without the 
formatting, follow these steps: 

1. Select the formatted text from its source. (I mentioned copying from a web 
page, but the source could be another Office document or practically any 
type of file.) 

2. Click Edit on the menu bar and click Paste and Match Formatting or Paste 
Special. If you select Paste and Match Formatting, Word pastes the text 
into the new position using the same format as the surrounding text. If you 
select Paste Special, the dialog box shown in Figure 2.7 opens. 

3. If you click Paste Special in step 2, select Unformatted Text and click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Figure 2.7 Sometimes, depending on what you have copied, this dialog box displays 
additional options in the As box. 

The Scrapbook is a more sophisticated tool for copying and pasting. Microsoft 
added the Scrapbook to Office 2008 for Mac, but if you skipped that version, 



you're going to fall in love with this feature. It enables you to store objects (text, 
graphics, tables, and so on) in a permanent storage area so that they are avail-
able for you to paste at any time. 

 

 

 
 

 
 

SHOW ME  Media 2.3—Using the Scrapbook 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

  

LET ME TRY IT 

Using the Scrapbook 
Before you start adding items to the Scrapbook, you have to display it by clicking 
View, Scrapbook (under Toolbox), or if the Toolbox is already open, you can click 
the Scrapbook tab if it's not already open. Then, to add items to the Scrapbook 
and paste them in a file, follow these steps: 

1. Select text or an item in your document. 

2. Click the Add button in the Scrapbook or click Edit in the menu bar and 
click Copy to Scrapbook. Word adds a clipping to the Scrapbook with the  
title New Clipping. 

3. Double-click the title of the clipping and type something more descriptive. 

4. If desired, right-click the clipping, click Categories, and select a category. 

5. Repeat steps 1 through 4 to add additional clips to the Scrapbook. 

6. To change the view of the Scrapbook, click the View pop-up button, shown 
in Figure 2.8, and select List, Detail, or Large Preview. 

7. View specific categories by clicking the first pop-up button on the toolbar 
and selecting Category Is. Then select a category from the pop-up menu 
on the button that suddenly shows up immediately to the right of the first 
button. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Just think what this Scrapbook feature can do for you! If you are a 
legal secretary who works for multiple attorneys, you can store all 
the signature blocks you need to use for all the attorneys. 



 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 2.8 If you have titled all your clippings, the List view takes less room for each 
clipping and, therefore, displays more items. 

 

8. To paste an item from the Scrapbook, select the item, position the insertion 
point where the text or item should be pasted, and click the Paste button in 
the Scrapbook. 

Moving Text 
Moving text is similar to copying and pasting text. Instead of copying the original 
text, however, you cut it. Then you paste it in the new position. After selecting the 
text, you can cut the text by clicking the Cut button in the Standard toolbar, 
pressing Cmd-X, or selecting Edit, Cut from the menu bar. After you move the in-
sertion point to the new location, you can execute the paste command by clicking 
the Paste button in the Standard toolbar, pressing Cmd-V, or selecting Edit, 
Paste from the menu bar. 

One other way to move text is to use the drag-and-drop method. You can turn 
this method on or off in the Edit Preference dialog box. It is turned on by default. 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



LET ME TRY IT 

Dragging and Dropping Text 
To drag text to a new location, follow these steps: 

1. Select the text. 

2. Drag the text to the new location. 

3. When you can see that the insertion point is in the correct location, release 
the mouse button. 

 

 

 
 

Checking Spelling and Grammar 
The whole time you are typing a document, Word assists you by making auto-
matic corrections to typos and calling your attention to typos that it cannot correct 
by underlining them with a wavy red line. Word has a list of words that it can  
correct for you automatically, and you can add to this list by clicking Tools, Auto-
Correct. Enter a frequently made typo in the Replace text box, enter the correct 
spelling in the With text box, and then click Add. Repeat this process for all typos 
you want to add. 

To correct a spelling error that is marked with a wavy red line, right-click the line. 
Click the correct spelling listed on the pop-up menu, or, if the typo is one that you 
make frequently, you can correct it and add it to the AutoCorrect list at the same 
time by clicking AutoCorrect and then clicking the correct spelling. If the correct 
spelling isn't listed on the pop-up menu, press Esc and manually correct the 
word. 

Word also calls your attention to "perceived" grammatical errors with a wavy 
green line. I say "perceived" because not all text marked with a wavy green line 
is really an error. Grammatical issues might include errors such as subject and 

I personally prefer not to use the drag-and-drop method because it 
is too easy to drag something accidentally, so I turn off this option 
in the Edit preferences window. 

If you like using the drag-and-drop method, you will find it helpful to 
split a window or open new windows on the same document when 
you need to drag to a location that is not on the same page. 



verb disagreement, incorrect capitalization, incorrect use of or lack of punctua-
tion, and incorrect spacing.  

If you right-click a green wavy line, and the problem is one for which Word can 
suggest a correction, you can click the suggestion to correct the problem. In 
some cases, however, Word merely identifies the problem and you must correct 
it manually. For example, if you have written a sentence such as, "The insertion 
point is not positioned correctly," the wavy line appears under the words "is not 
positioned." The pop-up menu does not have a suggestion but merely labels the 
text as "Passive Voice (consider revising)." If you want to avoid passive voice, 
you would have to rewrite the sentence in this case. Note, however, that some-
times Word actually does give you a suggested change for passive voice. If it 
does, you can click the suggestion to make the correction.  

After you make all the final revisions in a document, you should run the Spell 
Checker to catch anything you might have missed along the way. The final check 
might not find much, but at least you will be able to put a check mark in the box 
for "I was thorough today." 

  

LET ME TRY IT 

Checking Spelling and Grammar 
To check a complete document for spelling and grammar errors, follow these 
steps: 

1. Click Tools, Spelling and Grammar. The first problem Word finds displays 
in its context in the Spelling and Grammar dialog box. If Word perceives the 
problem to be a spelling error, the title above the context is "Not in diction-
ary," as shown in Figure 2.9, and the identified text is red. If the problem is 
grammatical, the title describes the grammatical error, as shown in Figure 
2.10, and the text is green. 

2. If the word is not truly misspelled (perhaps it's a proper name that doesn't 
appear in the dictionary), or it's not really a grammatical error, click Ignore 
to continue to the next error or click Ignore All if you know the perceived  
error appears in the document more than once. If the error actually is a 
misspelled word, generally the correct spelling is listed in the Suggestions 
box. At this point, you have several options. You can select the correct 
spelling and then 

▪ Click Change to correct the error. (If the error is grammatical, this is your 
only option.) 



▪ Click Change All if you think you have made the mistake more than 
once. 

▪ Click AutoCorrect to correct a typo and add it to the AutoCorrect list. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

Figure 2.9 Generally, the first suggestion in the list is the correct one. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Figure 2.10 Word rewrites the sentence using active voice instead of passive. 

 
 

 

 
 

If the correct spelling does not appear in the Suggestion box, you 
can click in the document, make the change manually, click back in 
the Spelling and Grammar dialog box, and click Resume. 



 

3. When the entire document has been checked, a message displays telling 
you the check is complete. Click OK. 

If the grammatical errors that Word marks are not to your liking, you can change 
the rules that Word uses or even create a custom set of rules in the Spelling and 
Grammar Preferences window. I tell you all about it in an audio recording. 

TELL ME MORE  Media 2.4—Setting Grammar Preferences 
Access this audio recording through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 



3 This chapter covers formatting a page, characters, 
and paragraphs. Additionally, it covers graphics, 
columns, tables, envelopes, and labels. 

Formatting Documents 
This chapter is organized in the order you would (or should) naturally use when 
creating a new document. It begins with the big picture: formatting the pages of a 
document—the margins, the layout, and the orientation. The chapter covers 
document formatting first because it's advisable to set the document formats be-
fore you start typing the text. Document formats, especially the margins, really 
change how the document looks on the page. If you change the margins after 
you type the complete document, lines of text will wrap differently and page 
breaks may change. The results may not be what you want, and you'll have to go 
back and make edits so the document looks the way you want it to look on each 
page. Why make more work for yourself? 

Next, the chapter discusses character formatting because normally you don't 
type more than a few words or sentences before you want to make a word bold 
or italic or even a different color. Then, moving from the simple to the more com-
plex, the chapter discusses paragraph formats and styles, a subject that requires 
quite a bit of detailed explanation. 

Finally, this chapter discusses special formatting techniques, which include in-
serting graphics, creating columnar text with columns or with tables, and creating 
envelopes and labels. 

Formatting the Page 
When you create a new document, Word has preset the page formatting for you 
using certain defaults. For example, it uses letter-size paper, sets tabs at every 
half inch, and uses portrait orientation. If the defaults work for you, you don't 
have to change anything. However, if you need to create a special document, 
such as a table with 20 columns, you probably will have to make some changes 
to the margins and the page orientation. 

Setting Margins and Headers and Footers 
The margins are the whitespaces at the top and bottom and on the left and right 
sides of a page. If you create a header or footer, it prints within the top or bottom 



margin area, so if you change the default settings, you need to be sure you allow 
enough room in the margin to hold the header or footer.  

  

LET ME TRY IT 

Setting the Margins 
To set the margins for a page, follow these steps: 

1. Click Format on the menu bar and click Document. 

2. Enter the measurement you want for each margin in the appropriate text 
fields, as shown in Figure 3.1. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 3.1 Be sure to set the margins to the acceptable values for your particular 
printer. 

 

 

 
 

 

If you select Mirror Margins, the fields for Left and Right margins 
change to Inside and Outside. This setting is for documents that 
print on both sides of the paper. The inside margins are the same, 
and the outside margins are the same. 



3. Specify a value for Gutter to add space to the "inside" margin if you intend 
to bind the document. (The inside margin is the left margin on a right-hand 
page and the right margin on a left-hand page.) 

4. Click OK. 

Header and footer text repeats at the top and bottom of every page. Typically, in 
a multipage document, you would place a page number in the header or footer. 
Additionally, you might want to put the document title, a date, or a copyright  
notice in a header or footer. 

  

LET ME TRY IT 

Setting the Header and Footer Positions 
When setting the position of the header and footer, be sure that your printer can 
accommodate the distance to the edge of the page. For example, if your printer 
can print only one-half inch from the edge of the page, don't set the header and 
footer position to a quarter of an inch from the edge. To set the header and footer 
positions, follow these steps: 

1. Click Format, Document. 

2. Enter the measurement in the Header and Footer text box. 

3. Click OK. 
 

 

 
 

Setting Layout Options 
Figure 3.2 shows the Layout options. For simple documents, you don't need to 
be concerned with the Section Start option or the Headers and Footers options, 
but you might want to specify the other options. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

If you find you have to reset the margins and header and footer po-
sitions to the same measurements for almost every document that 
you type, the next time you change them, click the Default button in 
the Document dialog box and click Yes to make the new settings 
your default. 



 
 
 
 
 
 
 
 
 
 
 

 

Figure 3.2 Use the Borders option to create a decorative border around a page for 
special types of documents, such as invitations or newsletters. 

  

LET ME TRY IT 

Setting Options for the Layout of a Page 
To set the layout options, follow these steps: 

1. Click Format on the menu bar and click Document. Click the Layout tab, if 
necessary. (Word remembers which tab you used last in the Document dia-
log box, so if you used the Layout tab last, it automatically displays again.) 

2. Because the options for Section Start and Headers and Footers have been 
eliminated from this discussion, skip to the next options in the dialog box. 
You might want to set one of these three options: 

▪ If you want to start text somewhere besides the top of a page, click the 
Vertical Alignment pop-up and select an option. Then from the Apply To 
pop-up, select Whole Document or This Point Forward and click OK. 

▪ If you want to number each line on the page, click Line Numbers. The 
Line Numbers dialog box opens. Click Add Line Numbering and then 
specify the Start At number, the From Text distance, and the Count By 
interval. Select a Numbering option and click OK. From the Apply To 
pop-up, select Whole Document or This Point Forward and click OK. 

 

 



 
 

▪ If you want to put a border around the edge of the page, first select ei-
ther Whole Document or This Point Forward in the Apply to pop-up 
menu. Then click the Borders button and click the Page Border tab, if 
necessary. The Page Border tab of the Borders and Shading dialog box 
is shown in Figure 3.3. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Figure 3.3 The Page Border tab offers you many different styles, colors, and widths 
for page borders. 

 

 If you want an art border—say you want a border of Christmas trees be-
cause you are typing your Christmas letter—click the Art pop-up button, 
click the green trees, and then click OK. If you just want a line around your 
page, select a Setting option; then Style, Color, and Width options; and 
click OK. 

Setting Paper Size and Orientation 
All printers are capable of printing on different sizes of paper. At a minimum, you 
can expect a printer to be able to handle letter and legal size paper and #10  

Sometimes line numbering is used for contracts. You could also 
use line numbering in documents that you share for discussion so 
that an area of the document can be identified easily. For example, 
you could say, "Look at page 5, line 20." 



envelopes. Most printers also can print custom sizes, within limits. Additionally, 
printers can print in portrait or landscape orientation. 

  

LET ME TRY IT 

Setting Up the Pages of a Document 
To specify a paper size and orientation, follow these steps: 

1. Click File on the menu bar and click Page Setup. 

2. Select the printer you are going to use from the Format For pop-up list. 

3. Select the size you want from the Paper Size pop-up list. 

4. Click the icon for the orientation you want to use. 

5. Click OK to close the Page Setup dialog box. 

6. Click OK to close the Document dialog box. 

Setting Page Formats Using the Ribbon 
Instead of using the dialog boxes to set some of the page formats, you can use 
the Layout tab on the ribbon. Figure 3.4 shows the available options: orientation, 
paper size, and margins. Additionally, a little further to the right are page back-
ground options for watermark, color, and borders. Using the tools on the ribbon is 
intuitive enough that I don't think you need step-by-step instructions. For exam-
ple, to change the margins, just click the Margins button and take it from there! 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 3.4 The Layout tab on the ribbon common layout options. 

 

Using Themes 
Every document has a theme, which is a group of colors, fonts, and effects. Us-
ing a theme ensures that elements in a file such as the color of fonts, shading, 
and shapes are coordinated. Of course, you can make color and font choices 
that are outside the theme if you want.  



A normal blank document defaults to the Office theme. It is the most conserva-
tive theme. To change to a different theme, click the Themes button on the Home 
tab on the ribbon and click the new theme. To see the differences in themes ef-
fectively, you need to open a document that has some text in it (better if the text 
is styled) and perhaps some tables with shading, some shapes, or SmartArt. 

Formatting Characters 
Type a word or a sentence in a document and just look at it for a moment. Then 
think of all the ways you can change the appearance of the text. The changes 
that probably come to mind first are bold, italic, and underline. These are the 
most common character formats. Other common character formats include font, 
font size, and color, as well as all caps and small caps. Another commonly used 
character format is highlighting, which mimics a highlighter pen. 

Less-used formats include strikethrough, double strikethrough, superscript, sub-
script, and hidden. If you type legal documents, you might need to apply strike-
through to text. This format tells you that the text should be deleted, but you can 
still read the text. If you type scientific documents, you might need to apply a 
subscript or superscript, as in H2O. If you type top-secret documents for the CIA, 
you might use hidden text. Okay, not really. You have to use invisible ink if you 
work for the CIA. I use every kind of character formatting in the different docu-
ments I type, but I seldom use hidden text. When I do, it's generally for instruc-
tions or something that only I should see. The reader of the document doesn't 
know the text is there, but I can see it when I need to by turning it on in the View 
Preferences or by choosing to print the document including the hidden text. (Of 
course, the reader can just as easily turn on the view of hidden text or print it, 
which is why you have to use invisible ink at the CIA.) 

Although I've listed a lot of character formats so far, I'm not done yet. There are 
still some advanced formats and some special effects. Advanced character for-
mats include character spacing and advanced typography, such as ligatures (the 
joining together of certain letters when typed next to each other). Special effects 
include drop cap, letter outlining, color and gradient fill, shadow, glowing and soft 
edges, reflection, and 3-D. Figure 3.5 shows the drop cap effect in the first para-
graph and color filled, 3-D letters with a shadow below the paragraph. 

 

 

 
 
 
 
 

One other text-formatting feature you might want to explore is Word 
Art. The button for Word Art is not grouped with the other text for-
matting tools. It's on the Document Elements tab under Text Ele-
ments.  



 
 
 
 
 
 
 
 
 
 
 

 

Figure 3.5 The text in this document uses the drop cap and special effects. 

 
 

 

The Font dialog box, shown in Figure 3.6, contains all the character formats ex-
cept drop cap, which is an option on the Format menu. To access the Font dialog 
box, click Format on the menu bar and then click Font. Instead of using the Font 
dialog box to apply a common character format such as bold, you can use the 
character format tools on the Home tab on the ribbon or keyboard shortcuts (for 
example, Cmd-B for bold, Cmd-I for italic, and Cmd-U for underline). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 3.6 The Font box lists all the fonts available in the Fonts folder on the hard 
drive. 

You can use one of two methods to apply character formats: 

▪ You can turn on the format, type the text, and then turn off the format. 



▪ You can select the text that you have already typed and apply the format. 
(In some cases, this method requires fewer steps.) 

Using the turn on/turn off method, you could apply bold to text by clicking the 
Bold button on the Home tab on the ribbon, typing the text, and clicking the Bold 
button again. Using the format-after-the-fact method, you could select the word 
that you want to be bold and click the Bold button on the ribbon. 

 

 

 
 

If you want to apply a format that is found only in the Font dialog box, such as 
small caps, you can select the text to be formatted, click Format, Font, select the 
format, and click OK. 

Formatting Paragraphs 
The second you type the first character in a document, you are using the default 
paragraph style that Word has chosen for you. Normal is the name of this style if 
you are typing in a new blank document. If you look on the Home tab on the rib-
bon under the Styles category, you will see that Normal is selected, as shown in 
Figure 3.7. (If you use a higher screen resolution, you'll see more styles in the 
ribbon than shown in the figure.) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Figure 3.7 To show you which style is applied to the current paragraph, Word puts a 
blue border around the style on the ribbon. 

 

If the character format that you want to apply from the ribbon has a 
pop-up menu button, click that button and select the format you 
want from the pop-up menu. For example, to change the font, click 
the Font pop-up button and select a font from the list. 



Paragraph formats include alignment (left, centered, right, and justified), left and 
right indentation, spacing before and after, tabs, bullets, numbering, borders and 
shading, and text direction. 

You can find the Paragraph formats in the Paragraph dialog box (shown in Fig-
ure 3.8), on the Format menu (shown in Figure 3.9), and on the Home tab on the 
ribbon (shown in Figure 3.10). Additionally, keyboard shortcuts exist for some 
formatting techniques, such as Cmd-E for centering a paragraph. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 3.8 Access the Paragraph dialog box by clicking Format, Paragraph. 

 
 
 
 
 
 
 

The Normal style contains both character and paragraph formats. When you ap-
ply character formatting to text, such as bold, you override the default that the 
Normal style uses. Likewise, if you apply a paragraph format, such as center 
alignment, you override the alignment format in the style. This method of format-
ting, overriding what is in a style, is called direct formatting. 

 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You can see the occurrences of direct formatting in a document if 
you turn on the option Show Direct Formatting Guides (located at 
the bottom of the Styles tab of the Toolbox). 



 
 
 
 
 
 
 
 
 
 

 

Figure 3.9 The Format menu gives you easy access to the Tabs dialog box, which is 
also accessible from the Paragraph dialog box. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Figure 3.10 The Home tab on the ribbon contains paragraph formatting buttons. 

 

The default Normal style uses these paragraph formats: left alignment, zero left 
and right indentation, single line spacing, zero spacing before and after, and left 
tabs every half inch. The text direction is normal, and the Normal style doesn't 
include any bullets, numbering, borders, or shading. 

In the next few "Let Me Try It" sections, you learn how to override several types 
of paragraph formats. The changes that you make to a paragraph do not affect 
the Normal style; they apply only to the paragraphs that you format in the current 
document. Additionally, you need to know that after you change the paragraph 
formats for a particular paragraph, Word carries those formats to the next para-
graph that you create when you press the Return key. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



SHOW ME  Media 3.1—Setting Paragraph Alignment, Indents, and 
Spacing 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

  

LET ME TRY IT 

Setting Paragraph Alignment, Indents, and Spacing 
To set alignment, indents, and spacing all at once, you can use the Indents and 
Spacing page of the Paragraph dialog box. Follow these steps: 

1. Select a paragraph or multiple paragraphs. 
 

 

 
 

2. Click Format, Paragraph, and click the Indents and Spacing tab, if neces-
sary. 

3. To set the alignment, select an alignment from the Alignment pop-up menu. 

4. To set a left and right indent, enter a number for the amount of space you 
want to indent in the Left and Right text boxes. If you want to set a first line 
indent only, select First Line from the Special pop-up menu and specify the 
distance in the By text box. To set a hanging indent, select Hanging from 
the Special pop-up menu and specify the distance in the By text box. (First 
line indents and hanging indents are mutually exclusive.) 

 

 

 
 

Because Word automatically sets a hanging indent for you when 
you use a bulleted or numbered list, it is rare that you will set a 
hanging indent yourself. A hanging indent causes text on the first 
line to hang out to the left of the text in the following lines of the 
paragraph. In the case of bulleted or numbered paragraphs, the 
bullet or number hangs out to the left of the text. You can see an 

To select a single paragraph, just click anywhere in the paragraph. 
To select consecutive paragraphs, highlight at least part of the first 
paragraph and part of the last paragraph in the group. To select 
multiple, nonconsecutive paragraphs, hold down the Command 
key as you click in the whitespace to the left of each paragraph you 
want to select. 



 
 

 

 
 

5. To set spacing before or after a paragraph, specify a distance in the Before 
or After text boxes. For example, if you are using a 10-point or 12-point 
font, you could set 12 points after the paragraph to simulate a double  
return. 

 

 

 
 

6. To set the line spacing, such as single, one and a half, or double, select a 
spacing interval from the Line Spacing pop-up menu. 

 

 

 
 

 

7. Click OK to close the dialog box and set the formats for the selected para-
graph(s). 
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Setting Line and Page Breaks 
When you set line and page break formats, you help Word know how to paginate 
a document. Using these parameters, Word can insert page breaks in the best 
locations. To set line and page breaks, follow these steps: 

1. Select a paragraph or multiple paragraphs. 

If you want to set precise spacing, you can select At Least or Ex-
actly from the Line Spacing pop-up menu and then specify a line 
height in the At text box. 

Always set spacing after a paragraph instead of just pressing the 
Return key twice to make space between paragraphs. If your page 
happens to break between two paragraph returns, you will have a 
blank line at the top of the new page. If you use paragraph spacing 
after a paragraph, you will never have this problem. 

example of this formatting right here in the numbered steps in this 
set of instructions. 



2. Click Format, Paragraph, and click the Line and Page Break tab, if neces-
sary. 

3. To stop Word from inserting a page break anywhere in a paragraph, select 
Keep Lines Together. 

4. To stop Word from inserting a page break between the paragraphs that you 
have selected and the next paragraph, select Keep with Next. 

5. To make Word insert a page break before the paragraphs that you have 
selected, select Page Break Before. 

 

 

 
 

6. Click OK to close the dialog box and apply the formats.  
 

SHOW ME  Media 3.2—Setting Tabs in the Tabs Dialog Box 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

  

LET ME TRY IT 

Setting Tabs in the Tabs Dialog Box 
As mentioned earlier, Word has default left tabs set every half inch. If you need a 
different type of tab in a different place, follow these steps to set one: 

1. Select a paragraph or multiple paragraphs. 

2. Click Format on the menu bar and click Tabs. The Tabs dialog box shown 
in Figure 3.11 opens. 

3. Type the position on the ruler where the tab should be in the Tab Stop Po-
sition text box. 

4. Select the alignment of the tab from the Alignment options and click the Set 
button. The created tab appears in the list on the left. 

5. Repeat steps 3 and 4 to set additional tabs. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Notice that Widow/Orphan control is selected by default. This set-
ting stops Word from inserting a page break before the last line in a 
paragraph (making a "widow" line at the top of the next page) or af-
ter the first line in a paragraph (making an "orphan" line at the bot-
tom of the page). 



 
 
 
 
 
 
 
 
 
 
 

 

Figure 3.11 Use the Tabs dialog box to set or clear tabs. 

 

6. To delete a tab that you have set, select it in the box on the left and click 
the Clear button. 

7. Click OK to close the dialog box. Figure 3.12 shows how text lines up with 
the different tabs. The bar tabs create vertical lines automatically. You don't 
have to press the Tab key to go to the Bar tab position. 

Another way to set tabs is to place them manually on the horizontal ruler where 
you want them. I think this is a better way to set tabs than using the dialog box 
because you have visual feedback, and you can move the tabs easily if you don't 
think they are positioned exactly right. 

SHOW ME  Media 3.3—Setting Tabs on the Ruler 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

LET ME TRY IT 

Setting Tabs on the Ruler 
To set tabs on the ruler, first make sure it is visible (View, Ruler), and then follow 
these steps: 

1. Select a paragraph or multiple paragraphs. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

Figure 3.12 This document uses a left tab, a center tab, a decimal tab, a right tab, 
and five bar tabs. 

 
  

2. Click the pop-up arrow on the button to the extreme left of the ruler and se-
lect a tab type from the pop-up menu. 

3. Click on the ruler where you want the tab to be set. If you miss the exact 
location, drag the icon for the tab to the right or left. 

To organize lists of information in a more readable format, you can use bullets or 
numbering. Typically, you use bullets if the order of the items doesn't really mat-
ter, such as the list of contents for the box your new Mac came in, and you use 
numbering if the items must be in a particular order, such as the steps in the 
process to set up the new Mac. 

  

LET ME TRY IT 

Bulleting Paragraphs 
Bullets can be little black dots or something quite a bit more fancy, such as 
graphics. To apply bullets to paragraphs, follow these steps: 

1. Select a paragraph or multiple paragraphs. 

2. Click the pop-up button on the Bulleted List button (on the Home tab on the 
ribbon) and select the bullet style you want to use from the pop-up menu, 
or click Format, Bullets and Numbering, click the Bulleted tab (if neces-
sary), select the bullet you want to use, and click OK. 

  



LET ME TRY IT 

Numbering Paragraphs 
To number a list, follow these steps: 

1. Select a paragraph or multiple paragraphs. 

2. Click the pop-up button on the Numbered List button (on the Home tab on 
the ribbon) and select the numbering style you want to use from the pop-up 
menu, or click Format, Bullets and Numbering, click the Numbered tab, if 
necessary, select the numbering style you want to use, and click OK. 

After you apply a bullet or number style to a paragraph, when you finish typing 
the paragraph and press the Return key, the next paragraph is also bulleted or 
numbered. If you press Return a second time, Word removes the bullet or num-
ber from the paragraph but (conveniently) does not create a new paragraph. 

I could write a whole chapter on the outline numbering techniques in Word, but 
this is a complicated technique that is outside the scope of this book. Certainly, 
you can try these techniques for yourself. To get started, click Format, Bullets 
and Numbering and click the Outline Numbered tab.  

Using Styles 
As mentioned earlier, every new blank document starts out using the Normal 
style. Word has other styles standing by waiting for you to use as well. If you 
point to the Style Area on the ribbon and click the arrow that appears, you can 
see a list of styles, as shown in Figure 3.13. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 3.13 The pop-up arrow doesn't show until you point to a style on the ribbon. 

 
 



Applying Styles 
Instead of using direct formatting to modify the appearance of text and para-
graphs, it is better to apply character or paragraph styles. This keeps the format-
ting consistent because each portion of text you apply a style to will have all the 
characteristics of the style. Using styles also makes things easier if you decide 
that you want to make a change later. Say you want to change the font size for 
all the subtitles in a document from 16 points to 14 points. If you used direct for-
matting, you will have to find all the paragraphs and select them to make the 
change. (What if you miss one?) If you used a style with a 16-point font size, you 
can make the change to the style, and Word can automatically apply the change 
to all paragraphs that use the style. 

Here's another advantage to using styles. Recall that if you change the format of 
a paragraph directly and then press Return anywhere in that paragraph, the new 
paragraph will have the same format as the paragraph to which you just applied 
direct formatting. If you don't want the same format in the new paragraph, you 
have to apply direct formatting to the new paragraph to correct it, or if you know 
how to apply styles, you could apply an appropriate style. In contrast, if you apply 
a style to a paragraph and then press Return, the next paragraph's formatting is 
determined by the definition of the style used in the preceding paragraph. (One 
of the options for defining a style is specifying the style of the following para-
graph. So, for example, you can define a style for a heading and specify that the 
paragraph that follows the heading should use the Normal style.) 
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Applying a Style to a Paragraph 
To apply a style to a single paragraph or multiple paragraphs, follow these steps: 

1. Select a single paragraph or multiple paragraphs. 

2. Click the style you want from the Home tab on the ribbon. 

Using Efficiency Tools with Styles 
If you're convinced that you should start using styles, this section shows you 
some nifty tools you can use to be even more productive with styles. First and 
least sophisticated is the Style Area. This is a space on the left side of the screen 
that shows the styles applied to each paragraph. It displays only in the Draft or 
Outline views and is shown in Figure 3.14. To turn on the Style Area, click Word, 



Preferences, View, specify a width for Style Area Width, and click OK. Use this 
feature to verify whether you have set styles consistently.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 3.14 You can make the Style Area wider or narrower as needed by simply 
dragging the divider line to the right or left. 

 

The most useful tool is the Styles tab of the Toolbox, shown in Figure 3.15. If the 
Toolbox is open, you can simply click the Styles tab if a different tab is visible. To 
open the Toolbox and display the Styles tab at the same time, click View in the 
menu bar and click Styles.  

Using the Styles tab in the Toolbox, you can apply styles, clear formatting, create 
new styles, modify existing styles, and select all paragraphs of a particular style. 
You can't do without this Toolbox when you are working with styles, so make 
room for it on your screen! 

 

 

 
 

The third tool I want to introduce you to is the Styles Guides. It does for the print 
layout view what the Style Area does for the draft and outline views. It identifies 
the styles in use and uses a color coding system that it associates with the Style 

You can display more styles in the Toolbox by pointing to the three 
dots under the style list and dragging them down. 



tab of the Toolbox. Figure 3.15 shows the Styles Guides on the left side of the 
document page. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 3.15 The Styles Guides can be turned on only from the Styles tab of the  
Toolbox. 

Modifying Styles 
I'm sure you see the advantage of using styles, but sometimes the styles that 
Word has provided for you don't have the individual formats that you need. No 
problem. You can modify styles to suit yourself. 

  

LET ME TRY IT 

Changing the Formats of a Style 
To modify the paragraph or character formats of a style, follow these steps: 

1. Click Format, Style. 

2. Select the style in the Styles box that you want to modify. If you don't see 
the style, select All Styles from the List pop-up menu. 

3. Click the Modify button. The Modify Style dialog box opens, as shown in 
Figure 3.16. The properties of the style (name, type, style basis, and follow-
ing paragraph) display at the top of the dialog box. These are options you 



have to specify when you create a new style. You can change any of these 
options when you are modifying a style, but usually, when you modify a 
style, you are changing the formatting attributes in the Formatting section. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 3.16 The Format button in the lower-left corner has options for every possible 
font format. 

 

 

 
 
 
 
 
 

4. To change formatting attributes, use any of the buttons in the Formatting 
section. 

5. If you need to modify a format attribute that does not have a button in the 
Formatting section, click the pop-up button for Format (located in the bot-
tom-left corner), and select an attribute from the pop-up list. The dialog box 
for the specific attribute opens. (These are the same dialog boxes that you 
have seen for applying direct formatting, but now the formats that you se-
lect become part of the style.) Set the options and click OK. The dialog box 
closes and you return to the Modify Style dialog box. 

If you have your Toolbox open to the Styles tab, you can simply 
point to the style you want to modify, click the pop-up arrow that 
displays, and click Modify Style. 



6. If you want the changes applied to other paragraphs in the document that 
use the style, click Automatically Update. (This option appears only when 
the style is applied to more than one paragraph in the document.) 

7. If you want the modifications that you have made to the style to be avail-
able in any new document that you create, click Add to Template. 

8. When finished, click OK. The Modify Style dialog box closes and you return 
to the Style dialog box. Click Apply to apply the style you modified to the 
currently selected text or click Close. 

Another way to modify the styles is to use Quick Styles. This feature modifies a 
standard group of styles to conform to a particular look, such as elegant or mod-
ern. Learn more about Quick Styles by listening to the following recording. 

TELL ME MORE  Media 3.4—Using Quick Styles 
Access this audio recording through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

Creating a User-Defined Style 
Instead of modifying existing character or paragraph styles, sometimes you just 
have to create your own style. Word classifies these styles as user-defined. The 
steps for creating your own style are similar to the steps for modifying a style. 
The main difference is that when you create your own style, you have to set the 
properties options, which you normally do not change when modifying a style. 
(Refer to Figure 3.16.) 
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Creating a Paragraph Style 
To create your own Paragraph style, follow these steps: 

1. Click New Style in the Toolbox (or click Format on the menu bar, click 
Style, and click the New button). 

2. Type a name for your new style. You might want to make the name refer to 
the purpose of the style, such as Product Description, or you could refer to 
the style's main characteristics, such as 14 pt Center. 

3. Select the style on which you want to base the new style from the Style 
Based On pop-up menu. Let me give you a little guidance here: You can 
select a style that you know has many of the same formats that you want 
and it will cut down on your work, but, be advised, this new style you are 



creating will change if you ever make changes to the style on which it is 
based. Sometimes it is best to select No Style for the Style Based On  
option. 

4. Select the style you want for the following paragraph from the Style for Fol-
lowing Paragraph pop-up menu. Let me guide you again: Word always de-
faults to the same style you are creating for this option. This might not 
always be the best choice. Think about what the following paragraph will be 
for the style you are creating. If the style is for a picture caption, for exam-
ple, you probably want the next paragraph to be normal body text (what-
ever style that is). 

5. Set the paragraph formats by using the buttons in the Formatting section of 
the dialog box or by selecting formatting options from the Format pop-up 
menu. 

6. After you set all the formatting attributes, click OK. The dialog box closes 
and you return to the New Style dialog box. 

7. If you want the new style to be available in any new document that you cre-
ate, click Add to Template. 

8. When finished, click OK. The New Style dialog box closes. 
 

 

 
 

 

Inserting Graphics 
Well-placed photos and graphics can enhance the readability of a document and 
raise the reader's interest level. Inserting graphics and photos in Word docu-
ments has never been easier, and the Media Browser provides access to Word's 
clip art, photos, symbols, and shapes. 

Notice that the preceding paragraph says "well-placed photos and graphics." By 
that I mean, don't go crazy just because you can. Gratuitous graphics make a 
document look amateurish. I think I'll make a bumper sticker that says, "Just Say 
No to Gratuitous Graphics." 

  

You use basically the same steps to create a character style, but 
really, you probably won't have any use for character styles except 
in special circumstances. For example, if you frequently need to 
format a word with bold, italic, red, and small caps, I might advise 
you to create a character style. In most cases, however, direct 
character formatting is usually good enough. 
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Inserting a Photo, Clip Art, Symbol, or Shape 
To insert a graphic element in a document, first, if it's not already open, open the 
Media Browser (click View, Media Browser), and then follow these steps: 

1. Click the tab in the Media Browser that has the graphic you want to use. 

2. Select a folder or category from the pop-up menu (located just below the 
tabs). For example, on the Photo tab, you could select Last Import from the 
pop-up menu. On the Clip Art tab, you could select Business from the pop-
up menu. 

3. Drag the graphic to the document and release it when you see the insertion 
point in the location where you want to insert the graphic. 

After you insert a graphic in a document, you can manipulate it in several ways. 
First, click the graphic to select it, and then do the following: 

▪ To resize the graphic proportionately, drag a corner. 

▪ To rotate the graphic, drag the green handle at the top. 

▪ To wrap text around the picture, click the Format Picture tab on the ribbon 
and click the pop-up button for the Wrap Text tool. Select a text wrapping 
option from the pop-up menu shown in Figure 3.17. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 3.17 The wrapping option icons represent how text will look with the picture. 

 

 To learn more about working with graphics, see "Creating Documents for 
Publication" in Chapter 6, "Creating Documents for Publication." 



Using Columns 
If you need to format a document with parallel, snaking columns, as used in 
newspapers and magazines, Word has you covered. You can create up to 12  
parallel columns on a page. You can make the columns equal widths with equal 
spacing between them, or you can specify custom widths and spacing. Addition-
ally, you can add a vertical line between the columns as a divider. 
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Setting Up a Columnar Layout 
To create a document that uses columns for the whole document, follow these 
steps: 

1. Click the Columns pop-up button on the Layout tab on the ribbon and click 
Columns (or click Format on the menu bar and click Columns).  

2. Specify the Number of Columns by clicking a Presets icon at the top of the 
dialog box or by typing a number in the text box. 

3. In step 2, if you selected Presets One, Two, or Three or typed a number in 
the text box, Word automatically checks Equal Column Width and com-
putes the column width and the space between columns, as shown in Fig-
ure 3.18. For unequal widths, uncheck this option and enter the values for 
width and spacing that you want to use, or select the Left or Right Presets. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 3.18  Presets One, Two, and Three use equal column widths and equal spacing 
between the columns. 



 
 

4. Click Line Between if you want a vertical line to separate the columns. 

5. Click OK. 

If you need only some of the text in a document formatted in parallel columns, 
you can position the insertion point where the columns should start, open the 
Columns dialog box, make all the settings, select This Point Forward from the 
Apply To pop-up menu, and click OK. When you finish with the columnar text  
and want to go back to one column, simply open the Columns dialog box again, 
select one column, select This Point Forward, and click OK. 

When you begin typing the columnar text, be sure you are working in the print 
layout view so you can see all the columns. If you work in the draft view, you can 
see only one column. Additionally, in the draft view you can see that Word inserts 
a continuous section break at the end of each column when it fills up. If you want 
a column to end before it fills up, you can insert a column break at the point you 
want the column to end by clicking Insert on the menu bar and then clicking 
Break, Column Break. 

Working with Tables 
You can achieve another type of columnar format in a document by using tables. 
Unlike the Column feature, text in a table does not flow from the bottom of one 
column to the top of the next column. The Table feature is good for typing… well, 
tables. 

Additionally, you can use a table to create a document that looks like the one in 
Figure 3.19. By using a table, I was able to create a hanging indent effect, with 
the text in the right column lined up just to the right of the text in the left column. 
All I did was remove the table borders to make the text look more like columns 
than it does a table. You may think you can do the same thing by setting a hang-
ing indent in the Tabs dialog box, but you can't. A hanging indent set with tabs 
does not allow you to have more than one line of text hanging out on the left. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 3.19 Notice that the text that looks as though it is hanging on the left (in the 
first column of the table) wraps to the next line. 

Creating a Table 
A table consists of columns and rows. A cell is the intersection of a column and 
row. A Word table is very much like a spreadsheet and actually has some of the 
functionality of a spreadsheet. For example, you can sort the data in a table and 
insert simple mathematical formulas in a table to perform calculations. Word pro-
vides four methods for creating a table. You can insert it, convert existing text to 
a table, draw a table, or use the New button on the Tables tab on the ribbon. 
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Inserting a Table 
To create a table with the insertion method, follow these steps: 

1. Click Table on the menu bar and click Insert, Table (or click the New button 
on the Tables tab on the ribbon and click Insert Table). The dialog box 
shown in Figure 3.20 opens. 

2. Enter a value for Number of Columns and Number of Rows. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 

 

Figure 3.20 The Initial Column Width is set to Auto by default. This setting gives you 
the same width for each column. 

 
 

 

 
 

3. Click OK. 
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Converting Existing Text to a Table 
The text you convert to a table must be typed in such a way that it will convert to 
a table. If it isn't or if it's a little inconsistent, you have to format it or clean it up 
before you convert it. The individual pieces of text, which will go into each cell in 
the table, can be separated by one of the following: tabs, paragraph returns, or 
commas. If the text that you want to convert to a table is separated by tabs, 
make sure that only one tab appears between each entry. Also, if a column is 
blank, be sure there is still a tab in that position. If each line of text should repre-
sent a row in the table, make sure no extra paragraph returns appear between 
lines because they will create blank rows in the new table. When the text is ready 
to convert, follow these steps: 

1. Select the text to convert. 

Sometimes you don't know exactly how many columns and rows 
you want, but don't worry—you can add and delete columns and 
rows after the table is inserted. See the "Fine-Tuning the Structure 
of a Table" section, later in this chapter, for more information. 



2. Click Table on the menu bar and then click Convert, Convert Text to Table. 
The dialog box shown in Figure 3.21 opens. Word fills in the number of col-
umns and rows for you based on an analysis of the text. Generally, it se-
lects the correct option for Separate Text At, but be sure to check this. You 
might need to select a different option. 

3. Click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 3.21 Nonprinting characters are turned on so you can see the number of tabs 
between each portion of text. 

 
 
 
 

SHOW ME  Media 3.5—Drawing a Table 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 
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Drawing a Table 
When a table will have many different-sized cells, it is sometimes easier to draw 
the table by hand. To draw a table, follow these steps: 



1. Click the Table tab on the ribbon and click the Draw button (or click Table 
on the menu bar and click Draw Table). The pointer changes to a pencil 
icon. 

2. Drag the pointer to create the outside outline of the table. Drag to draw the 
lines for the columns and rows. 

3. If you make a mistake, click the Eraser button on the Tables tab on the rib-
bon and drag the pointer across the line you want to erase. 

4. When finished, press Esc or click the Draw button on the Table tab on the 
ribbon. 

Setting Table Properties 
When you use the insertion or conversion method to create a table, Word does 
not give you the opportunity to set the table's width or alignment. It creates the 
table at the position of the insertion point and makes the table width fill the page 
from the left margin to the right. When the table appears in the document, Word 
adds a new tab called Table Layout on the ribbon. If you click the tab, you see 
the various buttons and controls for formatting a table and setting the table prop-
erties. 
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Setting the Width, Alignment, and Wrap Option for a Table 
Some of the properties of a table that you might want to set are the width of the 
table and its alignment. Additionally, if the table doesn't occupy the full width of 
the page (between the margins), you might want text to wrap around the table. 
To set table properties, follow these steps: 

1. Position the insertion point anywhere in the table. 

2. Click the Properties button on the Table Layout tab on the ribbon, or click 
Table on the menu bar, and then click Table Properties. 

3. Specify a value for the Preferred Width if you want a narrower table. 

 

You can just drag the right border of the table to the left to make a 
table narrower, but then you also have to drag the borders of the 
columns to adjust their widths. If you specify a value for Preferred 
Width in the Table Properties dialog box, Word automatically ad-
justs the widths of the columns for you. 



4. If you have made the table width narrower, select the Alignment you want 
or specify a value for Indent from Left. Additionally, you can select Around 
for Text Wrapping if you want text to wrap around the table. 

5. Click OK. 

Moving Around and Entering Text in a Table 
When you insert a table, Word automatically positions the insertion point in the 
first cell. You can type text in the cell and press Tab to move to the next cell in 
the row. When you get to the last cell in the row, pressing Tab moves the inser-
tion point to the first cell in the next row, if there is one. If there isn't a next row, 
pressing Tab from within the last cell creates a new row for you. 

As you type, text wraps in the cell. You also can press Return in a cell to create a 
new paragraph. If you want to use a tab stop inside a cell, you have to press Opt-
Tab because, of course, the Tab key moves the insertion point to the next cell. 

 

 

 
 

Fine-Tuning the Structure of a Table 
No matter how many columns and rows you start out with when you create a ta-
ble, you can adjust the number by inserting more or deleting the ones you don't 
want. Additionally, you may want to change the width of columns or the height of 
rows. 
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Inserting Columns and Rows 
If you decide you need more columns or rows in the table, follow these steps: 

1. Position the insertion point in a cell that is adjacent to the place where you 
want to insert the new column or row. If you want to insert more than one 
column or row, select the same number of adjacent columns or rows you 
want to insert (if you can). 

Here's my number-one insider tip for working with tables: If you 
need a blank line above a table that you've inserted at the top of a 
document, just click in the first space in the first cell and press  
Return. 



2. On the Table Layout tab on the ribbon, click the appropriate button: Above, 
Below, Left, or Right. 
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Deleting Columns and Rows 
If you want to delete columns or rows, follow these steps: 

1. Click in a cell that is in the column or row you want to delete or select all 
the columns or rows that you want to delete. 

2. On the Table Layout tab on the ribbon, click the Delete button and click De-
lete Columns or Delete Rows. 
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Moving Columns and Rows 
Moving columns and rows is one of the best features of tables. It enables you to 
rearrange your data easily without typing an extra letter! To move a column or 
row, follow these steps: 

1. Select all the columns or rows that you want to move by clicking above the 
first cell in a column or to the left of the first cell in a row. Drag to select  
additional columns or rows. 

2. After the columns or rows are selected, just point anywhere in the blue  
selection area and drag to the new location. 
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Changing the Width of Columns 
When you create a table by inserting it, the default width for each column is Auto. 
This means that Word makes each column the same width, filling up the page 
from the left to the right margin. Naturally, you will need to change the width of 
the columns to accommodate the text that should fit in the columns. One easy 

The Delete pop-up menu also has options for deleting cells or delet-
ing the entire table. If you delete cells, Word asks you how you 
want the remaining cells to shift. 



way to change the width of a column is to drag the right side border of the col-
umn to the right (to increase the width) or to the left (to decrease the width). If 
you need to be more precise in the measurement of the column width, follow 
these steps to set an exact width: 

1. Select the column or columns. 

2. Click the Properties button on the Table Layout tab on the ribbon or click 
Table on the menu bar and then click Table Properties. 

3. Type the exact measurement and specify the unit of measure. 
 

 

 
 

4. Click OK. 
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Changing the Height of Rows 
As with column width, Word sets the height of a row automatically (based on the 
default font size) and makes the height the same for all rows. After you start en-
tering data in a cell, the row height adjusts to fit the largest font used in the row. 
To change the height of any row, you can simply drag the bottom border down, 
but if you need a precise height, follow these steps: 

1. Select the row or rows. 

2. Click the Properties button on the Table Layout tab on the ribbon or click 
Table on the menu bar and then click Table Properties. 

3. Type the exact measurement for Specify Height and then select either At 
Least or Exactly for Row Height Is. 

 

 

 
 

While this dialog box is open, if you need to set the height of rows 
above or below the selected row(s), click Previous Row or Next 
Row and repeat step 3. 

While this dialog box is open, if you need to set the width of col-
umns to the left or right, click Previous Column or Next Column and 
repeat step 3. 



4. If you don't want Word to insert a page break in a row that falls at the bot-
tom of the page, uncheck Allow Row to Break Across Pages. 

5. Click OK. 
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Distributing Space Between Columns or Rows 
Distributing space is one of my favorite features of tables. It enables you to select 
multiple adjacent columns or rows and distribute the space they occupy evenly 
between them. To distribute space, follow these steps: 

1. Select the adjacent columns or rows. 

2. On the Table Layout tab on the ribbon, click the Distribute Rows button or 
the Distribute Columns button. 
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Splitting and Merging Cells 
Tables are great tools for creating forms like the one shown in Figure 3.22. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 3.22 This form was created by splitting and merging cells. 

 

When creating a form, you can start out with the same number of cells in each 
row and then use the split and merge commands to tailor the form. You might al-
so want to merge several cells to create a column heading that spans the width 
of several smaller columns. To split or merge cells, follow these steps: 

1. Select the cells you want to split or merge. 

2. Click the Split Cells button or the Merge button on the Table Layout tab on 
the ribbon, or click Table on the menu bar and click Split Cells or Merge 
Cells. 



3. If you clicked Split Cells, the dialog box shown in Figure 3.23 opens. Spec-
ify the Number of Columns and the Number of Rows. If the cells have data 
in them, it's probably advisable to select the Merge Cells before Split op-
tion. Click OK. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 3.23 When you split a cell, you can split it vertically and horizontally. 

 

 

 
 

Formatting Tables 
In addition to formatting the text that you type in a table, you can format the ta-
ble's borders using different types, colors, and weights of lines, and you can for-
mat the background of cells with different colors and percentages of shading. For 
example, you might want to use blue for the background of the top rows that con-
tain the column headings. Additionally, you can make the headings appear at the 
top of every page if the table is longer than one page. 
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Using Borders 
By default, Word creates tables with borders around every cell. These borders 
print, and they are black and half a point in width. You can specify exactly where 
you want to use borders and format the style, color, and size of the border. To 
format the borders, follow these steps: 

1. To make changes to the entire table, select the entire table by clicking the 
table icon that appears at the upper-left corner of the table when you point 

Another quick way to merge cells is to erase the border using the 
Erase tool on the Tables tab as described earlier in "Drawing a  
Table." 



to a table. To make changes to specific cells, rows, or columns, select all 
the appropriate cells. 

2. Click Format on the menu bar, click Borders and Shading, and then click 
Borders, if necessary. The dialog box shown in Figure 3.24 opens. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 3.24 The default setting for Borders is All. This setting puts borders around 
every cell in a table. 

 

3. Select an option from the Setting list. A preview displays on the right to 
show you what the table or individual cells will look like. (If you select None, 
click OK because you're done.) 

 

 

 
 

4. Select a style from the Style list and select a Color and Width from the cor-
responding pop-up menus. 

5. If you selected Custom for Setting, you can specify the Style, Color, and 
Width of each line by clicking the lines in the diagram in the Preview or by 
using the buttons that surround the diagram. 

6. When finished, click OK. 
 

 

If you select None to remove all borders, you will have a difficult 
time typing the text. To see where the cells are, you can turn on 
light gray gridlines by clicking Table in the menu bar and then click-
ing Gridlines. Gridlines do not print. 
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Using Shading 
Adding shading to a table can emphasize important information, such as the 
headings, or make a table easier to read by using a technique called banding, 
which shades every other row or column. To add shading to a table, follow these 
steps: 

1. Select the cells, columns, or rows that you want to shade. 

2. Click Format on the menu bar, click Borders and Shading, and then click 
Shading, if necessary. 

3. Click a color in the Fill palette or click More Colors, click a color on the color 
wheel, and click OK. 

4. If desired, select a percentage or pattern from the Style pop-up menu and 
select a color from the Color pop-up menu. (The color you select here 
works in conjunction with the color you select in step 3; it doesn't replace 
that color.) 

5. Click OK. 
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Repeating Header Rows 
If a table is so long that some of the rows go to the next page of the document, 
you should make the header row (or rows) repeat at the top of every page. To 
repeat the header row(s), follow these steps: 

1. Click anywhere in the first row or select multiple, adjacent rows at the top if 
you have used more than one row for column headings. 

 

You also can add or modify shading with buttons on the Tables tab 
on the ribbon. 

You also can add or modify borders with buttons on the Tables tab 
on the ribbon. 



 

 
 

2. Click Table on the menu bar, and then click Heading Rows Repeat. 
 

 

 
 

Using Preset Table Formats 
As shown in Figure 3.25, under Table Styles on the Tables tab on the ribbon, 
there are several preset formats that you can choose from to apply to a table. If 
you click the scroll button on the right, you can see the additional formats. Each 
format uses a particular color theme and various borders and shading. The first 
style is the default; it has no formatting applied. If you select Table options from 
the ribbon, such as Header Row or Banded Rows, the style uses special format-
ting for the options you select. Note that simply selecting the Table Option for 
Header Row does not cause a header row to repeat; it formats only the first row 
of a table.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 3.25 Table Styles apply formatting to a table. 

 

Creating Envelopes and Labels 
You can type an envelope in Word for just about any size envelope. The trick is 
getting your printer to print it. If you use blank envelopes, you need to print your 
return address in the upper-left corner. The top margin should be in the 
neighborhood of 0.1 inch and the left margin should be about 0.35 inch. Many 

Header rows repeat automatically at the top of every page as long 
as you do not insert a user-defined break. 

You cannot select a row below the first row as a header row if you 
haven't selected the first row. For example, you cannot make row 
two the header row by itself. 



printers can't print that close to the edge of the paper. If that is your case, your 
choices are to use larger margins, create a label for the return address, or forget 
it and use an envelope with a preprinted return address. 
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Creating an Envelope from Scratch 
To create an envelope, follow these steps: 

1. In a new blank document, click Format on the menu bar and click Docu-
ment. 

2. Click the Margins tab, if necessary, and set the following margins: 

▪ Top: 0.1 

▪ Bottom: 0.3 

▪ Left: 0.35 

▪ Right: 0.3 

3. Click Page Setup. 

4. Select Envelope #10 for Paper Size, click the icon for landscape orienta-
tion, and click OK. 

5. Click OK to close the Document dialog box. Word displays a warning dialog 
box if your printer cannot print within the margins that you set. Click the Fix 
button and Word will adjust the margin; then click OK again. 

6. Type the return address and then press the Return key about seven or 
eight times to come down to the line where you will type the address of the 
recipient. 

7. Click the Increase Indent button on the Home tab on the ribbon until the in-
sertion point is at 3.5 inches on the ruler and type the address. 

8. Print the document and save it if you want to retain the document for sub-
sequent printings. 

 

 

If you want to create an envelope with some pizzazz, use one of the 
envelope templates. 
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Creating Labels 
To make creating labels relatively easy, Word provides you with a Label Wizard. 
The wizard sets up the correct number of columns for you and sets the margins 
for each column as well. To create labels, follow these steps: 

1. Click Tools in the menu bar and click Labels. The Labels dialog box opens, 
as shown in Figure 3.26.  

2. Click the Options button. The dialog box shown in Figure 3.27 opens. 

3. Select the type of printer (under Printer Information), the Label Products, 
the Product Number, and click OK. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 3.26 The Labels dialog box can create a whole page of the same label for 
you, or you can type just one label. 

 
 

If you want to let Word do all the work for you (and why not?), click 
Tools on the menu bar and click Envelopes. Then you can type the 
delivery address and the return address in a dialog box and Word 
will place them in the correct locations on the envelope using text 
boxes. 



 
 
 
 
 
 
 
 
 
 
 

 

Figure 3.27 Avery labels are the standard labels in the United States. If you buy a 
generic brand of labels, they usually list the equivalent Avery product number on the 
box. 

 

4. To create the label(s), take one of the following actions: 

▪ If you want to create a page of labels with your personal address, click 
the Use My Address check box and click OK. 

▪ If you want to type one label, type the address in the Address text box 
and specify the Row and Column under Number of Labels. (If you are 
using up the labels on a page one by one, this enables you to use the 
next label on the page.) 

▪ If you want Word to give you a page of blank labels so you can type a 
different address on each label, don't type anything in the Address text 
box, click Full Page of the Same Label, and click OK. After Word creates 
the page of blank labels, you can type anything you want on the labels, 
not just addresses, of course.  

5. Print the document and save it if you want to retain the document for sub-
sequent printings. 



4In this chapter, you find out about AutoCorrect, 
AutoFormat, and AutoText. You also learn about the 
Thesaurus, creating a macro, and editing photos.  

Exploring Other Features 
The core features of Word have not changed since the release of the first version 
years ago, but Microsoft has added new features to the program with every new 
release. You don't need to know how to use all these features to get your work 
done in Word, but you certainly will be more productive if you at least learn to 
use a few of the features. 

This chapter shows you how to use some of the efficiency tools that Word pro-
vides. The tools help you format and correct your text automatically, insert boi-
lerplate text, look up synonyms and antonyms, and perform repetitive tasks. 
Additionally, this chapter shows you how to work with photos in a document and 
how to use the new layers feature. 

Using the AutoCorrect Components 
The AutoCorrect feature has several components: AutoCorrect and Math Auto-
Correct, AutoFormat As You Type, and AutoText. The AutoCorrect component 
can automatically correct typos and misspellings, replace typed characters with 
symbols, such as replacing (c) with the copyright symbol, and replace text in 
equations with mathematical symbols. The AutoFormat As You Type component 
can automatically format headings, borders, tables, lists, and so on, as you type. 
The AutoText component can automatically insert text that you have created and 
saved as an AutoText entry. 

Using AutoCorrect 
Using AutoCorrect is effortless. It happens automatically. You fail to capitalize 
the first word in a sentence, and Word capitalizes it for you. You type teh, and 
Word changes it to the. Word comes with a fairly extensive list of corrections it 
will make for you automatically, but you can and should add to this list. Addition-
ally, you should make sure that you approve of the AutoCorrect options that 
Word sets for you by default. 
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Setting AutoCorrect Options and Adding Corrections 
To set the AutoCorrect options and add to the default list of corrections, follow 
these steps: 

1. Click Tools on the menu bar and then click AutoCorrect. The dialog box 
shown in Figure 4.1 opens. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 4.1 By default, all the AutoCorrect options are selected. 

 

2. Select or deselect the options at the top of the dialog box, as you wish. I 
generally advise people to select all the options, but you can deselect an 
option at any time if you have a special case. For example, I occasionally 
want to type a table in which the first word in a cell is not capitalized. So I 
change the setting in AutoCorrect, type the table, and then change the set-
ting back again. 

3. To add a word to the AutoCorrect list, type the word in the Replace text 
box, type the correct spelling in the With text box, and click Add. Repeat 
this step as many times as necessary to add words to the list of auto-
corrections. 

 

 



 
 

 

4. Click the Math AutoCorrect tab, set options, and add replacements on this 
tab, if you wish. If you don't use equations in your work, you can skip this 
step. 

5. Click OK when finished. 
 

 

 
 

Using AutoFormat As You Type 
AutoFormat As You Type was added to Word as a feature when Microsoft first 
started adding so much artificial intelligence to the Office suite (Office 97). Ac-
cording to Microsoft, the AutoFormat As You Type feature is supposed to "work 
behind the scenes to produce an attractive, easy-to-read document while you 
concentrate on the content." 

In reality, most of the AutoFormat As You Type options are either unnecessary or 
cause less-knowledgeable users a lot of frustration. If you do an Internet search 
for autoformat + word, most of the hits you get are instructions on how to turn off 
the feature. 
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Setting AutoFormat As You Type Options 
To set AutoFormat As You Type options, follow these steps: 

1. Click Tools on the menu bar and then click AutoCorrect. Click the Auto-
Format As You Type tab. The dialog box shown in Figure 4.2 opens. 

 
 
 
 
 
 
 
 
 
 
 

If Word makes an automatic correction in a document that you 
don't want, point to the correction and the AutoCorrect Smart But-
ton appears. Click the pop-up arrow on the button and click Undo 
Automatic Correction. If you find that the button is distracting, you 
can turn it off in the AutoCorrect dialog box. Then, when you want 
to reverse an auto-correction, press the keyboard shortcut Cmd-Z. 

You also can add words to the list when you correct a word in the 
document that has a wavy red line under it. Right-click the word, 
choose AutoCorrect, and then click the correct spelling. 



 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 4.2 The default AutoFormat options can cause surprising and sometimes be-
fuddling results if you don't realize they are set. 

 
 
 

2. For the Apply As You Type options at the top of the dialog box, I recom-
mend that you deselect all of them. 

 

 

 
 

3. For the Replace As You Type options, I recommend you select the first 
four. I think the fifth option, *Bold* and _Italic_, is a throwback to some ar-
chaic typing techniques that you've probably never heard of, so don't select 
it. The last option turns a web address into a hyperlink. This option might 
be one you want or one you don't want. Let the actual case decide for you. 

The Apply As You Type AutoFormat settings are the ones that can 
unpleasantly surprise you. For example, say you want to make a 
short underlined space at the beginning of a line, so you type three 
underlines and press Return. AutoFormat changes what you typed 
into a line that spans the margins. As another example, if you type 
an asterisk followed by a space or tab, AutoFormat changes it into 
a bulleted list with a bullet instead of an asterisk. 



4. For the Automatically As You Type options, I recommend that you do not 
select any of them. These options are similar to the Apply As You Type op-
tions in that they cause unexpected results if you don't know they are set. I 
think it is better to be in control of the formatting yourself. For example, 
when I type a tab, I want it to function as a tab; I don't want it to set an in-
dent. If I want an indent, I'll set it myself! 

5. Click OK to close the dialog box. 

Using AutoText 
The AutoText feature can be a real timesaver. Say that you have to type your 
company's name over and over again in all the documents you create. The name 
is "Jacobowitz, Feinmann, Schwartz, and Jones, P.L.C." Wouldn't you rather 
type jfsj instead and let Word replace it with the full name? Well, that's what an 
AutoText can do for you. 

Word provides a short list of AutoText entries. They include entries such as "Best 
wishes," "REGISTERED MAIL," and "To Whom It May Concern." As you start 
typing one of these AutoText entries, Word shows the complete entry in a pop-up 
box, as shown in Figure 4.3. When you see the pop-up box, you can quit typing 
and press Return. Word completes the entry for you but does not end the line 
with the Return. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 4.3 When you see the AutoText entry in the pop-up box, you can press Return 
to insert it. 

Many of the default AutoText entries also have logic built into them. For example, 
if you type The salutation of this letter is To Whom It May Concern, Word will not 
complete the "To Whom It May Concern" phrase for you; it knows it is not really 
being used as the salutation because it is not at the beginning of the line. 

In addition to using the default AutoText entries, you can create your own. They 
can be as simple as a phrase or sentence or as complex as a paragraph fol-
lowed by a table with borders and shading. 

 



SHOW ME  Media 4.1—Creating an AutoText Entry 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

  

LET ME TRY IT 

Creating an AutoText Entry 
To create an AutoText entry, follow these steps: 

1. Create the content that you want to include in the AutoText entry, and then 
select it. 

2. Click Insert on the menu bar and then click AutoText, New. The Create 
New AutoText dialog box opens, as shown in Figure 4.4. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 4.4 The default name of the AutoText is generally the first few characters you 
have selected for the AutoText entry. 

 

3. For the name, there are two ways to go. You can simply accept the name 
that Word supplies in the Name text box, which is the first few characters of 
the selected text, or you can type a short name for the entry. (As you know, 
if you leave the name as the first few characters of the text, when you begin 
typing the exact text, Word suggests the text in a pop-up box. To save 
yourself some typing and force Word to display the AutoText entry sooner, 
you can make the name just four letters—something like wxyz that you 
don't normally type.) 

 

 

 
 

4. Click OK. 
 

 

If you select a nontext object for the AutoText entry, such as a 
graphic, the Name text box is empty. 



 
 

Using the Thesaurus 
The Thesaurus is one of Word's reference tools, and it "lives" in the Toolbox. It 
can look up a word that you select in a document, list the meanings, suggest 
synonyms for the word, and automatically replace the selected word with the 
word you choose from the list of synonyms. Generally, an antonym for the word 
appears at the end of the synonym list, and you can replace the selected word in 
the document with the antonym if you choose. 

Additionally, after opening the Thesaurus, you can "drill down" on a word by look 
up words from the synonym list. For example, if you select the word dark in your 
document and look it up in the Thesaurus, one of the synonyms is sinister. If you 
select sinister in the Synonym list and click the Look Up button, the Thesaurus 
displays the meaning of sinister and its synonyms. 

 

SHOW ME  Media 4.2—Using the Thesaurus 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

  

LET ME TRY IT 

Replacing a Word with a Word from the Thesaurus 
When you are composing a document and need to replace a word with a syno-
nym or antonym, follow these instructions: 

1. Click anywhere in the word that you want to replace. 

2. Click Tools on the menu bar and then click Thesaurus. The Toolbox opens 
(if it isn't already open) to the Reference Tools panel with the Thesaurus 
tool revealed, as shown in Figure 4.5. (If the Toolbox is already open but 
displaying a different tab, just click on the Reference Tools tab.)  

3. Select the correct meaning from the Meanings list. 

4. Select the synonym (or antonym) you want to use from the Synonyms list. 
 

 

Another way to insert an AutoText entry is to click Insert, AutoText, 
point to a category, and click the name of the entry. AutoText en-
tries that you have created are listed on the menu under the Normal 
category. 

 



 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 4.5 You can display or hide the tools on the Reference panel by clicking their 
reveal arrows on the left. 

 

5. Click the Insert button. 
 

 

 
 

 

If you are just looking for a quick synonym, you can select one from 
a shortcut menu without even opening the Thesaurus. Right-click 
the word, click Synonyms, and click the synonym you want. 

To see more synonyms and antonyms, you can perform a Web 
search by opening the Web Search tool in the Toolbox and clicking 
the hyperlink to Answers.com. Note that this hyperlink could 
change in the future, so just look for a hyperlink that is associated 
with synonyms and antonyms. 



Creating a Macro 
You might have heard of macros before and decided that they were far beyond 
your ability to create. In reality, Word provides a very basic mechanism for creat-
ing a macro that anyone can take advantage of and benefit from. 

A macro is a set of commands that have been saved and can be invoked to run 
automatically. For example, say that you are constantly writing articles in which 
you must use a red drop cap that uses a specific text effect. Instead of going 
through the menus and dialog boxes to apply the drop cap each time and then 
formatting it, you can create a macro to insert a drop cap and apply the format-
ting instantly. 

Even though macros are written in Visual Basic for Applications (VBA) code, you 
don't have to be a VBA programmer to create one. All you have to do is let Word 
record the commands while you perform them. Of course, if you are a VBA pro-
grammer, you can create some really smokin' macros that perform some very 
complicated routines. 

 

 

 
 

 
 

SHOW ME  Media 4.3—Recording a Macro 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 
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Recording a Macro 
Before you start recording a macro, make sure you have everything set up in the 
document first. For example, if you must select text before recording the first step 
of the macro, select the appropriate text. To record a macro, follow these steps: 

1. Click Tools on the menu bar and then click Macro, Record New Macro. 

2. In the Record Macro dialog box, shown in Figure 4.6, type a name for the 
macro. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Yes, I said "VBA." Microsoft has brought it back to Office 2011 for 
Mac after having dropped it in the last version. Many are rejoicing. 



 
 
 
 
 
 
 
 
 
 
 

 

Figure 4.6 No spaces are allowed in the macro name. 

 

3. To have access to the macro in any document, leave the Store Macro In 
option set on the default, which is All Documents (Normal). Your other op-
tion is to store the macro just in the current document. 

4. Type a short description of what the macro does if you want to. 

5. Click the Keyboard icon to open the dialog box shown in Figure 4.7, and 
press the keys you want to assign to the macro as a shortcut. If Word al-
ready uses the keyboard shortcut for another command, such as printing a 
document, the dialog box displays this information for you. Then you have 
the opportunity to try a different keyboard combination. If you want to use 
the shortcut that is already assigned to another command, you can do so, 
but I really don't advise it. 

 

 

 
 

 After you settle on a shortcut, click Assign, and then click OK. 

6. Perform the commands that should be in the macro, such as making menu 
selections, filling in dialog boxes, and so on. 

Word has so many keyboard shortcuts that use the function keys 
and the Command key, that it is difficult to come up with a combi-
nation that Word is not already using. I suggest you use the Control 
key in combination with a letter or number. 



7. When you finish performing all the steps, click Tools on the menu bar and 
then click Macros, Stop Recording. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 4.7 Press New Keyboard Shortcut is the only option available in the dialog 
box when it first opens. 

 

After you create a macro and assign it to a keyboard shortcut, you can run the 
macro simply by pressing the shortcut keys. For example, if you created a macro 
for a specially formatted drop cap and assigned the shortcut Ctrl-D to it, you 
would click in the paragraph that you wanted to have a drop cap, and then press 
Ctrl-D. 

Unfortunately, macros can be used for both good and evil. For this reason, Word 
always warns you when you open a document if it contains macros. To learn 
more about security issues that pertain to macros, listen to the following audio 
recording. 

TELL ME MORE  Media 4.4—Macros and Security Issues 
Access this audio recording through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

If you create a macro that doesn't work exactly the way you want it 
to, you can record it again using the same name. Word replaces the 
first macro with the new one. 



Flagging for Follow-Up 
The Flag for Follow-Up feature is well loved by those who use it. It enables you 
to specify a date and time when Office will remind you that you need to follow up 
on a document. I don't know about you, but I can't have too many reminders. The 
Flag for Follow-Up feature definitely helps me to be more efficient. 

  
 
 
 

LET ME TRY IT 

Creating a Follow-Up Flag 
To remind yourself that you need to follow up on something in a particular docu-
ment, follow these steps to set a flag: 

1. Open any document. 

2. Click Tools on the menu bar and then click Flag for Follow Up. 

3. Enter a date and time and click OK. The flag is activated after you save the 
document. 

 

 

 

Working with Photos 
In Office 2011, you have more control over photographs than ever before. Micro-
soft added features that you don't expect to find except in dedicated photo-
editing software. 

Adding a Photograph to a Document 
To add a photo to a document, you can insert it (Insert, Photo, Picture from File), 
paste it (Edit, Paste), drag it from the Scrapbook, or drag it from the Media 
Browser (click View, Media Browser to display the browser if necessary). All 
these methods insert the graphic in line with text. This means that the photo oc-
cupies a space on a line just as a character does. Most of the time, it is better to 
make the photo free floating so you can position it where you want it by dragging 
it with the pointer. You liberate the photo from the line by setting an option that 
defines how text will wrap around or through the photo. 

  

Word creates a task in Outlook that will remind you to follow up. 
Even if you don't use Outlook, the Microsoft Office Reminders ap-
plication picks up the task and reminds you at the appropriate time. 



LET ME TRY IT 

Setting the Text Wrap Option for a Photo 
To set the Wrap Text option, follow these steps: 

1. Select the photo. 

2. Click the Format Picture tab on the ribbon. 

3. Click the Wrap Text pop-up button (see Figure 4.8). 

4. Select the wrapping option that you want. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 4.8 You can wrap text around a photo in many different ways. 

 

Resizing and Cropping Photographs 
After inserting a photo and setting the text wrapping option, you can resize and 
crop it, if needed. To resize a photo proportionally, you drag the photo by a cor-
ner handle. To crop a photo, you use the Cropping tool. 

  

LET ME TRY IT 

Cropping a Photograph 
Cropping removes portions of the photo around the edges that do not contribute 
anything to the main image in the photo. To crop a photo, follow these steps: 



1. Select the photo. 

2. Click the Format Picture tab on the ribbon. 

3. Click the Crop button. Crop marks appear around the edges of the photo, 
as shown in Figure 4.9. 

4. Drag any crop mark toward the center of the photo. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 4.9 Crop marks appear at each corner and in the middle of each side. 

 

5. When finished cropping, click the Crop button on the ribbon again or click 
anywhere outside the photo. 

 

 

 
 

Adding Borders and Styles 
At this point, you might want to add a simple border to the photo to give it a more 
finished look. A line weight of one point is a standard border size. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

If you have cropped a photo, you might want to compress it to 
make the file size smaller, which, in turn, makes the size of the 
document that contains it smaller. To compress a photo, select it 
and click the Compress button on the Format Picture tab of the 
Ribbon. 



LET ME TRY IT 

Adding a Border to a Photo 
To add a border, follow these steps: 

1. Select the photo. 

2. Click the Format Picture tab on the ribbon. 

3. Click the Border pop-up arrow. 

4. Point to Weights and click the point size you want. 

If you want to make the photo a little fancier, you can apply a style. Word has 28 
different styles to choose from, including different frames, reflections, shadows, 
cameos, and so on. 
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Applying a Style to a Photo 
To apply a style to a photo, follow these steps: 

1. Select the photo. 

2. Click the Format Picture tab on the ribbon. 

3. Click the Picture Styles pop-up button and then click the thumbnail for the 
style you want to use, as shown in Figure 4.10. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 4.10 Word offers many different picture styles. 



 
 

4. To change the color of the frame for the picture style, click the Border pop-
up button on the Format Picture tab on the ribbon and select a color. 

Adjusting Photos 
New in this version of Office is the ability to adjust a photo as you would in a pro-
gram such as iPhoto or Adobe Photoshop. Figure 4.11 shows the Adjust Picture 
options, which include Transparency, Brightness, Contrast, Sharpen, Recolor, 
Saturation, and Temperature. Unfortunately, the adjustments are made to the 
photo that has been placed in the Word document and not to the original photo 
file. This means that if you place the same file in multiple documents, you must 
adjust the photo in each document. Knowing this up front, I would adjust the file 
itself in iPhoto or Adobe Photoshop before inserting the file in multiple Word 
documents or adjust it in one document and then add it to the Scrapbook.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 4.11 The Adjust Picture pane contains the most commonly used options  
found in professional photo-editing programs. 
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Adjusting a Photo Manually 
To adjust a photo by making settings manually, follow these steps: 

1. Select the photo. 



2. Click the Format Picture tab on the ribbon. 

3. Click the Corrections button and then click Picture Correction Options. 

4. Make adjustments one at a time. The photo updates with the adjustment 
while the Format Picture dialog box is still open. This feature enables you 
to see whether the change that you make is acceptable. 

5. When all changes are complete, click OK. 

If you don't feel skilled enough to adjust photo options manually (using the sliders 
shown in Figure 4.11), you can use the Corrections palette shown in Figure 4.12 
and the Recolor palette shown in Figure 4.13. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 4.12 The Corrections palette displays thumbnails with different degrees of 
sharpness/softness and brightness/contrast. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

To access the Corrections or Recolor palettes, select the photo, 
click the Format Picture tab in the ribbon, and click the appropriate 
button (Corrections or Recolor). 



 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 4.13 The Recolor palette has thumbnails with varying degrees of saturation 
and tone. 

Using Filters 
Filters are another professional photo-editing type feature that Word includes. A 
filter changes the look of a photograph in some way. It might make the photo-
graph look as though it is a chalk, marker, or pencil sketch. It might make the 
photograph look as if it were printed on textured paper (as shown in Figure 4.14) 
or as if the photo were taken with a diffusion filter on the camera lens, which 
blurs the photo. 

LET ME TRY IT 

Applying a Filter to a Photograph 
To apply a filter to a photograph, follow these steps: 

1. Select the photo. 

2. Click the Format Picture tab on the ribbon. 

3. Click the Filters button and click the thumbnail for the filter you want to use. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 

 

Figure 4.14 This photo has the cement filter applied. 
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Removing a Filter 
If you have added a filter and you change your mind, you can remove it by fol-
lowing these steps: 

1. Select the photo. 

2. Click the Format Picture tab on the ribbon. 

3. Click the Filters button and click None. 

Removing the Background of a Photograph 
Another new photo-editing feature in Office 2011 is the Remove Background fea-
ture. This feature makes the background in a bitmapped image transparent. It 

If you compress a photo after applying a filter (File, Reduce File 
Size), the appearance of the photo may change. The reason is that 
compressing a photo removes a certain amount of detail; therefore, 
it is better to compress the photo before you apply a filter. 



doesn't work for vector images, and you won't be able to use it effectively even 
on some bitmapped photos, but it does a fantastic job on photos that have a pro-
nounced difference in foreground and background colors. Figure 4.15 shows the 
before and after effect of using this feature. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 4.15 Removing the background of the photo allows the background of the 
page to show. 

 

SHOW ME  Media 4.5—Removing the Background of a Photo 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 
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Removing the Background of a Photo 
To remove the background of a photo, follow these steps: 

1. Select the photo. (The photo in Figure 4.15 can be found in the Media 
Browser's Clip Art.) 

2. Click the Format Picture tab on the ribbon. 



3. Click the Remove Background button. Word draws a rectangle around the 
part of the photo that it perceives to be the foreground, the part of the im-
age it will keep. Any part of the photo that is dark pink will be eliminated. 

4. Drag any of the sizing handles to increase or decrease the rectangle to in-
clude or exclude part of the photo. 

5. To fine-tune the selection, increase the zoom by dragging the slider on the 
right side of the window's status bar. Click in the background or foreground 
area to add or eliminate areas. When you click in the foreground area, a 
minus in a circle appears. When you click in the background area, a plus in 
a circle appears. Additionally, you can drag the pointer across an area that 
you want to include or eliminate. 

6. When finished, click anywhere outside the photo. 

7. If the results are not quite what you want, select the photo again and click 
the Remove Background button again. Continue clicking or dragging in the 
foreground or background to achieve better results. 

Adding Effects to Photos 
If you really want to go crazy with photos, you can add effects. The effects in-
clude Shadows, Reflection, Glow, Bevel, and 3-D Rotation. Figure 4.16 shows an 
example of each. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.16 Photo effects can add some additional interest to a photo. 
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Adding Effects to Photos 
You can add one or more effects to a photo, but be careful! If you add too many 
effects, I'll have to throw a penalty flag for piling on. To add one or more effects 
to a photo, follow these steps: 

1. Select the photo. 

2. Click the Format Picture tab on the ribbon. 

3. Click the Effects button and point to an effect. The options for an effect dis-
play as graphics (see Figure 4.17). 

4. Click the option you want to apply. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 4.17 Each effect has several options. 

 

Resetting a Photograph 
If at any point in the process of formatting or adjusting a photo you have gone 
way too far and you just need to start over, you can click the Reset button on the 
Format Picture tab on the ribbon. The original photo reappears, or, if you have 
compressed the photo, the last compressed version of the photo appears. 

Working with Layers 
Word 2011 has a fantastic new feature that enables you to see the layers of a 
document in three dimensions. This is a feature that Office 2010 (for PCs)  
doesn't even have! 



 

A document automatically has layers if you add photos, text boxes, or graphic 
shapes. Each object occupies its own layer. If object layers overlap each other, 
selecting the object that is behind another object can be difficult. 

 

 To learn more about text boxes and graphic shapes, see Chapter 6,  
"Creating Documents for Publication." 

Figure 4.18 shows a document that has several layers. I've inserted two photos 
from the Media Browser's Clip Art collection, created a text box, drawn a shape, 
and typed text in a placeholder. This document has a total of five layers. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 4.18 You can create interesting graphics by layering photos and other graphic 
objects. 

 

When I created this document, I was careful to build the document from the bot-
tom layer up. I inserted the photo of the dry erase board first; then I created the 
text box on top of the photo; and finally I inserted the photo of the man on top of 
both of these layers. I decided that the man looked as though he was floating in 
air, so he needed something to stand on. Using the parallelogram shape, I drew 
a platform, but because it was the top layer, it covered the man's feet. I had to 
rearrange the order of the levels, and that's when things really got cool (see Fig-
ure 4.19). 
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Changing the Order of Layers 
To change the order of layers, follow these steps: 

1. In print layout view, click an object that is layered and click the Format Pic-
ture tab. 

2. Click the Reorder button. The screen changes to a 3D view of all the layers 
in the document, as shown in Figure 4.19. 

 

 

 
 

 

3. Drag the layer to a new position and click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4.19 The Layers feature is found only in the Mac version of Office. 

 
 

In the Publishing Layout View, the Reorder button is located on the 
Home tab of the Ribbon. 



5 In this chapter, you learn about creating electronic 
notebooks that organize your information in 
written and audio formats.  

Using the Notebook 
Chapter 1 introduced the notebook view and notebook template. This chapter 
explains the notebook feature in depth. It covers how to create and customize a 
notebook; set up the tabs in the notebook; enter and format data; use the scrib-
ble tools; record, play, and export audio; and finally flag, sort, and search for  
data. 

Creating and Customizing a Notebook 
With the advent of PDAs and then smart phones, as well as applications such as 
Outlook, the old day planner notebook that you could carry around with you (and 
accidentally leave on the table at Starbucks) became outdated for the tech set. 
Why would you write everything by hand and keep it in an unsearchable, un-
sortable medium? Unthinkable! 

And yet … the notebook format still has an organizational value that is un-
matched by the new technology. The day planner paradigm is still one of the best 
ways to organize information in one place, and Microsoft has brought the para-
digm into the electronic environment in a very user-friendly way. 
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Creating a Notebook 
You can create a notebook from scratch or convert an existing document to a 
notebook. It's really better to start with a blank notebook and copy the informa-
tion from the existing document into the new notebook because you can lose 
some types of data by converting (style definitions and the placement of graph-
ics, for example). To create a new notebook, follow these steps: 

1. Click File on the menu bar and then click New from Template. The Word 
Document Gallery opens. 



2. Click Notebook Layout in the Templates sidebar on the left and click a style 
in the middle pane. The styles are all very similar. The main difference is 
the appearance of the tabs. 

3. Click Choose. Your screen should look similar to Figure 5.1. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5.1 This notebook uses the Simple Contemporary template. 

 

 

 
 

If you care about the way the notebook looks on the screen, you can change the 
background or even switch to a different template. Additionally, you can adjust 
the height of the lines on the page or hide them. 
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Changing the Appearance of the Notebook 
To customize the appearance of the notebook, follow these steps: 

1. Click the Appearance tab on the ribbon. 

Another way to create a notebook is to open a new blank document 
and then switch to notebook view before you enter any text.  



2. To change the notebook template, click the Type button and select a differ-
ent type. Notice that each type has two forms: with or without rings. (The 
rings are purely visual. They don't print.) 

3. To change the background, click the Background button and click the op-
tion you want, or click the Customize Workspace button in the status bar 
and select the option from the pop-up list. 

4. To increase or decrease the line height, click the up or down arrow for  
Distance. 

5. To hide the lines, click the Style pop-up button and click None. (Note that 
lines do not print even if they are not hidden.) 

Setting Up the Notebook 
When you create a new notebook, Word provides you with three tabbed sections 
named Section 1, Section 2, and Section 3. These tabs correspond to the section 
number displayed in the status bar. If Section 1 is the current section, the status 
bar displays Sec1 Pages: 1 of 1. Word is a little slow about updating this informa-
tion in the status bar, so even if you've switched to another tab, it might still show 
the status of the previous tab you selected for a little while. 

Renaming Tabs 
Your first task after creating a notebook should probably be to rename the tabs. 
You really are not limited to a certain number of characters for the name. If the 
name you want to use has more characters than "Section 1," Word increases the 
size of the tab to accommodate the name. 
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Renaming a Tab 
To give a tab a name that is more meaningful than the default name, follow these 
steps: 

Here's a tip for naming the tabs. If you rename Section 1 to some-
thing like Atlanta, the status bar still displays Sec1 when the Atlanta 
tab is the current tab. To keep confusion to a minimum, name the 
tab something like 1-Atlanta. 



1. Click the tab to select the page. The tab you select comes to the top. 

2. Click the Appearance tab on the ribbon and click the Rename button. The 
name on the tab is selected. 

3. Type the new name and press Return. 
 

 

 
 

Adding Tabs 
Depending on your needs, you may have to add tabs. When you add a new tab, 
it automatically becomes the last tab. If you want the new tab to go before  
another tab, you have to move it to the new location. 
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Adding and Positioning a Tab 
To add and position a tab, follow these steps: 

1. Click the plus button below the last tab. 

2. Drag the new tab to the new location. An arrow points to the new location 
to help you see where to drop the tab. 

 

 

 
 

Deleting Tabs 
If you no longer need a tab, you can delete it. Deleting a tab deletes all the con-
tent in the section, not just the page where the tab is located, so before deleting 
a tab, make sure you don't need any data in the section. 

  

When you add more tabs than Word can display, Word adds scroll 
arrows so you can scroll the tabs up or down. Don't think you're go-
ing to display more tabs by giving the tabs shorter names. Tabs 
have a minimum size, and they do not get smaller just because you 
don't use all the space for the name. 

You also can double-click the tab, type the new name, and press 
Return. 
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Deleting a Tab 
To delete a tab and all the information in the section, follow these steps: 

1. Click the tab you want to delete. 

2. Click the Appearance tab on the ribbon and click the Delete button. Word 
renames the sections after the deleted section if you have kept the default 
names Section 1, Section 2, and so on. So if you delete Section 2, the old 
Section 3 becomes Section 2, Section 4 becomes Section 3, and so on 
down the line. 

Specifying Colors for Tabs 
In some cases, you might want to change the colors of the tabs. For example, if 
your notebook has three adjacent tabs that relate to each other, you can group 
them by making the three tabs the same color, as shown in Figure 5.2. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 5.2 Making related tabs the same color helps to show the division between  
major topics. 

  
 
 
 
 



LET ME TRY IT 

Changing the Color of a Tab 
To change the color of a tab, follow these steps: 

1. Click the tab you want to change. 

2. Click the Appearance tab on the ribbon and click the Color button. 

3. Click the color you want. 

Using Page Numbers 
One last setting you might want to make is the addition of page numbers. These 
numbers don't really show up on the screen, but they do show in the print pre-
view and they also print. You can number all pages consecutively, or you can 
number each section separately. 

  

LET ME TRY IT 

Adding Page Numbers to a Notebook 
Page numbers automatically go in the footer at the bottom of the page. To add 
page numbers, follow these steps: 

1. Click the Appearance tab on the ribbon. 

2. Click the Include pop-up button under Footer and click Page (Number). 

3. Click Restart Number per Section if you don't want to number consecutively 
throughout the notebook. 

Storing Information 
A notebook can hold various types of information from various sources. You can 
type information directly on the page; paste information from another source; in-
sert information from your Contact list in Outlook; record information in an audio 
file using your computer's microphone; scribble notes with the electronic pencil; 
and insert media from the media browser, including photos, audio, movies, clip 
art, symbols, and shapes. 

To start, each section has only one page, but when you fill up a page with infor-
mation, Word automatically creates the next page for you, just as it does in a 
regular document. The page break, however, is not visible in the notebook view, 
but you can tell how many pages are in a section by looking at the status bar. 



All the proofing and reference tools are also at your disposal in the notebook 
view. For example, you can check your spelling, look up a word in the dictionary, 
or find a synonym in the thesaurus. 

Typing and Organizing Information 
By default, a notebook is in what I call the "note-taking mode." It assumes that 
you are going to be typing your notes in an outline format. The first text you type 
is automatically styled as Note Level 1. When you press Return to go to the next 
line, Word applies Note Level 1 again. If you press the Tab key one time, Word 
indents the text, automatically changes the style to Note Level 2, and adds a bul-
let. You can continue in this mode specifying the correct level by pressing Tab to 
go to the next lower level (the lowest level is Note Level 9) or by pressing Shift-
Tab to go to the next higher level. Additionally, you can use the buttons on the 
Home tab on the ribbon to promote or demote text (see Figure 5.3). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 5.3 The button with the green arrow that points to the left promotes, and the 
button with the green arrow that points to the right demotes. 

If you prefer the notes to be numbered rather than bulleted, click the Numbered 
List button (on the Home tab on the ribbon) before you begin typing. The default 
numbered list uses the scheme 1.a.i., but you can change the style at any level 
by clicking the Style button (on the Home tab on the ribbon) and clicking the style 
you want. 

 

SHOW ME  Media 5.1—Numbering Text in a Notebook 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

Dragging Text 
As you type, a bubble appears to the left of the text. This bubble has rather  
mysterious behavior. It appears and disappears, and I could explain it to you, but 
it would really be to no purpose. Here's what you need to know: If you point to a 
line and see the bubble on the left, you can then drag that bubble to move the 
line to a new location. If you point to a line that has subheadings, a blue triangle 
appears on the left instead of a bubble. Clicking the blue triangle hides or reveals 



 

the subheads. If you want to drag a line and its subheadings to a different loca-
tion, you drag the blue triangle. 

Formatting Text 
Text formatting tools are available on the Home tab on the ribbon in the Font 
section. You can select a different font, size, or color; apply bold, italic, underline, 
or strikethrough; and use the highlighter pen feature. 

Additionally, you can display the Styles tab of the Toolbox and apply styles to 
text. The styles you apply to text in a notebook are retained if you switch to an-
other view. The reverse is not true. If you apply styles to text in another view and 
convert to a notebook, all the styles are changed to Note Level 1. 

Inserting Tables 
To insert a table on a notebook page, click the Insert button under Tables on the 
Home tab on the ribbon. The pop-up menu shown in Figure 5.4 displays. High-
light the number of columns and rows you want to insert. Format the table and 
type the text as you would if you were working in a regular document. 

 

 To learn more about working with tables, see "Working with Tables" in 
Chapter 3. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 5.4 If you want to specify other characteristics of a table, click the Insert Table 
option instead of highlighting the columns and rows. 

 



Inserting Outlook Information 
In general, you can copy information from an Outlook item, such as a message, 
an appointment, a note, and so on, and then paste the information in your note-
book. If you want to copy a complete calendar page into the notebook, you can 
save the page as a PDF file and then insert it as a graphic. To insert contact in-
formation into a notebook, Word has a special command that saves you the 
trouble of opening Contacts or your Apple Address Book. 

  

LET ME TRY IT 

Inserting Contact Information 
To insert a contact in a notebook, follow these steps: 

1. Click on the tab where you want to insert the contact information. 

2. Click Tools on the menu bar and then click Contacts. The Contacts dialog 
box opens, as shown in Figure 5.5, and all contacts display by default. This 
includes contacts in the Apple Address Book, as well as Outlook. 

3. Click, Cmd-click, or Shift-click to select contacts you want to insert, and 
click the Insert button. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 5.5 Use the search field to find a contact if you have too many to scroll 
through. 

 

 



 
 

4. When finished, click the Close button. 

Recording Audio 
Instead of typing your notes, you can use your computer's microphone to record 
notes. If you are typing while you record the audio, Word associates the line you 
are typing on with the part of the audio that you speak while you are on that line. 
If you point to a line of text that has audio associated with it, a speaker icon dis-
plays in the left margin. If you want to see where all audio notes are, you can 
click the Show button on the Audio Notes tab on the ribbon. Figure 5.6 shows an 
example of a notebook with several audio notes. 

 

SHOW ME  Media 5.2—Recording Audio Notes in a Notebook 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5.6 The Show button (under Advanced) toggles on and off the display of the 
speaker icons. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Duplicate contacts appear in the list in the Contacts dialog box if 
you have the same contact in both the Apple Address Book and 
Outlook. 



LET ME TRY IT 

Recording Audio Notes in a Notebook 
If you find that you use the audio recording features quite frequently, you might 
want to invest in a microphone and headset. The microphone on an iMac doesn't 
pick up the sound as well as a microphone you can speak into directly. To record 
a note, follow these steps: 

1. Click the Audio Note tab on the ribbon. 

2. Click the Record button and begin speaking. 

3. Type notes while you are speaking if you want to associate text with the 
audio note. 

4. When finished, click Stop. You can start and stop as many times as you 
want. Word appends any new audio to the end of the audio file. 

To play the audio file, click the Play button on the Audio Note tab on the ribbon. 
The audio starts playing from the beginning, but if you click a speaker icon be-
side a line of text, the audio jumps to the segment that was recorded when you 
typed that line of text. 

TELL ME MORE  Media 5.3—Setting Audio Preferences 
Access this audio recording through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

 

 

 
 

Scribbling 
In the Scribble section on the ribbon's Home tab, Word gives you tools to write, 
erase, and select. I can't imagine that you would try to doodle electronically in the 
notebook, but you might want to circle something in your notes, cross out some-
thing, or sketch a simple diagram. With the scribble tools, you can do all these 
things, as shown in Figure 5.7. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

If you want to separate the audio file from the notebook so you can 
play it in iTunes or with some other player, you can export the file 
by clicking the Export button in the Audio Note tab. 



 
 
 
 
 
 
 
 
 
 
 

 

Figure 5.7 Using the scribble pen, you can mark out and circle text, as well as draw a 
rough diagram. 

 

SHOW ME  Media 5.4—Using the Scribble Tools 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

  
 
 
 
 

LET ME TRY IT 

Using the Scribble Tools 
To use the scribble tools, follow these steps: 

1. Click the Home tab on the ribbon. 

2. Click the pop-up button on the button with the pen on it (under the Scribble 
section) and point to an option, as shown in Figure 5.8. 

3. Click the color you want to use and drag the pointer to begin scribbling. 

4. To erase a scribble, click the Eraser on the ribbon and click any part of  
the scribble. (Make sure the plus on the Eraser touches the line of the 
scribble.) 

 
 
 
 
 

 
 
 
 
 
 
 
 

Note that you cannot use the Eraser to erase only part of a scribble. 

 



 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 5.8 You can select the weight of the line and then the color you want to use 
with the pen. 

 
 
 
 

5. To select multiple scribbles on the same page, click the Selection tool on 
the ribbon and draw a marquee around all the scribbles. Then you can 
work with them as a group (to delete them, copy them, drag them, and so 
on). 

Inserting Media from the Media Browser 
You can insert any item in the Media Browser in a notebook. This includes pho-
tos, audio recordings, video recordings, clip art, and shapes. To display the Me-
dia Browser, click View on the menu bar and click Media Browser, or just click 
the Media Browser button in the toolbar. To insert an item, click the appropriate 
tab and drag the item to the notebook page. 

 

 To learn more about the Media Browser, see "Inserting Media from the 
Media Browser" in Chapter 6. 

Managing Your Information 
After you put the information in your notebook, you might need to manage it in 
different ways. For example, you might want to add a marginal note, sort a list, 
search for something specific, or even create a to-do item. 

Of course, you know that you can do all these things in a notebook, or I wouldn't 
have brought up this issue, right? 



Flagging Text 
Have you ever put a question mark in the margin beside some of your notes or 
drawn a star beside something that's important? You can do basically the same 
thing in the Word Notebook by using Note Flags. 

  

LET ME TRY IT 

Inserting a Note Flag 
To call attention to text in various ways, follow these steps to insert a Note Flag: 

1. Click anywhere on the line that contains the text you want to flag. 

2. Click the Flag Type button on the Note Flags section on the ribbon's Home 
tab. The pop-up menu shown in Figure 5.9 opens. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

Figure 5.9 Use the priority flags to show the importance of information. 

 

3. Click the flag you want to insert. The flag appears in the left margin (see 
Figure 5.10). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 5.10 Word always inserts the flag in the left margin. 

 



 

Sorting Text 
If your notebook contains a list, you can sort it automatically in ascending or de-
scending order. To sort a list, select it and click the Ascending or Descending 
button in the Sort group on the ribbon's Home tab. To return the items to their 
original order, click the Undo button in the toolbar immediately after sorting. 

Creating an Outlook Task 
You can create an Outlook task with a reminder that will alert you at a specified 
date and time using any text in your notebook as the title of the task. This feature 
is helpful if you need to be reminded to meet a deadline, such as studying for a 
test or finishing a report for your boss. 

LET ME TRY IT 

Adding a Task to the Outlook Task List 
To create a task in Outlook, follow these steps: 

1. Select the text in the notebook. 

2. Click the Create Outlook Task button in the Note Flags group on the rib-
bon's Home tab. The dialog box shown in Figure 5.11 opens. 

3. Specify a date and time and click OK. 

 To learn more about working with Tasks, see Chapter 10, "Using Tasks 
and Notes." 

 
 
 
 

 

Figure 5.11 The text you selected is the name of the task. 



 

Searching for Text 
To search for text in a notebook, you use the Spotlight search field on the far 
right side of the toolbar. Just type the search text in the field and press Return. 
Word removes the colors from all tabs that do not have the search text and ap-
plies a blue highlight to the tabs of the sections that do have the search text. 
When you click a tab that is highlighted, you see the search text on the page 
highlighted in blue, as shown in Figure 5.12. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 5.12 Text found in a search is highlighted in blue. 



6 This chapter deals with using graphic design 
features in the publishing layout view to create a 
professional-looking publication. 
.  

Creating Documents for 
Publication 

Once upon a time, the term publishing referred to printed media only. Now the 
term refers to printed media as well as electronic media that are published on the 
Web or for electronic book readers, such as the Kindle or the iPad. 

This chapter tells you how to use the graphic and publication tools in Word to 
create documents that are suitable for publishing. It begins by explaining the 
graphic features of the publishing layout view and how to set the layout options in 
a new publication. After a quick tour of the publication templates, the chapter 
gives you step-by-step instructions on how to use text boxes, shapes, and  
SmartArt. It finishes with instructions for selecting, resizing, aligning, distributing, 
rotating, and grouping objects. 

 

 

 
 

Examining the Publishing Layout View 
The publishing layout view is unlike any other view in Word. It is a graphic design 
environment, not a text environment. It's not a full-blown design application—
nothing close to Adobe Illustrator or Photoshop—but for a design application 
that's tucked into a word processing program, it's pretty darned good. Graphic 
designers in the "real" graphic design world wouldn't be caught dead using it, but 
for nonprofessionals, it serves a great purpose. It's much easier to learn and  
use than the professional design applications, and it can produce some very  
professional-looking results. 

Throughout this chapter, unless otherwise noted, you can assume that the 
publishing layout view is the view in use. 



Because the publishing layout view is not a text environment, you cannot click 
the pointer on the page and start typing. Everything in a publication is an object 
that must be placed in some manner. If you want to type text, you place a text 
box object on the page and type in the text box. When you place objects on a 
page, Word automatically creates layers for the objects.  

Creating a New Publication 
You can use one of two methods to create a publication. If you are already in a 
Word document, you can switch to the publishing layout view and click the Cre-
ate New button to open a new publication that uses the blank template. The  
other method is to select a template from the Document Gallery. 

Using a Blank Template 
If you are reading this chapter sequentially, I suggest you use the first method to 
create a blank publication so you can use it to experiment with as you go through 
the following sections of this chapter. By starting with a blank template, you won't 
be confused by template elements that may not be present in all templates. 

Using a Designed Template 
When you are ready to create a real publication, if you have no experience in de-
signing anything, I highly recommend you use one of the templates included in 
Word. They have been professionally designed, they look really good, there are 
plenty of them, and there are lots more you can download from the Web. (The 
term word publishing templates resulted in 3,740,000 hits in Google, so I think 
you can find a template that fits your needs.) 

 

SHOW ME  Media 6.1—Using a Template to Create a Publication 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

  

LET ME TRY IT 

Using a Template to Create a Publication 
To create a publication from a template, follow these steps: 

1. Click the New from Template button in the Standard toolbar. 

2. Scroll down to the Publishing Layout section in the left sidebar if necessary. 



3. Click a category such as Newsletters or Brochures. The templates for the 
category display in the middle pane. 

4. To see all the pages of a template, move the pointer across the thumbnail 
in the middle pane. 

5. In the middle pane, click the template you want to use. The template you 
select displays in the right pane. 

6. To get a better look at the individual pages of the template, click the scroll 
buttons in the right pane (shown in Figure 6.1). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 6.1 The template you select in the middle pane displays in the right pane, and 
you can scroll through its pages. 

 

7. Select a different set of colors from the Colors pop-up menu and scroll the 
thumbnail again to see the difference. 

8. Select a different set of fonts from the Fonts pop-up menu and scroll the 
thumbnail to see the difference. 

9. Click Choose when finished. Word creates the publication using the color 
scheme you selected, and it has placeholders for text and photos. The text 
placeholders contain Latin, often referred to as Lorem Ipsum text, and the 
photo placeholders contain stock photos. 



10. Replace the content of the placeholders with your own text and photos. To 
replace the text in a text placeholder, select the text box and then double-
click it to clear the text. To replace a photo, simply drag a new photo to the 
placeholder. 

TELL ME MORE  Media 6.2—Exploring Lorem Ipsum Text 
Access this audio recording through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

Saving a Publication 
There is nothing different about saving a publication. You can save it as a DOCX 
file just as you would any Word document. As with any file you save in Word 
2011, there also might be compatibility issues with other versions of Word. If you 
want to publish the file to the Web and make it downloadable, you can save the 
file in PDF format. 

Setting Up the Graphic Environment 
Much of the graphic environment is already set up for you. The ribbon has all the 
tools you need, and the Standard toolbar even has special tools just for graphics. 
Some features, however, are not turned on by default, and you need to know 
what these features are and why you need them. 

Setting Options for Nonprinting Guides 
The graphic environment requires precision and exact measurements so objects 
can be created and placed correctly and consistently throughout the publication. 
To assist you with placing objects, Word provides you with nonprinting guide-
lines, which include gridlines, ruler guides, and object outlines. 

You can use gridlines to help you place objects manually, and you can turn on 
their magnetic power so that objects snap to them automatically. By default, 
Word has horizontal and vertical gridlines set up at 0.13 inch (a little over 1/8 
inch), but it doesn't display them. You have to turn them on. (When you turn on 
the display of gridlines, they are also visible in the Print Layout view. After you 
turn on the display of gridlines, all documents display them, not just the docu-
ment you are in.) 

 

 To learn more about the magnet power of gridlines, see "Aligning Objects," 
later in this chapter. 

  



LET ME TRY IT 

Turning On the Display of Gridlines 
To make gridlines visible, follow these steps: 

1. Click the Layout tab on the ribbon. 

2. Click Options under Grid to open the dialog box shown in Figure 6.2. 

3. Check Display Gridlines on Screen and click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 6.2 Displaying gridlines helps you place objects more precisely on a page. 

 
 
 

A ruler guide is a nonprinting horizontal or vertical line that you drag from the 
ruler to use as a guide for aligning objects. The display of ruler guides is on by 
default to assist you in the design process. These guides can be distracting, so 
sometimes you might want to turn them off to view the page without them. 

  

LET ME TRY IT 

Turning on the Display of Guidelines and Outlines 
To turn on guidelines, follow these steps: 



1. Click the Layout tab on the ribbon. 

2. Click Show Under Guides to show the pop-up menu. 

3. Check Static Guides if it is not checked already. 
 

 

 
 

The outline of an object is the rectangular border that defines the space around 
the object. Even if you draw a circle, the circle occupies a rectangular space. The 
display of outlines is off by default, but you can turn on the display if you need 
help placing shapes at exact locations. To show or hide object outlines, click the 
Show button on the Layout tab on the ribbon and check or uncheck Outlines. 

Getting Acquainted with the Publishing Tools 
Seven special tools appear on the Standard toolbar in the publishing layout view. 
These tools are invaluable, so be sure you have the Standard toolbar turned on. 
Figure 6.3 shows the section of the toolbar that contains the following tools: 

▪ Selection Tool—The Selection tool is active by default. It actually is the 
pointer for the mouse. You use it to select objects in the publication. 

▪ Text Box—Use this tool to create a text box. The Home tab on the ribbon 
also has a text box tool, but the one in the toolbar is always available. 

▪ Vertical Text Box—This tool creates a text box in which the text direction 
is vertical instead of horizontal. 

▪ Draw Shape—This tool has 15 of the most commonly used shapes. Be-
cause it is always accessible, it is more convenient to use than the Shape 
button on the Home tab. Of course, if you want to draw a shape that is not 
on this tool, you have to resort to the button on the Home tab or the Shapes 
tab of the Media Browser. 

▪ Draw Line—This tool has a straight line and two types of arrows, but it also 
has some freehand drawing options that are pretty cool. You can draw the 
following: 

▪ A zigzagged line that the tool converts to a smooth curve 

To place a ruler guide on a page, point to the vertical ruler and 
drag to the right, or point to the horizontal ruler and drag down. As 
you are dragging the guide, its position shows on the opposite 
ruler. When the guide is lined up with the desired measurement on 
the opposite ruler, drop it. 



▪ A closed polygon (with any number of sides) 

▪ A freehand line 

▪ Hand Tool—Use this tool when the zoom is so large that only a portion of 
the page is visible on the screen. You can use the hand tool to drag an-
other portion of the page into view. 

▪ Zoom Loupe—This zoom tool works differently from simply zooming in or 
zooming out using the Zoom slider in the status bar. It zooms in or out on 
the location that you point to with the tool. To zoom in, you drag the tool to 
the right or down. To zoom out, you drag the tool to the left or up. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 6.3 These special tools appear only on the Standard toolbar in the Publishing 
Layout view. 

 

Laying Out a Publication 
Just as you specify layout options for a regular document (paper size, margins, 
and orientation), you must also specify these options for a publication. The op-
tions are the same, so you shouldn't have any trouble setting them. You can click 
Format on the menu bar and then click Document to open the Document dialog 
box (discussed in detail in Chapter 3, "Formatting Documents"), or you can set 
individual layout options using the Layout tab on the ribbon. 

Creating Master Pages 
A master page serves as a template for new pages that you add to your publica-
tion. It usually contains ruler guides and standard objects that you want to repeat 
on every page. For example, a master page might have a text box across the 
bottom that contains a copyright notice. 

 

 

 
 

Although you can pull guides onto a content page, it is better to put 
the guides on the master page. The guides show up on the content 
page, but you cannot accidentally move them because they are not 
physically on the content page. 



 
 

Every publication has at least one master page, even if it's blank. You can add 
content to a blank master page and create additional master pages to use as 
templates for other pages in the publications. For example, you might have a 
master page for left-hand pages and a master page for right-hand pages. 

To add content to an existing master page, click the Master Pages tab in the 
lower-right corner of the window. Use the techniques outlined in this chapter to 
add objects to the page. To create a new master page, click the Layout tab on 
the ribbon, click the Add button under Pages, and click New Master. 

Creating Content Pages 
If you have only one master page, you create additional, new content pages by 
clicking the Add button on the Layout tab on the ribbon. The new page appears 
on the screen, and the previous page scrolls up out of sight. 

 

 

 
 

If you have more than one master page, you must select the master on which 
you want to base the new page before adding the page. To select the master, 
click View on the menu bar, point to Sidebar, and click Thumbnail Pane. Click the 
thumbnail of the master you want to use and then click the Add button on the 
Layout tab. 

Inserting and Working with Text Boxes 
In many published documents, you have text that must flow continuously from 
one place to another, such as an article in a newspaper or magazine. To accom-
plish this text flow in Word, you use linked text boxes. In Word, the text that flows 
through the text boxes is called a story. 

Before you start creating a set of linked text boxes, make sure Outlines are visi-
ble (as described earlier in this chapter) so you can see the text boxes even if 
they have no text in them. Because you can have more than one set of linked 
text boxes in a document, each set of linked text boxes uses a different color for 
the outlines. 

 

 

Because the publishing layout view is not a text environment, Word 
never generates automatic page breaks for you because you have 
"filled up the page." Technically, you can stack more layers on a 
page than you would ever possibly need, so a page never fills up. 



 
 

 

SHOW ME  Media 6.3—Creating Linked Text Boxes and Filling 
Them with a Story 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

  

LET ME TRY IT 

Creating Linked Text Boxes 
You can link as many as 32 text boxes in one document. To link text boxes, fol-
low these steps: 

1. Click the Text Box button in the toolbar. 

2. Drag the pointer to create the first text box. 

3. Point to the square handle on the right side of the text box just above the 
bottom corner handle (see Figure 6.4). Click the plus sign in the handle and 
draw another text box at the location (on any page) where the story should 
continue. Word numbers the text boxes in the upper-left corner. 

4. Repeat step 3 for each successive text box that you want to link to a new 
text box. 

 

 

 

Adding the Story to the Linked Text Boxes 
When you are ready to start adding text to your blank text boxes, you can type 
the text or paste it. The text is referred to as a story. It's only logical to start in 
Box 1, but if you start typing text or you paste text in Box 2 or higher, Word still 
puts the text in Box 1. When the first text box fills up, the text flows into the next 
linked text box and continues to flow to the other linked text boxes. If you have 

To add a text box at the beginning (before the first box), click the 
plus box in the upper-left border of Box 1. 

Turning on Outlines also makes outlines visible around shapes. If 
this is too distracting, you might want to turn off the Outlines after 
you are finished working with the linked text boxes. 



too many text boxes, you can delete the ones you don't need on the end. If the 
opposite is true—you don't have enough text boxes—you can add more text 
boxes or increase the size of the existing text boxes to accommodate more text. 

To navigate between linked text boxes, select a text box and then click the arrow 
on the right side of the text box border to go to the next text box in the story or 
click the arrow on the left side of the border to go to the previous text box in the 
story. 

Breaking a Story into Two Stories 
If you want a story to stop flowing between text boxes for some reason, you can 
break the link. The text boxes that remain before and after the break are still 
linked to each other but text can no longer flow across the broken link. 

  

LET ME TRY IT 

Breaking a Link Between Text Boxes 
A text box has only one backward link and one forward link. If you break the link 
between text boxes, you create two stories. To break a link between text boxes, 
follow these steps: 

1. In Publishing Layout view, click the text box you want to be the last text box 
in the story. 

2. Click the Format tab on the ribbon. 

3. Click the Break Link button under Text Box. 

Deleting a Text Box in a Linked Set 
Now say you have a story that uses three linked text boxes. One text box is on 
page one, the second text box is on page three, and the third text box is on page 
five. You just sold a $1,000 full-page advertisement, and you want to put it on 
page three. You need to delete the text box on that page, but you don't want to 
break the flow of the story. No problem; you can delete the text box itself without 
breaking the link. The text in the first text box will flow to the text box on page 
five, but the text box on page five will not be able to hold all the new text at its 
current size. When a text box has text that is not visible, the bottom outline of the 
box has a text symbol on it, as shown in Figure 6.4. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 

 

Figure 6.4 The "A…" in the box indicates that there is more text than the text box can 
show. 

  

LET ME TRY IT 

Deleting a Text Box in a Linked Series 
To delete a text box without breaking the link, follow these steps: 

1. Select the text box you want to delete. 

2. Point to the border until the pointer turns to a four-headed arrow. 

3. Click the border and press the Delete key. Text that was in the deleted text 
box flows to the next text box in the series. 

Formatting Text Boxes 
You can set various formats for text boxes, including text alignment, text direc-
tion, margins, fills, borders, shadows, and so on. If you want to call attention to 
some short text in a publication by giving it a border and filling in the background 
with a light color, a formatted text box is just the trick. 
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Formatting a Text Box 
To apply various formatting to a text box, follow these steps: 

1. Right-click the text box and click Format Shape. The dialog box in Figure 
6.5 opens. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 

 

Figure 6.5 The Text Box option on the left is not the only option that applies to text 
boxes. 

 

2. Click Text Box to set the alignment, text direction, internal margins, and so 
on. 

3. Click Fill to add a background color. 

4. Click Line to add a border. 

5. Click Shadow to add a shadow. 

6. Continue adding as much formatting as you like, and then click OK. 
 

 

 
 

Inserting and Working with Shapes 
Publications often use shapes as backgrounds for text. For example, if you are 
creating a flyer to sell a product, you might want to put the price of the product in 
a starburst. 

You can add shapes to a publication via the ribbon or the Media Browser, which 
is discussed in detail later in this chapter. I prefer the ribbon for inserting shapes 
because you can size the shape as you insert it. If you drag a shape to the  

If you want to use the same formatting for all text boxes, after you 
have set the formats, right-click the text box and click Set as Default 
Textbox. 



publication from the Media Browser, it comes in at a standard size and you have 
to resize it after it appears on the page.  
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Inserting a Shape from the Ribbon 
To insert a shape in a publication, follow these steps: 

1. On the Home tab on the ribbon, click the Shape button (under Insert). 

2. Point to a shape category to reveal your choices, as shown in Figure 6.6. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 6.6 The pop-up menu shows all the shapes available in the Stars and  
Banners category. 

3. Click the shape you want, point to location where you want to place the 
shape, and drag the pointer to create the size you want. (Hold down the 
Shift key as you drag if you want the shape to maintain its proportion.) 

4. While the shape is still selected, you can type or paste text in it unless the 
shape is some form of a line. 



Changing the Style of a Shape 
When you insert a shape, Word uses a fill color (mandated by the theme of the 
template) and a default appearance. For example, the blank template uses blue 
fill for shapes, and it makes shapes one-dimensional. You can easily change the 
appearance of a shape by changing the style of the shape. 
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Changing the Appearance of a Shape 
To change the appearance of a shape, follow these steps: 

1. Select the shape and click the Format tab on the ribbon. 

2. Click Quick Styles under Shape Styles. 

3. Click the new style you want to use. 

4. Use the buttons in the Quick Styles area to change the border color, the fill, 
effects, and so on.  

Changing to a Different Shape 
After you insert a shape, you can easily change it to a different shape if your de-
sign calls for it. You don't need to delete the shape and insert a different one. 
Any text that you might have added and formatted inside the shape remains 
when you change to a new shape.  
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Changing a Shape 
To change a shape to a different shape, follow these steps: 

1. Select the shape. 

2. Click the SmartArt tab on the ribbon. 

3. Click the Shape button under Edit SmartArt. 

4. Point to the category that has the shape you want, and then click the new 
shape you want to use. 



Changing the Fill and Outline 
Every shape has a fill and an outline that you can change to coordinate with your 
design. In the Office theme, the default fill is a solid color blue, and the outline is 
a 3/4-point line that is the same color as the fill, so you really can't see the out-
line. For a shape's fill, you can choose a solid color or gradient, a photo or tex-
ture, or a pattern. For an outline, you can choose the color, weight, and dash 
pattern. 
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Changing the Fill of a Shape 
You can change the fill color using a button on the ribbon, or you can open a dia-
log box that gives you access to additional fill options. To change the fill, follow 
these steps: 

1. Select the shape. 

2. Click the Format tab on the ribbon. 

3. Click the Fill pop-up button (under Shape Styles) and click the color you 
want, or click Fill Effects to open the dialog box shown in Figure 6.7. Click 
the tab you want, make the selections you want, and click OK. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 

Figure 6.7 A shape can have a solid color, gradient, picture, texture, or pattern as a 
fill. 
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Changing the Outline of a Shape 
You can change one outline property at a time using a button on the ribbon, or 
you can open a dialog box that gives you access to all the properties at once. To 
change the outline of a shape, follow these steps: 

1. Select the shape. 

2. Click the Format tab on the ribbon. 

3. Click the Line pop-up button (under Shape Styles) and do one of the follow-
ing: 

▪ Select a different color. 

▪ Point to Weights and select a different line weight. 

▪ Point to Dashed and select a solid or dashed pattern. 

▪ Point to Arrows and select an arrow type. 



 Alternatively, you can click the Line pop-up button and click Line Effects to 
open the dialog box shown in Figure 6.8. Make all your selections in the 
three different tabs of the dialog box and click OK. 

 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 6.8 Change the color of the outline on the Solid or Gradient tabs and all other 
properties on the Weights & Arrow tab. 

 

Inserting and Working with SmartArt 
The SmartArt graphics are actually multiple shapes, which, in combination, pro-
vide a visual representation of a concept such as a process, cycle, hierarchy, or 
relationship. They have their own tab on the ribbon, and you'll find them in Word, 
Excel, and PowerPoint. They work exactly the same way in all Office applica-
tions. 

 

If you change the color of the fill or line, the corresponding buttons 
on the Ribbon reflect the new color. You can then apply the new 
color to any shape by selecting the shape and clicking the button 
(not the pop-up arrow on the button). 



SHOW ME  Media 6.4—Inserting a SmartArt Graphic 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 
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Inserting a SmartArt Graphic 
To insert a SmartArt shape, follow these steps: 

1. Click the SmartArt tab on the ribbon. 

2. Click the pop-up button for the type of graphic you want to insert. Figure 6.9 
shows the graphics available for a process. (Take the time to look at all the 
SmartArt graphics so you know what's available to you.) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 6.9 The graphics for a process all use a linear pattern. 

3. Click the SmartArt graphic you want to insert. 

4. Click a text placeholder ([Text]) and type the text you want in the place-
holder. Alternatively, you can type all the text in the Text Pane. If neces-
sary, click the Text Pane icon to open the pane shown in Figure 6.10. 
SmartArt automatically adjusts the size of the font to fit the drawing. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 

 

Figure 6.10 In the Text Pane, you can add more placeholders by pressing Return. 

 

Modifying a SmartArt Graphic 
To make modifications to the number, position, and hierarchy of the shapes that 
make up the SmartArt graphic, you use the Text Pane of the graphic. Remember 
that you can display the Text Pane by clicking the Text Pane icon in the upper-
left corner of the SmartArt object. Table 6.1 lists the modifications and how to 
make them. To make the SmartArt modifications, click anywhere in the line of 
text in the Text Pane, and then click the appropriate button. 

 
 
 
 
 
 
 
 
 
 
 

Table 6.1 SmartArt Modifications 

Action Button 

Add a shape Green plus 

Delete a shape Red minus 

Move a shape up Green triangle that points up 

Move a shape down Green triangle that points 
down 

Lower the level of a shape Blue arrow that points right 

Raise the level of a shape Blue arrow that points left 
. 

Changing the Style of a SmartArt Graphic 
After you insert a SmartArt graphic, if you don't like the style, you can easily 
change its appearance by selecting a different style. For example, Figure 6.11 
shows the default graphic at the top and a different style for the graphic below it. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 

 

Figure 6.11 Applying a different style to a graphic keeps the same overall design but 
adds different textures, dimensions, or perspectives. 
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Changing the Appearance of a SmartArt Graphic 
To change the appearance of the shapes in a SmartArt graphic, follow these 
steps: 

1. Click the SmartArt object to select it. 

2. Click the SmartArt tab on the ribbon. 

3. Under SmartArt Graphic Styles, scroll the styles until you find the one you 
want and click it. (If you want to see all styles at once, point to the scrolling 
area and click the arrow at the bottom.) 

Changing the Color of a SmartArt Graphic 
By default, SmartArt graphics use the color scheme mandated by the theme of 
the template. You can override these colors by selecting a different color 
scheme. 

  



LET ME TRY IT 

Applying a Different Color Scheme to a SmartArt Graphic 
To apply a different color scheme to a SmartArt graphic, follow these steps: 

1. Click the SmartArt object to select it. 

2. Click the SmartArt tab on the ribbon. 

3. Under SmartArt Graphic Styles, click the Color button and select the color 
scheme you want. 

Resetting a SmartArt Graphic 
After making changes to colors and styles, you can reset a SmartArt graphic to 
its original appearance by clicking the Reset Graphic button on the SmartArt tab 
on the ribbon. The Reset Graphic button does not reset modifications that you 
have made to the graphic to add or delete shapes, move them up or down, or 
promote or demote them. 

Inserting Media from the Media Browser 
The Media Browser, a feature that works the same in Word, Excel, and Power-
Point, is a palette with six tabs: Photos, Audio, Movies, Clip Art, Symbols, and 
Shapes. It's very simple to use. Each tab contains items that you can select and 
then drag into a file. 

To use the Media Browser, first display it by using one of these three methods: 

▪ Click the Media Browser button in the Standard toolbar. 

▪ Click View on the menu bar and click Media Browser. 

▪ Press the shortcut keys Ctrl-Cmd-M. 

When you drag an item into a document, the item is a fixed size. No matter how 
small or large the thumbnails in the browser are, the items are always the same 
size when you drag them into the document. 

Getting Acquainted with the Photos Tab 
The Photos tab gives you access to the files stored in iPhoto and Photo Booth. 
You cannot use the Media Browser to insert a photo from any other locations. 
For this, you have to use the Insert, Photo, Picture from File command. 



Figure 6.12 shows the Photos tab. The viewing area of the tab shows thumbnails 
of the graphic files, and you can show larger or smaller thumbnails (and, there-
fore, fewer or more) by moving the slider at the bottom of the tab to the right or 
left. Notice that the total number of items displays in the lower-right corner just 
above the slider. Because most people have scads of photos, Microsoft wisely 
provides a Spotlight search box in this tab so you can search for the photo or 
movie you want by name. 

 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 6.12 The Photos tab of the Media Browser contains a Spotlight search box to 
help you locate the photo you want . 

 

Getting Acquainted with the Audio Tab 
The Audio tab gives you access to audio files stored in the default folders for Ga-
rageBand and iTunes. Additionally, it directly accesses all the playlists that you 
have in iTunes. Figure 6.13 shows the possibilities in the pop-up menu. If you 
have audio files stored in other locations, you have to insert them with the Insert, 
Audio, Audio from File command. 

 

Because iPhoto and Photo Booth can contain movies, you actually 
can insert a movie from the Photo tab. Before inserting it, you can 
even play the movie to be sure it's the one you want by selecting 
the file in the viewing area and clicking the Play button (located to 
the left of the Spotlight search box). 



 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 6.13 Select an option from the pop-up menu to show only the items in the  
selected location. 

 

This tab uses a list to display items instead of thumbnails; therefore, it has no 
slider to change the size of the items in the viewing area. It has a Play button, a 
Spotlight search box, and it displays the total number of items in the folder. 

Getting Acquainted with the Movies Tab 
The pop-up menu at the top of the Movies tab gives you access to movies stored 
in the Movies folder, in iPhoto, Photo Booth, and iTunes. To insert a movie from 
any other location, you must use the Insert, Movie, Movie from File command. 

The Movies tab uses thumbnails to display movies in the viewing area, and you 
can use the slider at the bottom of the tab to increase or decrease the size of the 
thumbnails. You also can play a selected movie before you drag it to a file to be 
sure it's the one you want. The Movies tab also has a Spotlight search box and 
displays the total number of items in the folder. 

Getting Acquainted with the Clip Art Tab 
The Clip Art tab gives you access to some of the clip art that comes with Office 
2011. Using the pop-up menu, you can display thumbnails for all the clip art or 
individual categories, such as Animals, Business, Food & Dining, and so on. This 
tab has a slider to adjust the size of the thumbnails, and it displays the total 
number of items available. 

 

 



 
 

Getting Acquainted with the Symbols Tab 
The pop-up menu in the Symbols tab enables you to view all the symbols or spe-
cific categories of symbols, such as Currency, Fractions, Math, and so on. The 
tab has a slider to adjust the size of the symbols, and it displays the total number 
of items. When you drag a symbol to a Word document, Word uses the Lucinda 
Grande font, so if you want the symbol to match the font of the text, you will have 
to change the font for the symbol.  

Getting Acquainted with the Shapes Tab 
The Shapes tab has 160 different shapes that you can use. You can display all 
the shapes or select a category from the pop-up menu. Categories include Rec-
tangles, Basic Shapes, Lines and Connectors, Block Arrows, Equation Shapes, 
Flowchart, Stars and Banners, and Callouts. 

The Shapes tab has a slider to adjust the size of the shapes that display in the 
viewing area, and it displays the total number of items. It also has a Spotlight 
search box. For example, you might type a search phrase in the search box such 
as circular, quad, or diagonal. 

Manipulating the Objects in a Publication 
All professional design applications, such as Adobe Illustrator, have commands 
and techniques that help you manipulate objects. Office 2011 offers many of the 
same tools, including tools for resizing, aligning, distributing, rotating, grouping, 
and stacking objects. 

Changing the Stacking Order of Objects 
The first step in any technique that manipulates an object is to select the object. 
If objects are stacked, selecting an object that is behind another object may be 
difficult. If this is the case, you might need to change the stacking order tempo-
rarily so you can select the object you need to manipulate. 

Even better than the Clip Art tab of the Media Browser is the Clip 
Art Gallery. To open it, click Insert in the menu bar, click Clip Art, 
and click Clip Art Gallery. You can import additional files to the Clip 
Art Gallery. 



Chapter 4, "Exploring Other Features," discusses the process of changing the 
stacking order in reference to photographs, and it is the same process for 
graphic objects, but this chapter includes the steps again for your convenience. 
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Changing the Stacking Order 
To change the stacking order of objects, follow these steps: 

1. On the Home tab on the ribbon, click the Reorder button. 

2. Drag the layer to a new position and click OK. 

Resizing Objects 
You probably know that you can resize an object by selecting it and dragging a 
sizing handle. To keep the same proportion, you hold down the Shift key as you 
drag a corner-sizing handle. This sort of seat-of-the-pants resizing is fine in some 
cases, but many times in a publication, you need to resize identical objects that 
must be exactly the same size. To have precise control over the size of an ob-
ject, you can use the Size tool on the ribbon. 
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Changing the Size of an Object with Precise Measurements 
To change the size of an object or photograph, follow these steps: 

1. Select the object or photograph. 

2. Click the Format tab on the ribbon for an object or click the Format Photo 
tab on the ribbon for a photo. 

3. Under Size, enter the exact Height and Width. (Click the check box that 
joins the two text boxes if you want to lock the aspect ratio. By checking 
this box, you can enter one measurement, and Word computes the other 
measurement automatically to resize the object proportionally.) 

Aligning Objects 
If you have multiple objects on a page, such as photos or text boxes, you often 
need to make sure they are aligned. One way of aligning objects is to display  
the grid and turn on the snap to grid option. The snap to grid feature makes the  



gridlines magnetic so that when you place an object, the outline of the object 
automatically snaps to the nearest grid. 
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Turning on the Snap to Grid Feature 
To set the Snap Objects options in the Grid Options dialog box, follow these 
steps: 

1. Select an object. 

2. Click the Format tab on the ribbon and click the Align button (under Ar-
range). 

3. Click Grid Options to open the dialog box. (Refer to Figure 6.2.) 

4. Under Snap Objects, click the check box for To Grid in Publishing Layout 
View. 

5. Click OK. 

Another way to align objects is to drag ruler guides onto the page and manually 
align objects to the guides, but the most precise way to align objects is to use the 
Align command. This command provides the following choices: Align Left, Align 
Center, Align Right, Align Top, Align Middle, and Align Bottom. Each alignment 
option has a visual representation to help you select the correct alignment for the 
objects you are trying to align. 
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Aligning Objects with the Align Command 
To align multiple objects in the most precise way, follow these steps: 

1. Select all the objects. 

2. Click the Format tab on the ribbon. 

3. Click the Align button (under Arrange) and make sure that the Align Se-
lected Objects option is checked. (If it isn't, check it and click the Align but-
ton again.) Then select the alignment that you want.  

Distributing Objects 
Distributing objects puts equal amounts of space between the objects. Let's say 
that you want to put three equally sized photographs on a page side by side. You 



drag the first one so its left side is on the left margin, you drag the second one so 
its right side is on the right margin, and you drag the third one so it is in the mid-
dle, but you want the space on either side of the middle photo to be exactly the 
same. You can eye-ball it, but to be precise, you can use the Distribute com-
mand. 
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Distributing Objects 
To distribute three or more objects equally, either horizontally or vertically, follow 
these steps: 

1. Select at least three objects. 

2. Click the Format tab on the ribbon. 

3. Click the Align button (under Arrange). 

4. Click Distribute Horizontally or click Distribute Vertically. 

Rotating and Flipping Objects 
Each object has a green rotation handle you can drag to rotate the object. The 
handle shows up when you select the object. As you drag the handle, the object 
turns in a circular motion, and a pop-up box tells you the number of degrees you 
have rotated the object. Additionally, you can flip an object vertically or horizon-
tally. 
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Flipping an Object 
To flip an object vertically or horizontally, follow these steps: 

1. Select the object. 

2. Click the Format tab on the ribbon. 

3. Click the Rotate button and select Flip Vertical or Flip Horizontal. 

Grouping Objects 
Sometimes you might need to group several objects so they function as one ob-
ject. For example, if you create a graphic of a target using layers of concentric 
circles, you could group all the layers so they function as one graphic. This  



prevents you from accidentally moving or altering an individual object in the 
graphic. It also enables you to resize all the objects in the graphic at the same 
time and in the same proportion. 
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Grouping Objects 
To group objects, follow these steps: 

1. Select all the objects. 

2. Click the Format tab on the ribbon. 

3. Under Arrange, click the Group button and click Group. 
 

 

 
 

If you need to manipulate one object in a group, you can ungroup 
the objects, make your change, and then group the objects again. 
To ungroup objects, select the group, click the Format tab, click the 
Group button, and click Ungroup. 



7 This chapter looks at the Outlook Mail window. It 
tells you how to set up an e-mail account and send, 
receive, and organize your e-mail.  

Using E-mail 
The focus of this chapter is the e-mail component of Outlook. It covers the e-mail 
interface, plus how to set up an e-mail user account, view and read e-mail mes-
sages and attachments, send replies and attachments, organize messages in 
folders, find messages, and filter spam. 

Exploring the Mail Interface 
To open Mail, first open Outlook. Then, if necessary, click Mail (see Figure 7.1). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Figure 7.1 The navigation pane lists all e-mail accounts. 



The Mail window has the following standard features: a title bar, a toolbar, the 
ribbon, and a status bar. 

 

 To learn more about how the ribbon works, see "Getting Familiar with the 
Ribbon" in Chapter 1, "Getting Started with Word." 

The pane on the left is called the navigation pane. It contains the Mail folders 
called Inbox, Drafts, Sent Items, Deleted Items, and Junk E-mail and the virtual 
folders called Smart Folders (covered in detail later in this chapter). Additional 
folders appear in the navigation pane if you set up certain types of user ac-
counts. For example, if you have a Gmail account, a Gmail folder appears in the 
list, as shown in Figure 7.1. 

The screen area to the right of the navigation pane contains the item list and the 
reading pane. The item list displays your e-mail messages, and the reading pane 
shows the content of the message that is currently selected in the item list. The 
reading pane can be hidden or displayed either to the right of or under the item 
list. Figure 7.1 shows the reading pane on the bottom (my preference because I 
like a wide view of the item list), and Figure 7.2 shows the reading pane on the 
right. (To select the view you want to use, click the Organize tab on the ribbon, 
click the Reading Pane button, and click Right, Below, or Hidden.) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7.2 When the reading pane is on the right, you can't see as much information 
in the item list. 



 

Understanding the Client/Server Relationship 
E-mail is practically universal now, and it has become one of those things, like 
electricity, that people use without understanding how it works. For e-mail to 
work, two programs are required: a server application and a client application. 
The client application manages e-mail and is active only when a user runs it. The 
server application runs all the time, provides all e-mail services such as sending 
and receiving messages, and fills requests from client applications. 

If the preceding paragraph sounds too technical and you're ready to bolt, stay 
with me for just a little longer. I'm making a point that will be important to you 
when you set up an e-mail account in Outlook. 

The Microsoft client/server applications are Outlook (the client) and Microsoft Ex-
change Server (the server). Outlook does not actually send and receive e-mail 
messages in and of itself. It can only make requests to a server. A typical Out-
look request of the server would be (in layman's terms) "download all new e-mail 
messages to me." 

Although Outlook is made specifically to work with Exchange Server, it also 
works well with numerous other server applications. If you work at a company or 
organization that uses Microsoft Exchange Server, it's likely that someone has 
already set up your Exchange user account in Outlook for you. Otherwise, you're 
probably on your own. This means you'll have to set up a user account in Out-
look to connect Outlook with the server application that processes your e-mail 
address. This might be a server application from Google, Hotmail, or a web-
hosting service such as Go Daddy. 

  

LET ME TRY IT 

Setting Up an E-mail Account with Automatic Configuration 
If you have an e-mail account with a major provider, such as AOL, Google, Mac, 
Hotmail, and so on, you can supply Outlook with your e-mail address and pass-
word, and it can usually set up your e-mail account without additional informa-
tion. It knows the settings to use for these common e-mail accounts. To set up a 
user account for a common e-mail account, follow these steps: 

1. Click Tools on the menu bar and click Accounts. The Accounts window 
opens. If no account has been set up yet, the window looks like the one 
shown in Figure 7.3. 

2. Click the E-mail Account button. 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 7.3 The Accounts window lists all the e-mail accounts that you have set up in 
Outlook. 

3. Type your e-mail address and password and click Add Account. Outlook 
fills in the incoming and outgoing server names and port numbers for you, 
and the new account name appears in the Accounts sidebar as well as in 
the Outlook Mail navigation pane. Close the Accounts window. 

 

 

 
 

If Outlook cannot set up the e-mail account for you automatically, you have to 
supply the account information yourself. You need to know which protocol your 
e-mail server uses (POP3 or IMAP), the names of the incoming and outgoing 
servers, the port numbers, and so on. This information is usually available in the 
Help files at the provider's website. For example, if you have your own domain 
hosted by 1and1.com, you can find all this information in the Support area of the 
1and1 website.  

You can set up multiple user accounts in Outlook so that e-mail 
from all your e-mail addresses can come to one location. To set up 
another account, click the plus button in the bottom-left corner, click 
E-mail, enter your e-mail address and password, and click Add  
Account. 



Setting Up an Exchange Account 
Generally, you do not have to set up an Exchange Account yourself. If you are 
part of an organization that uses the Exchange Server, an Exchange administra-
tor usually sets up all the e-mail accounts. However, Outlook can configure an 
Exchange account automatically if you are connected to the server and can sup-
ply a minimal amount of information. To learn more about this process, listen to 
the audio recording I've made for you. 

TELL ME MORE  Media 7.1—Setting Up an Exchange Account 
Access this audio recording through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

Viewing and Reading E-mail 
After people know you have an e-mail address, it won't be long before you have 
lots of e-mail to read. Most people leave Outlook running all the time so they can 
check e-mail continually. If you leave Outlook open, it alerts you when you have 
new mail even if you aren't in the Outlook window. It plays a sound and displays 
a pop-up alert that tells you the name of the sender and the subject. The notifica-
tion appears for only a very short time, so if you're not sitting at your computer, 
you'll miss it. It appears just long enough that you can click the Delete button in 
the notification if you know without even opening the message that you want to 
get rid of it. 

 

 

 
 

Outlook checks for new messages on a regular basis and stores your e-mail 
messages in the Inbox. If you want to send or receive e-mail immediately, click 
the Send/Receive button in the toolbar or on the Home tab on the ribbon. 

The item list, where messages are listed, has the following columns of informa-
tion for each message: Message Status, Priority, Attachment, From, Subject, 
Date Received, Categories, and Flag Status. You can change the order of the 
columns by dragging the column headings to different locations, and you can 
make a column wider or narrower by dragging the right separator of the column 
heading. To add or delete columns in the item list, right-click any column heading 
to display the list of all possible columns. Click an option to display the column 
and click a checked option to hide the column. 

If you'd like to modify the delivery notification, you can find the set-
tings under Notifications and Sounds in the Outlook Preferences. 



If you have the reading pane open, you can see the content of an e-mail just by 
selecting the message in the item list and viewing the content in the reading 
pane. You might have to scroll the reading pane to see all of the content though. 
Most of the time, I just double-click the message in the item list. The e-mail 
opens in a new window, as shown in Figure 7.4. Many times, you can see the 
entire message without scrolling this way. It's also good to use this method if you 
need to view the information in two different e-mail messages at the same time. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 7.4 When you open an e-mail in its own window, you can move it, resize it, 
minimize it, and so on.  

 

Opening and Saving Attachments 
An e-mail attachment is a separate file that the sender has attached to the mes-
sage. You can tell if an e-mail message has an attachment even before you open 
it if you are using the wide view of the item list. The Attachment column displays 
a paper clip if the message has an attachment. When you open an e-mail mes-
sage with an attachment, you see the name of the attachment in the header, as 
shown in Figure 7.5. Opening the e-mail does not open the attachment. You 
have to open it separately by double-clicking the name of the attachment. In-
stead of actually opening the attachment, you can view a preview in the Mac 



Previewer application. Click the Preview button beside the attachment. (The but-
ton changes to Preview All if the list shows more than one attachment.) 

A sender can send any type of file in an e-mail message. To open the attach-
ment and be able to read the file, you must have an application on your computer 
that can read the file. For example, if you receive a Photoshop file with the .psd 
extension, and you don't have Photoshop installed on your Mac, you cannot 
open the file. As I already said, a sender can send any type of file. This includes 
viruses, Trojan horses, and other malicious programs. Use caution when opening 
any type of attachment.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 7.5 The Preview button is called Preview All if more than one attachment is 
listed in the header. 
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Saving an Attachment 
As long as you keep a message, you can go back to it and open its attachment. 
If you don't need the message any more but would like to keep the attachment, 
you can save the attachment and then delete the message. To save an attach-
ment, follow these steps: 

1. Right-click the attachment name and click Save As. 

2. Type a new name for the attachment if desired. 

3. Navigate to the location where you want to save the attachment. If you are 
not able to navigate, expand the dialog box by clicking the down arrow to 
the right of the Save As text box. 

4. Click Save. 



Sending Messages: The Basics 
This section examines the bare bones of sending a message: creating the mes-
sage, typing the message, and sending the message. The section that follows 
this one, "Sending Messages with Bells and Whistles," goes into more detail. 

You can send an e-mail message from within Outlook in several basic ways: You 
can compose a new message, send a reply to a message you have received, or 
forward a message you have received. In all cases, Outlook saves a copy of the 
message that you send in the Sent Items folder, which leaves a great "paper 
trail" if you ever need to check on something. 

At any time, when you are composing a new message, reply, or forward, you can 
click the Save button in the toolbar to save the message in the Drafts folder. 
Then you can close the message and come back to it later. To complete the 
message, open it in the Drafts folder and proceed as usual. 

Composing a New Message 
To compose a new message, click the E-mail button (the first button on the 
Home tab on the ribbon). A new message window opens, as shown in Figure 
7.6. Fill in the header information at the top (see Table 7.1), type the message in 
the body area, and click the Send button. If you are connected to the Internet, 
Outlook sends the message to the Outbox and then sends out the message im-
mediately. If the message is a large one that takes a while to send, you see a 
progress bar in the Outbox in the navigation pane. If the message is very short, 
you might not even see the Outbox open. 

 

 

 
 
 

 
 

Refer to Table 7.1 for instructions on how to fill out the fields at the top of the  
e-mail message. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

If you are not connected to the Internet when you send a message, 
the message goes into the Outbox, where it stays until the next 
time you connect. As soon as you connect to the Internet, Outlook 
sends the messages that are in the Outbox. 



 
 
 
 
 
 
 
 
 
 
 

 

Figure 7.6 A new message is absolutely blank (unless you have a default signature). 

 
 
 
 
 
 
 
 
 
 
 
 
 

Table 7.1 Filling Out Header Information 

Header Field Instructions 

From If you have multiple e-mail accounts in Outlook, you can select 
the e-mail address from which the e-mail should be sent by 
clicking the From pop-up button and clicking the account. 

To, Cc (Carbon 
Copy), and Bcc  

You can type the e-mail address(es) for the recipient(s) in 
these fields if you know the address(es) by heart. Even if you 
don't quite know the complete address, if you can type the first 
few characters, Outlook supplies a list of addresses that start 
with those characters for you to select. The list comes from 
your Outlook contacts, the Apple Address Book (if you choose 
to sync it with Outlook), and from recently used addresses. 

Instead of typing, you can access your Contact list by clicking 
the button at the end of any address field. When the Contacts 
Search window opens, enter the search text. All contacts dis-
play that match the search. Select all the contacts you want to 
include in an address field and click the appropriate button 
(To, Cc, or Bcc). Continue selecting contacts and clicking the 
appropriate buttons. When finished, close the Contacts 
Search window. Note that if you click Bcc for a Contact, Out-
look adds the Bcc field automatically when necessary. 

Subject Type text in this field to give the recipient an idea of what the 
e-mail is about. If you don't enter a subject, when you click the 
Send button, Outlook confirms that you want to send the mes-
sage without a subject.  



. 

Sending Replies to Messages 
When you receive a message that warrants a response, it is better to reply to the 
message than to create a new message. You can send the reply back to the 
sender only, or if the original message was sent to other recipients besides your-
self, you can include those recipients in your reply. 
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Sending a Reply 
To send a reply to a message, follow these steps: 

1. Select the message you want to respond to in the item list or open the 
message. 

2. To send the reply only to the sender, click the Reply button on the Home 
tab on the ribbon. To send the reply to the sender and all other recipients, 
click the Reply All button in the Home tab. Outlook populates the To ad-
dress field for you based on whether you clicked Reply or Reply All. Out-
look also populates the Subject field with the original subject preceded by 
"Re" meaning "in reference to." 

 

 

 
 
 
 

3. Type the text of your reply at the top. The original message displays below. 
 

 

 
 

4. Click the Send button when finished. 

Forwarding a Message 
When you forward a message, you send it to someone who did not receive the 
message when it went out originally. 

  

If you want to quote only a portion of the original message in your 
reply, select that content in the original message before clicking the 
Reply (or Reply All) button. 

You can add or delete addresses in the To and Cc fields as needed. 
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Forwarding a Message 
To forward a message, follow these steps: 

1. Select the message you want to forward in the item list or open the mes-
sage. 

2. Click the Forward button on the Home tab on the ribbon. Outlook populates 
the Subject field with the original subject preceded by "FW" for "forward. 

3. Specify the recipients in the To and Cc fields. 

4. Type any text that you want to add in the space above the original mes-
sage. 

5. Click the Send button when finished. 

Changing Your Mind 
If you are in the middle of composing a new message, reply, or forward, and you 
decide you don't want to create the message after all, just click the red Close 
button in the upper-left corner; then click Discard Changes. 

Sending Messages with Bells and Whistles 
There's quite a bit more to creating an e-mail message than just typing the mes-
sage. You can format the text, assign a priority level, attach files and pictures, in-
sert your signature, and insert hyperlinks. 

 

 

 
 

Attaching Files and Inserting Pictures 
To attach a file to an e-mail message that you are composing, click the Attach 
button on the Message tab on the ribbon. (It's the one that has a paper clip on it.) 
Navigate to the file location and double-click the filename. Using this method, 

Like Word, Outlook checks your spelling and grammar as you type. 
If you want to perform an interactive spell check before you send a 
message, click the Spelling button on the Options tab. The Spell 
Checker in Outlook works very much like Word's Spell Checker. 



you can attach any type of file—data, photograph, video, and so on. Outlook lists 
the name of the attachment(s) in the header on a new line under the Subject line.  

To insert a graphic file in the actual body of the message, you can open the Me-
dia Browser (View, Media Browser) and drag a photo from iPhoto or Photo Booth 
into the body of the message. If the photo you want to insert is not available 
through the Media Browser, click in the body of the message, click the Picture 
button on the Message tab on the ribbon, and click Picture from File. Navigate to 
the graphic file and double-click it. 

Selecting the Message's Format 
The underlying format of a message can be HTML or Plain. If you use HTML 
format, you can then format the text of the message, adding bold, color, and so 
on. If you use the Plain format, the text of the message can have no formatting. 
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Selecting a Format 
To select either the HTML or Plain format for a message, follow these steps: 

1. Create a new message, reply, or forward. 

2. In the message window, click the Options tab on the ribbon. The Format 
button is the first button on the ribbon, as shown in Figure 7.7. 

3. Click the gray box to change the formatting. If the current formatting is set 
on HTML, when you click the gray box to change to Plain, Outlook warns 
you that you will lose any formatting that you have already applied and the 
action cannot be undone. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 7.7 The Format button operates like a switch. When you click the gray box, it 
slides over. 

Some e-mail servers do not accept e-mail messages in HTML for-
mat because of their potential danger. 



 

Formatting the Text 
The text formatting tools appear on the Message tab on the ribbon, as shown in 
Figure 7.8. Use these tools to change the character and paragraph formatting 
just as you would in Word.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 7.8 To format text, select it, and then click the button for the format you want 
to apply. 

 

 To learn more about formatting techniques, see Chapter 3, "Formatting 
Documents." 

 

 
 

Using a Background Color 
To add some color and interest to a message, you can select a color for the 
background of the message text (if you are using the HTML format). If you select 
a dark color for the background, you might want to change the font color to white 
or another light color that will contrast with the background color and make it eas-
ier to read. 

 

SHOW ME  Media 7.2—Applying a Background Color 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 
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Applying a Background Color to a Message 
To apply a background color to a message, follow these steps: 

1. In the message window, click the Options tab on the ribbon. 

The formatting tools are not available if you have selected Plain as 
the message format. 



2. Click anywhere in the body and click the Background Color button. The 
Colors window opens, as shown in Figure 7.9. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 7.9 Each tab in the Colors window represents a different color model. 

 
 
 

3. Click one of the tabs at the top of the window to provide the color model 
you want to use. From left to right, the tabs are Color Wheel, Color Sliders, 
Color Palettes, Image Palettes, and Crayons. Figure 7.9 shows the Color 
Slider tab. 

4. Make appropriate selections for the model you selected. For example, if 
you select the Color Sliders, select RGB Sliders and then slide the Red, 
Green, and Blue sliders to mix the color that you want. 

5. Close the Colors window when finished. 

 

Using a Background Photo or Picture 
Instead of applying a color to the background of the text message, you can use a 
photo or picture. Again, this change is possible only when you're using the HTML 
format, and you might want to consider using a different color for the font. 

  

To ditch a background color quickly, click the Background Color but-
ton, click the Crayons tab, and click the white crayon. 
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Applying a Background Graphic 
To apply a photo or picture to the message background, follow these steps: 

1. In the message window, click the Options tab on the ribbon. 

2. Click anywhere in the body and click the Background Picture button. 

3. Navigate to the picture you want and click the Open button. 
 

 

 

Assigning a Priority 
Assigning a priority to a message places a visual cue in the recipient's Inbox that 
identifies the importance level of the message. You can assign a high priority or 
low priority. If you assign no priority, the priority defaults to normal, and no visual 
cue displays. To assign a priority to an e-mail before you send it, click the appro-
priate button on the Message tab on the ribbon, as shown in Figure 7.10. The 
buttons are toggles, so if you change your mind about setting a priority, just click 
the same button again. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 7.10 The button with the red exclamation point sets a high priority. The button 
with the down arrow sets a low priority. 

 

Using Signatures 
If you need to include lots of information in your e-mail signature in addition to 
your name, such as your office phone number, fax number, cell phone number, 

To remove a picture background, click anywhere in the body, click 
the Background Picture pop-up button on the Options tab of the rib-
bon, and click Remove. 



and website address, you might want to create a signature so Outlook can insert 
the information for you automatically. Additionally, you can create multiple signa-
tures to choose from in different circumstances. For example, you can have a 
formal signature with your full name and title and an informal signature with just 
your first name or nickname. 

 

SHOW ME  Media 7.3—Creating Signatures 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 
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Creating Signatures 
In addition to creating multiple signatures to choose from, you can create differ-
ent signatures and assign them to specific e-mail accounts. To create a signa-
ture, follow these steps: 

1. Click Outlook on the menu bar and click Preferences. 

2. Click Signatures. The Signatures window opens. 

3. Click the Plus button to add a signature. Outlook gives the signature the 
name Untitled. Click the name to select it, type a more descriptive name, 
and press Return. 

4. Type the text that you want for your signature in the right pane. 
 

 

 
 

5. Repeat steps 3 and 4 to add as many signatures as you need. Outlook lists 
each signature that you create as an option in the Signatures menu. (To 
access these signatures when you are composing a message, click Draft in 
the menu bar, click Signatures, and click the one you want to use.) 

6. To set a signature as a default for an e-mail account, click the Default Sig-
natures button, select an account, and click the pop-up button to select the 
signature you want to use as the default. 

7. Close the Signatures window when finished. 

To format the signature, select the text in the right pane, right-click 
it, and click Font. From there, you can select Show Fonts, Bold, 
Italic, Underline, Styles, and Show Colors. 



Inserting Signatures 
If you set a default signature, Outlook automatically includes the default signa-
ture each time you create a new e-mail message. If you do not specify a default 
signature, you can add a signature at the bottom of your message (if you choose 
to) by selecting the signature you want. First, position the insertion point where 
the signature should be, and then click Draft in the menu bar, point to Signatures, 
and click the one you want to use. 

 

 

 
 

Finding Messages 
Before you start looking for a particular message, the most common type of 
message you will look for is an unread message. Outlook helps you find mes-
sages that you have not read by displaying them in bold type. Beyond that, you 
may think that because all your e-mail messages are contained in one place—
the Inbox—it will be difficult to find anything. On the contrary, if you need to find a 
particular message, you can use several methods to find it. Later in this chapter, 
I also show you how to organize the Inbox with folders (if having everything in 
one place is just too much for you).  

Sorting Messages 
One way to find a message is to sort the Inbox. By default, the item list sorts 
messages by the Date Received. In this way, the latest e-mail messages that 
you have received appear at the top of the list. If you click the Arrange By button 
on the Organize tab on the ribbon and click Show in Groups, Outlook adds a 
header row above messages for certain time periods. Outlook lists today's mes-
sages at the top; then there is a heading row titled Yesterday with yesterday's 
messages listed under it. Additional groups have titles for the last three days of 
the week, Last Week, 2 Weeks Ago, 3 Weeks Ago, Last Month, and so on. You 
can expand or collapse each group with the reveal button on the left side of the 
heading row. 

If you want to find messages from a particular sender, you can sort on the From 
column and then scan the e-mails for the sender. To sort on any column, just 
click the column heading. Click the column heading again to change the order of 
the sort (ascending to descending or vice versa). To sort by a column that does 

Thinking outside the box, you also can create "signatures" that are 
really boilerplate text that you want to insert in an e-mail. 



not display in the item list, click the Arrange By button on the Organize tab on the 
ribbon and click the column you want to sort on. This sorts the messages but 
does not display the column. 

Grouping Messages in Conversations 
Grouping messages in conversations is a new feature in Office 2011. You might 
have seen this feature in Gmail or other Internet mail programs. It groups all the 
messages that pertain to an original e-mail message. So if you send a message 
to three people, and all three people send you a reply, all these messages make 
a conversation. As you continue to send messages back and forth on the sub-
ject, Outlook adds the messages to the conversation. When you get a new e-mail 
in reference to the subject, Outlook moves the entire conversation to the top of 
the message list.  

To group by conversation, click Arrange By on the Organize tab and click Con-
versation. Additionally, you can click the Conversation button in the header of a 
message that is part of a conversation, and all the related messages are grouped 
with that message; however, this does not group all messages in the Inbox by 
conversation. (The Conversation button is just to the left of the Subject in the 
header.) 

Filtering 
Another way to find a message is to use a filter. When you use a filter, only mes-
sages that fit the filter specifications display in the item list. Figure 7.11 shows 
the filter options you can use. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 7.11 Select the Unread filter to quickly see your e-mail backlog. 

 



 

Notice that one of the filters is Flagged. If you select this filter, only messages 
you have flagged display in the item list. You flag a message by selecting it in the 
item list and clicking the Follow Up button on the Home tab on the ribbon. You 
can select a follow-up day (Today or Tomorrow) or a follow-up time period (This 
Week or Next Week); select no due date; specify a custom date; add a reminder; 
or mark a message as complete. When a message is flagged, the gray flag in the 
Flag column in the item list turns to orange. Additionally, when you open or view 
the message, a Flag with a description displays under the header of the mes-
sage, as shown in Figure 7.12. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 7.12 The follow-up flag that was selected for this message was Next Week. 
Outlook automatically filled in the correct dates. 

Another filter you can use is Category. This filter displays all messages that have 
been categorized for the category you select. Some messages are automatically 
categorized if the sender of the message is in your Contact list and you have as-
signed a category to the contact. After you receive a message, you can catego-
rize it yourself by clicking the Category button on the Home tab on the ribbon, 
and clicking the Category you want. (You can categorize any Outlook item, not 
just e-mail, and you can create your own categories.) 

 

 To learn more about creating your own categories, see "Editing Catego-
ries" in Chapter 8, "Using Contacts." 

After filtering messages, click the Filter button and click Clear All Filters to see all 
the messages in the item list again. 

Searching for Messages with the Spotlight 
One of the most powerful search tools you can use to find a message is the 
Spotlight search. To find a message, type the search text in the Spotlight search 
box and press Return. The search text can be any text that might appear any-



where in the message: the subject, sender, body of the message, and so on. 
Outlook displays all messages that contain the search text in the item list and 
displays the Search tab on the ribbon. When finished, click the X in the Spotlight 
field or click the Close button in the Search tab. 

If you frequently search for messages using the same criteria, you might want to 
save your search criteria so you can use it repeatedly. When you save search 
criteria, you create a Smart Folder, a dynamic, virtual folder that is listed in the 
navigation pane. Any time you click the Smart Folder in the navigation pane, a 
new search is performed and the messages that currently meet the criteria dis-
play in the item list. 

Note that Outlook provides a few Smart Folders for you by default. These are 
called Flagged Mail, Free Stuff, High Priority Mail, and Overdue Mail. To see the 
Smart Folders, you might have to click the Smart Folder reveal button in the 
navigation pane.  
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Creating a Smart Folder 
To create a Smart Folder, follow these steps: 

1. Type search text in the Spotlight search box and press Return or click one 
of the options that displays. 

2. Click the Search tab on the ribbon. On this tab, you can click buttons to de-
fine the scope of the search (Folder, Subfolders, All Mail, All Items) and 
click buttons to add more search criteria. For example, click the Unread 
button on the ribbon to add the criteria "Read Status Is Unread." The 
search criteria display at the top, as shown in Figure 7.13, and messages 
that meet the criteria display in the item list immediately. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 7.13 Use the plus or minus button to the right of the criteria to delete a specific 
criterion or add another criterion. 



3. To delete a criterion, click the minus button to the right of it. To add another 
criterion, click the plus button and then define the specifics by clicking the 
pop-up buttons and selecting appropriate options. For example, to build the 
criterion "Cc Recipient Is Me," click Item Contains and select Cc Recipient; 
click Contains and select Is Me. 

4. Click the Save button on the Search tab on the ribbon. The Smart Folder 
appears in the navigation pane with the name Untitled. 

5. Type a name for the Smart Folder and press Return. 
 

 

 
 

Deleting Messages 
To make the Inbox more manageable, you should regularly delete unnecessary 
messages. Deleting a message is a two-step process. When you delete a mes-
sage from the Inbox, it goes into the Deleted Items folder, from which you can  
retrieve the message if you change your mind. When you delete a message from 
Deleted Items, the message is truly deleted. 

 

SHOW ME  Media 7.4—Deleting E-mail Messages 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 
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Deleting E-mail Messages 
To delete one or more messages, follow these steps: 

1. To select a single message, click the message you want to delete in the 
item list, or to select adjacent messages, click the first or last message in 
the block and then Shift-click the message at the opposite end of the block. 
To select nonadjacent messages, Cmd-click each message. 

 

 

To delete a Smart Folder, right-click the folder in the navigation 
pane and click Delete; then click the Delete button in the confirma-
tion message. 



 
 

2. Click the Delete button on the Home tab on the Ribbon or press the Delete 
key. The message moves to Deleted Items. 

3. To permanently delete all the messages in the Deleted Items folder, right-
click the folder and choose Empty Folder. A confirmation dialog box opens. 
Click Delete. If you want to keep some messages in the Deleted Items 
folder for a while, you can select only the messages in the Deleted Items 
folder you want to permanently delete, and click the Delete button on the 
ribbon. Then click Delete in the confirmation message that appears.   

Handling Junk Mail 
Outlook has junk mail filters built in. These filters define various characteristics 
that junk messages generally have. When a message fits the junk e-mail profile, 
Outlook stores the message in the Junk E-mail folder and assigns the Junk cate-
gory to the message. This keeps your Inbox much tidier. Outlook periodically tells 
you whether it has stored e-mail in the Junk E-mail folder and reminds you to 
check it—even providing a button for you to click to quickly open the folder and 
cycle through the e-mails to confirm them as junk. 

Even when the Junk protection level is set very low, messages that you would 
not consider junk still get placed in the Junk E-mail folder if they meet the junk fil-
ter criteria. You should check this folder periodically to see whether any valid 
messages have made their way there. If you find a valid message, you can re-
store it to the Inbox easily. Select the message, click the Junk button on the 
Home tab on the ribbon, and click Mark as Not Junk. If too many valid messages 
go into the Junk E-mail folder, you might want to visit the Junk E-mail Protection 
options to see whether you need to make an adjustment. 
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Setting Junk E-mail Protection Options 
To set your level of junk e-mail protection and specify safe and blocked domains, 
follow these steps: 

Here's where sorting can come in handy. To delete all the mes-
sages you have received from pest@spam-r-us.com, sort on the 
From column so all the e-mail messages from this sender appear in 
the item list together. Then you can easily select all of them as a 
block. 



1. Click the Junk button on the Home tab on the ribbon and click Junk E-mail 
Protection to open the dialog box shown in Figure 7.14. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 7.14 The level of junk e-mail protection that you select determines the number 
of messages that will be filed in the Junk E-mail folder; it doesn't prevent you from get-
ting the junk e-mail. 

2. Select the level of protection that you want. 

3. Specify the number of days in which junk mail will be deleted, or clear the 
check mark for this option if you want to delete junk mail manually. 

4. Click the Safe Domains tab. 

5. Type the domain names from which you want to receive e-mails without 
treating the messages as junk. Separate each with a comma, as shown in 
Figure 7.15. 

6. Click the Block Senders tab. 

7. Type the domain names from which all e-mails should be treated as junk. 
Separate each with a comma. 

 

 

 
 

8. When you are finished making all settings, click OK. 
 
 
 
 

Note that e-mail messages are not truly blocked; that is, they still 
come into Mail. Outlook just stores them in the Junk E-mail folder. 



 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 7.15 The domain names must be separated by commas. 

Working with Folders 
Another way to organize e-mail messages is to create folders for them. This 
gives you the same type of organization you have in the Finder. You can create 
folders under Inbox, Sent Items, Deleted Items, and Junk E-mail. After you cre-
ate folders, you can drag messages to them. Additionally, you can create rules 
that process your messages and send them to different folders. Creating a rule is 
outside the scope of this book, but if you want to try it, click Tools in the menu 
bar and click Rules. 
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Creating Folders in the Inbox 
To create a folder, follow these steps: 

1. Select the folder that will be the root of the new folder. For example, if you 
want to create folders for the Inbox, select one of the account folders under 
Inbox, such as Gmail. 

2. Click the New button on the Home tab on the ribbon and click Folder, or 
right-click the parent folder and click New Folder. 

3. Expand the account folder, if necessary, and right-click the new untitled 
folder. Click Rename, type the name, and press Return. 



8 In this chapter, you learn how to create, import, 
sort, find, edit, delete, and categorize contacts, as 
well as create contact groups for mass e-mailing. 

Using Contacts 
This chapter focuses on the Contacts component of Outlook, which holds the 
names, addresses, phone/ fax numbers, e-mail addresses, and miscellaneous 
personal information for your contacts. The chapter covers adding contacts to 
your Address Book in many different ways; finding contacts; deleting contacts 
and editing contact information; editing the contact form; creating a group contact 
for mass e-mailing; and categorizing contacts. 

Exploring the Contacts Interface 
To open Contacts, first open Outlook and then, if necessary, click Contacts. The 
Outlook Contacts window opens, as shown in Figure 8.1. Your Address Book in 
Outlook is a valuable tool in and of itself, but it also works with other applications 
in Outlook and the Office suite to supply information when needed. 

Starting at the top of the window, you find the following elements: the title bar, 
toolbar area, and ribbon. At the bottom of the window, you see the status bar. 

 

 To learn more about how the ribbon works, see "Getting Familiar with the 
Ribbon" in Chapter 1, "Getting Started with Word." 

Under the ribbon, on the left is the navigation pane. By default, it contains the 
Address Book and Smart Folders. In Figure 8.1, the Address Book is expanded 
to show Categories, and all the Categories are checked, which guarantees that 
all contacts display onscreen. 

The area to the right of the navigation pane can be split either vertically, as 
shown in Figure 8.1 (with the item list in the middle and the reading pane on the 
right), or horizontally, as shown in Figure 8.2. I like the horizontal split that lists 
the contacts at the top and shows the selected contact in the reading pane at the 
bottom. Additionally, you can hide the reading pane so you can see more con-
tacts in the item list. If you hide the reading pane, you might want to customize 
the headings in the item list so you can see all the information you need for each 
contact. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 

Figure 8.1 The vertical split places the reading pane on the far right. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 8.2 The horizontal split places the reading pane at the bottom. 



To use the vertically split view, click the Details button on the Home tab on the 
ribbon. To use the horizontally split view, click the List button right beside the De-
tails button. To hide the reading pane, click the Organize tab on the ribbon, click 
the Reading Pane button, and click Hidden. 

To customize the columns that display in the item list, do any of the following: 

▪ To display different columns, right-click any column heading and then se-
lect or deselect the headings you want to display or hide. 

▪ To change the order of the columns, drag the column heading to the de-
sired location. 

▪ To change the width of the columns, drag the right border of the heading to 
the left or right. 

Adding Contacts to the Address Book 
You can add contacts to your Address Book in many different ways: 

▪ You can use the old-fashioned method and type the contacts yourself. 

▪ When you get an e-mail message from a sender not in your Contacts, you 
can easily add the sender to your list from the return e-mail address. 

▪ You can save a vCard e-mail attachment as a Contact. 

▪ If you use the Mac Address Book, you'll be blown away by how easy it is to 
get all your addresses from that application into Outlook's Contact list. 

▪ If you are upgrading from Entourage to Outlook, you can import a file that 
you have exported from Entourage. 

▪ If you are making the switch from Outlook for the PC to Outlook for the 
Mac, you'll be glad to know that you can import your complete Outlook 
Contact list via a .pst or .olm file. 

▪ Outlook for Mac also can import contacts from other e-mail applications if 
the other applications can export their data as a delimited text file or an 
MBOX file. (You learn more about this later in this section.) 
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Adding a Contact by Typing the Information 
Typing a contact's information is undoubtedly the slowest way to enter informa-
tion, but many times, it's the only way. This set of instructions addresses using 



only the default fields in the contact form. Later in the chapter, under "Adding and 
Deleting Fields on a Contact Form," you learn how to modify the fields on the 
contact form. To add a new contact by typing it yourself, follow these steps: 

1. Click Contacts in the navigation pane if necessary. 

2. On the Home tab on the ribbon, click the Contacts button or press Cmd-N. 
A form opens for you to fill out, as shown in Figure 8.3. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 8.3 The blank contact form opens to the General tab. 

 
 

3. Fill out the information by typing the text and pressing Tab to move to the 
next field. (You can leave any field blank.) 

4. To add a photo to the contact, double-click the photo placeholder and click 
Choose. Navigate to the photo and double-click it; then click Set. 

 

 

 
 

5. If the label for a field has a pop-up button, you can select a different label 
from the pop-up menu. For example, by default, Outlook displays labels for 
work-related information, such as Work E-mail. If the e-mail address you 

You also can drag a photo to the placeholder. 



want to enter is a personal one, click the label pop-up and select Home  
E-mail. 

 

 

 
 
 
 
 

6. Click the Notes tab and type any information that you want. 

7. Click the Save & Close button when finished. 
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Adding a Contact from an E-mail Sender 
In Outlook, if you get an e-mail message from someone you know you will con-
tinue to correspond with, it's a good idea to add that sender's name and e-mail 
address to your Contacts list. To add a contact directly from an e-mail message, 
follow these steps: 

1. Right-click the e-mail message in the Mail items list, select Sender, and 
click Add to Contacts. The contact form opens with the name and e-mail 
address filled in for you. 

 

 

 
 

2. Enter additional information if you want and click the Save & Close button. 
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Saving a vCard as a Contact 
A vCard is an electronic business card that can be sent via e-mail. Later in this 
chapter, you learn how you can send a vCard to someone else, but if you receive 
one, you can save it as a contact by following these steps: 

1. Open the message that contains the vCard attachment and double-click the 
attachment. It opens in a contact form. 

If the message is open in its own window, point to the sender. A 
pop-up opens. Click the Open Contact button, which looks like a 
Rolodex card. 

Changing a field label for a contact does not change the contact 
form for any other contacts. 



2. Enter additional information if you want and click the Save & Close button. 
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Importing Contacts from Mac Address Book 
The method for importing contacts from the Mac Address Book is pure Mac; 
you'll love it. To import contacts from the Mac Address Book, follow these steps: 

1. Select the contacts in your Mac Address Book and drag them to the Desk-
top. This creates a vCard file with a .vcf extension. 

2. Open Contacts in Outlook. 

3. Drag the file on the Desktop to the item list. The new contacts appear in the 
list. This is why you own a Mac! 
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Importing Contacts from Outlook for Windows 
To transfer your Outlook for Windows contacts to Outlook for Mac, you must first 
export the contacts on your PC. Depending on your version, Outlook for Win-
dows exports items in a file with the extension .pst or .olm. After you create the 
.pst or .olm file, you must make the file accessible to your Mac so you can import 
the data in the file. To import from a .pst or .olm file, follow these steps: 

1. In Contacts, click File on the menu bar and then click Import. A wizard 
opens, as shown in Figure 8.4. 

2. Outlook Data File (.pst or .olm) is selected by default, so click the right ar-
row button at the bottom-right corner to go to the next step in the wizard. 

3. Select the format that you want to import and click the right arrow button. 

4. Navigate to the .pst or .olm file and click Import. 

5. Click Done to close the wizard. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

If you want to merge all the contacts in your Mac Address Book into 
your Outlook list instead of selecting specific contacts, click Out-
look, Preferences and open the Sync Services preference.  



 
 
 
 
 
 
 
 
 
 

 

Figure 8.4 The Import Wizard guides you through the importing process. 

  

LET ME TRY IT 

Importing Contacts from Entourage 
To transfer your Entourage contacts to Outlook, you must first export the Entou-
rage contacts to a file. Entourage refers to exported files as identities and uses 
the extension .rge. After you create the export file, follow these steps to import 
the contacts into Outlook: 

1. In Contacts, click File on the menu bar and then click Import to open the 
wizard that guides you through the process. 

2. Select the Entourage option and click the right arrow button at the bottom-
right corner to go to the next step in the wizard. 

3. Select the correct version of Entourage and click the right arrow button. 

4. Deselect the items you do not want to import and click the right arrow. (For 
purposes of this discussion, you might deselect all items except Contacts.) 

5. Click Browse and double-click the Entourage exported file. 

6. Click Done to close the wizard. 
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Importing Contacts from Text Files 
You can import contacts from other programs, such as Gmail or Eudora, if the 
application is able to export its data as a delimited text file or as an MBOX file. A 
delimited text file has one contact per line, and each field is separated with a tab 
or comma. The first line in the file usually gives the field names. This is the in-
formation Outlook uses to try to map its contact fields to the incoming data. An 
MBOX file uses a format that was first developed for Unix systems, and it's used 
by Eudora. To import contacts from a text or MBOX file, follow these steps: 

1. In Contacts, click File on the menu bar and then click Import to open the 
wizard that guides you through the process. 

2. Select Contacts or Messages from a Text File and click the right arrow  
button in the bottom-right corner to go to the next step in the wizard. 

3. Select the type of text file and click the right arrow at the bottom of the  
wizard. 

4. Browse to the file and double-click it. The Import Contacts dialog box 
opens, as shown in Figure 8.5. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 8.5 To map the fields, drag fields in the left pane so they line up with the fields 
in the right pane. 

 

5. Outlook lists the fields that it can map to Address Book fields in the pane on 
the left. Make sure that the incoming fields are mapped correctly. You can 
drag the incoming fields up and down in the left pane to match them up 



with their correct fields. When finished mapping the data, click the Import 
button in the dialog box. Outlook imports the data. 

6. Click Finish to close the wizard. 

Finding Contacts 
Contacts are not too difficult to find if you don't have a lot of them. You can just 
scroll through them until you see the one you want. If your contact list is too large 
for this method, Outlook provides several methods for finding contacts.  

Sorting Contacts 
If you still prefer scrolling through your list, you can make things easier for your-
self by sorting the list in the List view. By default, Outlook sorts on the Name col-
umn, using the last name of the contact or the company name if there is no last 
name. To sort on a different column, click the column heading for that field. For 
example, if you can't remember the name of the contact you're looking for, but 
you remember the company, click the Company heading to sort the contacts by 
company. Click the heading again to reverse the order of the sort. To sort by a 
field that is not represented in the item list, click the Organize tab on the ribbon 
and click the Arrange By button. Select a field to sort by from the list of all the 
fields available. 

Using a Spotlight Search 
Another method of finding a contact is to use a Spotlight search. To find a par-
ticular contact, type the search text in the Spotlight search box on the right side 
of the toolbar and press Return. (You can search for text that appears in any part 
of the contact.) Outlook displays all contacts that contain the search text and 
switches to the Search tab on the ribbon. 

If you perform an advanced Spotlight search, you can specify additional criteria 
and even save the search as a Smart Folder to be used repeatedly. To hear 
more about advanced searches, listen to the following audio recording. 

TELL ME MORE  Media 8.1—Performing Advanced Searches 
Access this audio recording through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 



Using Contacts Search 
The Contacts Search is similar to a Spotlight search, but this method searches 
for data in only the first name, last name, title, department, company, or e-mail 
address fields. So if you don't know any information in any of these fields, and 
you enter the work address as the search string, this search will come up empty. 
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Finding a Contact with Contacts Search 
To use Contacts Search, follow these steps: 

1. Click the Contacts Search button on the Home tab on the ribbon. The Con-
tacts Search window opens. 

2. Begin typing the name, title, department, company, or e-mail address. Out-
look displays the contacts that contain the search text in one of these fields. 

3. You can limit your search further by clicking the pop-up buttons under the 
search box, as shown in Figure 8.6. The default for the first criterion is All 
Fields, but this refers only to the first and last name, title, department, com-
pany, or e-mail address. Changing this criterion to Search Names Only lim-
its the search to the first and last name fields. The second criterion defaults 
to All Folders, and this includes the Global Address List (GAL) if you have a 
Microsoft Exchange account. If you have created other folders for Contacts, 
you can select the folder from this pop-up list. 

4. When contacts that contain the search text display, you can open the one 
you want by double-clicking it. Additionally, if the contact has an e-mail  
address, two buttons appear under the contact information in the search 
results. You can use these buttons to send an e-mail or a meeting request 
to the contact. 

5. Click the Close button in the Contacts Search window when finished.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 

 

Figure 8.6 The two buttons under the Spotlight search box add additional criteria to 
the search. 

 

Communicating with Contacts 
The Contacts application is not just the repository for your contacts; it is also an 
application that can reach out and touch contacts in many different ways. Using 
the Contact menu or the buttons on the Home tab on the ribbon, you can com-
municate with a contact via e-mail, a meeting invitation, or instant message. 

If you hide the reading pane or display it under the item list, you have access to 
the Online Status column in the item list. When you click the box in this column, 
you see the pop-up shown in Figure 8.7. The buttons along the bottom of the 
pop-up enable you to send an e-mail, send an instant message, make an audio 
call to the contact, make a video call to the contact, send a meeting invitation, or 
open the contact. 

 

 

 
 

To send an instant message, make an audio call to the contact, or 
make a video call to the contact file, you and the contact must be 
signed into Messenger or Communicator. 



Additionally, if you have an account on an Exchange Server, a new feature in Of-
fice 2011 for Mac called Presence retrieves and displays information about the 
contact from the contact's calendar. If the contact is diligent about keeping his or 
her calendar up-to-date, you can see if the contact is busy and what time the 
contact will be free. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 8.7 If you are not using an Exchange account, this pop-up displays "Presence 
Unknown" for every contact. 

Editing and Deleting Contacts 
When the data for a contact changes, you can edit the contact in your Address 
Book so it's current. If you no longer want to keep a contact in your Address 
Book, you can delete it. 
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Editing Contact Information 
To edit the information in a contact, follow these steps: 

1. Open the contact by double-clicking it in the item list. 

2. Use the same steps as you would to create a contact; that is, tab to a field 
and type the data. If a field has data in it, the new data overwrites it. If you 
want to edit a field that has data in it, and you don't want to tab to it, triple-
click the field to select all the data and then type the new data. 

One of the first contacts you should edit is the contact that Outlook 
automatically creates for you. To open this contact, click View in the 
menu bar and click Me Contact. 



3. Click the Save & Close button on the Home tab on the ribbon when fin-
ished. 
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Deleting a Contact 
To delete a contact, follow these steps: 

1. Select the contact(s) in the item list. 
 

 

 
 

2. Click the Delete button on the Home tab on the ribbon. Outlook asks if you 
are sure you want to delete. 

3. Click Delete. 

Editing the Contact Form 
Outlook limits your ability to make changes to the contact form itself. As previ-
ously explained, you can change some field labels, but you cannot change the 
location of the fields on the form, change the fonts, add informational text, and so 
on. You can, however, add or delete fields on a form for a particular contact. 

 

SHOW ME  Media 8.2—Adding and Deleting Fields on a Contact 
Form 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Use the Shift-click method to select adjacent contacts or the Cmd-
click method to select nonadjacent contacts. 

Additionally, you can select a contact in the item list and make 
modifications directly in the reading pane. 
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Adding and Deleting Fields on a Contact Form 
Fields under the header are listed in categories (Phone, Internet, Address). You 
can add or delete fields in each category as needed. To modify the fields in a 
category, follow these steps: 

1. Open the contact. 

2. To add a field, click the plus button next to the category and select a label. 

3. To delete a field in a category, point to the field and then click the minus 
button that appears to the left of the field. 

4. When finished, click the Save & Close button. 

Sending an Electronic Business Card 
As mentioned earlier in this chapter, a vCard is an electronic business card. 
Sending a vCard is similar to handing out a printed business card, but much bet-
ter because it can hold more information than a little 2-inch x 3.5-inch business 
card. In Outlook, you can pass out your own contact as an electronic business 
card, but you also can send a business card for any other contact in your list. For 
example, your friend says to you, "The price of ink cartridges is killing me. Do 
you know where I can get them cheaper?" You can send your friend a vCard for 
your cheapest-ink-prices-in-the-known-universe.com contact. 
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Sending Contact Information as a vCard 
To send a vCard, follow these steps: 

1. Select the contact(s). 

2. Click the Forward button on the Home tab on the ribbon. A new e-mail 
message opens with a vCard as an attachment, as shown in Figure 8.8. 

 
 
 
 
 
 
 
 
 
 

Before forwarding contact information as a vCard, you might want 
to review the contact to make sure there is no information included 
that you would not want to pass along. 



 
 
 
 
 
 
 
 
 
 
 

 

Figure 8.8 Outlook fills in the subject of the e-mail with FW (for Forward) and the 
name of the contact. 

3. Fill out the address information for the recipients, type the message, and 
click the Send button. 

Sending Mass E-mails 
Most people find that at least occasionally they need to send an e-mail message 
to a large group of recipients. This is referred to as a mass e-mail. If you fre-
quently send out mass e-mails to the same recipients, you can save yourself 
some time by creating a group that contains all the e-mail addresses. The group 
appears as a single entry in the Address Book. 

 

SHOW ME  Media 8.3—Creating a Contact Group 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 
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Creating a Contact Group 
Contact groups can contain members that you do not have contacts for, as well 
as members that come directly from your Address Book. You can create multiple 
contact groups, an individual contact can be in more than one contact group, and 
a contact group can contain a contact group as a member. To create a contact 
group, follow these steps: 

1. Click the Contact Group button on the Home tab. The contact form opens. 



2. Type a name for the group and press Return. 

3. If the recipients in the group do not know each other, check the box for Use 
Bcc to Hide Member Information. When this option is checked, Outlook 
automatically places all the recipients' names in the Bcc field so each re-
cipient cannot see the addresses of the others who also receive the mes-
sage. 

 

 

 
 

 

4. Click the Add button on the ribbon or double-click the instruction that says, 
"Double-click to add." 

5. To add a name that is in your contact list or from which you have sent or 
received an e-mail message, just begin typing the name. Outlook displays 
names and e-mail addresses that contain the text you have typed. Click the 
one in the list that you want to add. 

 

 

 
 

6. To add a name and e-mail address for a contact that is not in your list and 
you have never corresponded with, type the full name, tab to the address 
field, type the e-mail address, and press Return. 

7. Repeat steps 5 and 6, as needed, to continue adding names to the group. 
Figure 8.9 shows a group contact form in progress. 

8. To delete a name in the group, click the name and then click the Remove 
button on the ribbon. 

9. Click in the Notes field and type any text you want. This might be informa-
tion that tells you what kind of message to send and how often to send it. 

10. When finished, click the Save & Close button on the ribbon. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To add a name from your Address Book, if the name is visible be-
hind the group contact form, just drag it into the list. 

As far as I'm concerned, using Bcc is not optional if the members of 
the group do not know each other; it's required. It's a protection of 
privacy that you must extend to the recipients in the group. 



 
 
 
 
 
 
 
 
 
 
 

 

Figure 8.9 The contact group form accepts as many e-mail addresses as you need  
to add. 

To use the group contact, simply select the group contact in the contact list and 
click the E-mail button on the Home tab on the ribbon. If you are in the Mail ap-
plication, you can open a new message form and select the group contact as a 
To, Cc, or Bcc address just as you would any other recipient. Selecting the group 
contact for the To or Cc fields overrides the Bcc setting you might have set when 
creating the group. (See step 3 in the preceding "Let Me Try It.") 

Categorizing Contacts 
Outlook provides the following categories you can use to bring another level of 
organization to your contact list: Family, Friends, Holiday, Junk, Personal, Rec-
reation, Travel, and Work. If you do not assign a category to a contact, Outlook 
automatically assigns a category called No Category to the contact. Categorizing 
contacts enables you to view the contacts in different ways. See "Viewing Con-
tacts by Category" later in this chapter. 

Editing Categories 
If you need additional categories, you can create your own. You also can delete 
the categories you don't want—even most of the default categories that Outlook 



supplies for you. (You cannot delete the Junk or Holiday categories, however, 
because they serve special purposes.) 

 

SHOW ME  Media 8.4—Adding and Deleting Categories 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 
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Adding and Deleting Categories 
To add or delete a category, follow these steps: 

1. Click the Categorize button on the Home tab on the ribbon and click Edit 
Categories. The Categories Preferences window opens, as shown in Fig-
ure 8.10. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 8.10 Notice that you can determine which categories show in the navigation 
pane. 

 

2. To add a new category, click the plus button at the bottom of the list of cat-
egories, select a color for the category, type the name of the new category, 
and click OK. The new category appears in the list, and Outlook automati-
cally checks the box for Show in Navigation Pane. 

3. To delete a category, select the category in the list, click the minus button 
at the bottom of the list, and click Delete. 



4. Close the window when finished. 

Assigning and Removing Categories 
When you assign a category to a contact, the contact displays in the item list in 
the color that is associated with the category. If you assign multiple categories to 
a contact, the contact displays in the color associated with the last assigned cat-
egory. 
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Assigning a Category to a Contact 
To assign a category to a contact, follow these steps: 

1. While creating a new contact or editing an existing contact, click the Cate-
gorize button on the Home tab on the ribbon and click the category you 
want to assign. 

 

 

 
 

2. Repeat step 1 as many times as you need to assign additional categories. 
 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

You can create a new category and assign it to a contact simulta-
neously. Just select the contact, click the Categorize button, click 
Add New, type the name, and click OK. 

You also can select multiple contacts in the item list and assign the 
same category to all of them at once by clicking the Categorize but-
ton and clicking a category. 

When you get e-mail from a contact that you have categorized, Out-
look automatically assigns the same category or categories to the 
e-mail messages and displays them in the appropriate colors. 
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Removing a Category from a Contact 
To remove a category from a contact, follow these steps: 

1. Select the contact. 

2. Click the Categorize button on the Home tab on the ribbon and clear the 
check for the assigned category. Repeat this step to remove other catego-
ries for the same contact. 

 

 

 
 

Viewing Contacts by Category 
You can use categories in two ways to change the view of your contacts. You 
can view contacts in category order or view only the contacts for particular cate-
gories. 

To view all contacts in category order, click the Organize tab, click Arrange By, 
and click Categories. The contacts display in the item list in category order with 
uncategorized contacts listed at the bottom. 

To view the contacts in specific categories, turn your attention to the navigation 
pane. Expand the Address Book item, if necessary, deselect the categories you 
don't want to see, and select the ones you do want to see. (Hint: To deselect all 
the categories at once, deselect Address Book.)  

Printing the Address Book 
If you're going to be away from your computer and have limited access to the In-
ternet (going on a real vacation, in other words), you might want to take a print-
out of your most important contacts with you. You can print contacts using either 
an address book format or a phone list format. 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

If you have assigned more than one category to a contact, and you 
want to delete all of them at once, click the Categorize button and 
click Clear All. 
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Printing a Contact List 
To print contacts, follow these steps: 

1. Select the contacts you want to print if you don't want to print your entire 
list. 

2. Click the Print button in the toolbar or press Cmd-P. The Print dialog box 
opens, as shown in Figure 8.11. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 8.11 The preview pane on the left shows how the contacts will look when 
printed. 

3. Select the printer you want to use. Then set all other printer-related options 
at the top of the dialog box and set all Page Options at the bottom of the 
dialog box. 

4. Under Outlook, select Selected Contacts, All Contacts, or Flagged Con-
tacts for Print, and select Address Book or Phone List for Style. 

5. Select the desired options under Contact Options. 

6. Click Print. 



Using Folders 
If you want to create separate contact lists, you can create folders for them and 
add new contacts or move or copy existing contacts from the Address Book into 
the new folder. When you create a folder, it appears in the navigation pane under 
On My Computer. 
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Creating Folders for Contacts 
To create a folder, follow these steps: 

1. Click File on the menu bar and click New, Folder. A new Untitled Folder 
appears in the navigation pane under On My Computer. 

2. Type the name for the new folder and press Return. 

To add a new contact to a folder, select the folder in the navigation pane, click 
the Contact button on the Home tab on the ribbon, and proceed as usual. To 
move an existing contact into a folder, drag the contact from the item list and 
drop it on the folder name in the navigation pane. To copy an existing contact to 
a folder, press the Option key as you drag the contact from the item list to the 
name of the folder in the navigation pane. Be advised that changes you make to 
one copy of a contact do not pass through to the copy of the contact that exists in 
a different folder. 



9 This chapter shows you how to navigate in the 
calendar, create and edit appointments, and print 
the calendar.  

Using the Calendar 
The Outlook calendar is one of the primary components of Outlook. In this chap-
ter, you can explore the different calendar views and learn to navigate the calen-
dar; create recurring and nonrecurring appointments and events; send meeting 
requests; search for appointments; and edit, delete, and print appointments. Also 
in this chapter, you learn about the feature called My Day. 

Exploring the Calendar Window 
To open the Outlook calendar, first open Outlook and then, if necessary, click 
Calendar in the navigation pane. Figure 9.1 shows the Calendar window, and 
you can see that it has the menu bar at the top, then the title bar, a toolbar under 
the title bar, and then the ribbon. The status bar is at the bottom of the window. 
The calendar window uses two panes: the navigation pane on the left and a 
pane on the right that displays different views of the calendar. 

 

 To learn more about how the ribbon works, see "Getting Familiar with the 
Ribbon" in Chapter 1, "Getting Started with Word." 

The navigation pane has three sections that you can resize. At the top is a sec-
tion for a mini calendar. In the middle is the folder list, and the buttons for the 
Outlook components are at the bottom. I like to drag the Outlook buttons down 
so they occupy only one line at the bottom of the navigation pane. This gives me 
more room to display two mini calendars at the top, as shown in Figure 9.1. 

Unlike all other components of Outlook, the calendar does not use a reading 
pane. The area to the right of the navigation pane can display a grid or list. In the 
grid view, the calendar displays a calendar for the day, a work week, a seven-
day week, or a month. In the list view, the calendar displays an item list. To 
choose between a grid view and list view, click the Organize tab on the ribbon 
and click the Grid button or List button. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 

Figure 9.1 In this window, the navigation pane has been customized to show two 
mini calendars, and the pane on the right is in the grid mode, showing the day view. 

 

Viewing and Navigating the Calendar 
The calendar has more views than any other Outlook component. The different 
views of the calendar show different time periods so you can view your calendar 
for a single day or see the big picture and view an entire month. Each view has 
navigation tools that can take you to specific dates. 

Changing the View 
If you have selected the grid view, you can then specify the time period you want 
to view in the right pane. To select a view, click the appropriate button on the 
Home tab on the ribbon: Day, Work, Week, or Month. Regardless of what view 
you choose, the date for "today" is always orange. 



The day view, shown in Figure 9.1, shows timeslots for a single day. You can 
make the timeslots taller or shorter by dragging the slider in the bottom-right cor-
ner. The green arrow with the green line shows the current time of day. 

By default, the work view displays only five days, Monday through Friday. It has 
timeslots for 24 hours, but it differentiates the work hours by shading all the time-
slots before 9:00 a.m. and after 5:00 p.m., as shown in Figure 9.2. It also has a 
slider to adjust the size of the timeslots. 

You can customize the work view so it reflects your own work schedule. At a 
minimum, the view displays five days, even if you work only four days. Addition-
ally, if you work at least one day on the weekend, the view displays all seven 
days. The view shades all the days and hours you don't work, but these days 
and hours are still available for scheduling, of course. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 9.2 In the work view, each timeslot that represents an hour that you work uses 
a white background. 

 

SHOW ME  Media 9.1—Customizing the Work View 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 



LET ME TRY IT 

Customizing the Work View 
To select different days for the work week, follow these steps: 

1. Click Outlook on the menu bar and click Preferences. 

2. Click Calendar in the bottom row. The Calendar Preferences window 
opens. 

3. Enter the correct times for Work Day Starts and Work Day Ends. 

4. Click each day you want to see in the Work Week, as shown in Figure 9.3, 
and close the window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 9.3 You can select the days that you want to show in the work view. Monday, 
Wednesday, Friday, and Saturday are chosen here. 

 
 

The week view is similar to the work view, but it displays all seven days of the 
week. It also shades the nonwork hours based on the settings in the Calendar 
Preferences and has a slider to adjust the size of the timeslots. 

The month view, shown in Figure 9.4, displays five weeks. The dates for the pre-
vious month and next month that happen to display in the calendar are light gray. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 

Figure 9.4 The month view always shows 35 days, so the last days of the previous 
month and the first days of the next month could both display in this view. 

 

Navigating 
Outlook provides many different navigation tools to help you move around in a 
calendar. Generally, each view has tools that scroll a calendar and tools that go 
to a specific date. 

Using the Mini Calendar 
The mini calendar at the top of the navigation pane is good for reference, but it is 
also a navigation tool that will take you to a specific date in the right pane. To go 
to a specific date in the right pane, click the desired date in the mini calendar. (To 
scroll the mini calendar to the next or previous month, click the arrow buttons to 
the right or left of the month name.) If you scroll through the months in the large 
calendar, the mini-calendar scrolls in sync. 

 

 

 
 
 

 

Today's date is always orange in the mini calendar. 



Going to a Specific Date 
The Home tab on the ribbon provides two buttons for going to a specific date: 
Today and View Date. When you click the Today button, today's date becomes 
visible in the right pane in whatever view you are using, with the possible excep-
tion of the work view. (The work view cannot display a day that is not in its de-
fault view.) When you click the View Date button, this month's calendar displays 
in a pop-up window, and you can click the day you want to display or scroll the 
calendar and then click the day. The date becomes visible in the right pane in 
whatever view you are using, again with the possible exception of the work view. 

Navigating in a View 
Each view has its own navigation buttons in the upper-left corner (refer to Figure 
9.1). The three buttons are (from left to right) Previous, Today, and Next. They 
function differently according to the view. For example, if you are looking at the 
month view, Previous and Next scroll a month at a time. If you are looking at the 
week view, the Previous and Next buttons scroll a week at a time. 

Creating Appointments and Meetings 
Your Outlook calendar is the repository for two types of events that you can 
schedule: appointments and meetings. The words appointment and meeting are 
synonymous in most people's minds, but Outlook defines a meeting as an event 
that involves inviting other people and reserving resources, such as a conference 
room or equipment. Outlook defines an appointment as an event that doesn't in-
volve inviting other people or reserving resources. 

 

 

 
 

Creating a One-Time Appointment 
Some appointments are one-shot deals, and others occur over and over again. 
Say you have an appointment with a body shop to get an estimate for repainting 
the left side of your new car after it was keyed in the parking lot. This is an ex-
ample of an appointment that you hope never occurs again, so it's a nonrecurring 
appointment. 

 
 
 
 
 
 
 
 
 

Note that you cannot sync the Outlook calendar with iCal or Cal-
DAV, so all appointments must be created within Outlook. 



SHOW ME  Media 9.2—Creating a Nonrecurring Appointment 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

  

LET ME TRY IT 

Creating a Nonrecurring Appointment 
To create an appointment on your Outlook calendar for an appointment that oc-
curs only once, follow these steps: 

1. In day, work, or week view, go to the date on the calendar on which the ap-
pointment will occur and double-click the time the appointment will start. A 
new appointment form opens, and the Starts date and time are filled out for 
you, as shown in Figure 9.5. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 9.5 The new appointment form is blank if you just click the Appointment  
button on the Home tab on the ribbon instead of double-clicking a specific time on the  
calendar. 

 

 



 
 

2. Type a name for the appointment in the Subject field and press the Tab 
key. 

3. If needed, type the address or a general description of the location, such as 
The Baxter Room. 

4. Click the pop-up button for Duration and select the amount of time that the 
appointment will take. The Ends time updates to reflect your selection. Or 
you can set a specific Ends time, and the Duration reflects your selection. 

5. Click the Status pop-up button and select the status that you want your cal-
endar to show while you are at this appointment. (If you are using an Ex-
change e-mail account, people who are trying to set up a meeting can view 
this information to see whether you are available.) 

6. Click the pop-up button for Reminder and select a reminder that gives you 
a little more notice than the default 15 minutes, or select None if you don't 
want a reminder. 

 

 

 
 

7. Click in the whitespace at the bottom and type additional information about 
the appointment. 

8. If the appointment occurs in a different time zone, click the Time Zone but-
ton to add the Time Zone field to the appointment. Then click the pop-up 
button in the new field and select the time zone. Outlook posts an alert in 
the saved appointment to tell you what time the meeting starts in your 
home time zone. 

9. Click Categorize and select a category if desired. 

10. Click the Save & Close button. 

You can change the default reminder time by clicking Outlook, 
Preferences, Calendar. Set the reminder time and close the win-
dow. 

Instead of going to the date on the calendar, you can just press 
Cmd-N or click the Appointment button in the Home tab of the rib-
bon and specify the Start date and time yourself. I prefer to go to 
the date on the calendar before creating the appointment so I can 
see if the timeslot is open. Outlook doesn't warn you if there is a 
scheduling conflict. 



Creating a Recurring Appointment 
Now say you have an appointment on Friday to have dinner at one of your favor-
ite restaurants with your sweetheart. This is the kind of appointment you might 
like to have every Friday. This is called a recurring appointment. 

 

SHOW ME  Media 9.3—Setting a Recurring Appointment 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

  

LET ME TRY IT 

Setting a Recurring Appointment 
To set an appointment that will occur repeatedly in a definite pattern, such as the 
first day of every month, follow these steps: 

1. Create a new appointment as instructed in the preceding set of steps, but 
don't save and close the appointment. 

2. Click the Recurrence button and select a recurrence period, or click Cus-
tom to open the dialog box shown in Figure 9.6, define a more specific re-
currence period (such as every 2 weeks), and click OK. Outlook displays 
the recurrence period on the last line of the appointment's header below 
the Ends and Duration fields. (Figure 9.5 shows the header.) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 9.6 Using the custom options, you can define a recurrence as complex as the 
first Wednesday of every third month. 

 

3. Click the Save & Close button. The appointment appears on the calendar 
with a recurrence symbol beside it. 



Creating an Event 
Now say that you want to create an appointment on your calendar to go to a 
convention for three days. This type of appointment is called an all day event. 

  

LET ME TRY IT 

Creating an All Day Event 
To set an appointment for an event, follow these steps: 

1. Go to the date on the calendar on which the all day event will occur and 
double-click any timeslot on that day. 

2. Enter a Subject and Location. If you want, change the Status (which de-
faults to Free) and set a different Reminder interval or select None if you 
don't need a reminder. Type anything you want about the event in the 
whitespace at the bottom. 

3. Click the All Day Event check box. 

4. If the event lasts more than one day, enter the Ends date. 

5. Click the Save & Close button. 
 

 

 
 

Scheduling a Meeting 
If you are on a Microsoft Exchange Server, you have very powerful tools you can 
use to schedule a meeting with co-workers. You can use the Scheduling Assis-
tant to select a time for the meeting by looking at the free time on everyone's 
calendars, and you can specify whether a person's attendance is required or op-
tional. When an invitee gets the meeting request, Outlook automatically places 
the meeting on the invitee's calendar and marks it as tentative. The invitee can 
respond to the meeting request and accept or decline or even suggest a different 
date or time. As people respond to the meeting invitation, the organizer of the 
meeting can send updates if changes to the meeting details must be made. Addi-
tionally, the meeting organizer can schedule resources, such as conference 
rooms or equipment. 

If you are not on a Microsoft Exchange Server, the meeting request feature is 
more limited. Because the features available through the Microsoft Exchange 

You also can set the Recurrence feature for events. 



Server are outside the scope of this book, this chapter just looks at the meeting 
invitation from the standpoint of a user who doesn't have an Exchange e-mail 
account. 

  

LET ME TRY IT 

Creating a Meeting Invitation 
If you are not on a Microsoft Exchange Server, you can use the meeting invita-
tion for a meeting that has a definite date and time and is not dependent on 
whether everyone who is invited can actually attend. To create a meeting invita-
tion, follow these steps: 

1. Go to the date on the calendar on which the meeting will occur and double-
click the time the appointment will start. A new appointment form opens, 
and the Starts date and time are filled out for you. 

2. Click the Invite button on the ribbon, and the new appointment form 
changes to a new meeting form. 

 

 

 
 

3. Enter the e-mail addresses of the people who should attend the meeting. 

4. Enter a name for the meeting in the Subject field. 

5. Enter the address or a general description of the location in the Location 
field. 

6. Specify the Duration and the Ends time updates to reflect your selection, or 
specify the Ends time and the Duration updates. 

7. Set other options as you would for an appointment: the Status, a Reminder, 
the Time Zone, and so on. 

8. Click in the whitespace at the bottom and type additional information about 
the meeting. 

9. Click the Send button. Outlook creates a meeting on your calendar and 
sends an e-mail invitation to everyone you invited. If an invitee has Outlook, 
Outlook places the meeting on the invitee's calendar too. If the invitee  

Instead of going to the date on the calendar, you can just click the 
Meeting button in the Home tab of the ribbon and specify the Starts 
date and time yourself. 



deletes the meeting on his or her calendar, Outlook opens a cancellation  
e-mail message that is addressed to the meeting organizer. 

 

 

 
 

Searching for Appointments 
After you have scheduled appointments in your calendar for several months, you 
might find it necessary to search for one. You might have forgotten when you 
scheduled the appointment, or you might just need to find the appointment so 
you can open it and check some details. 

  

LET ME TRY IT 

Finding an Appointment 
To find an appointment, follow these steps: 

1. Type the search text in the Spotlight search box and press Return. Regard-
less of the view you are in when you perform the search, the results display 
in the list view, and Outlook switches to the Search tab on the ribbon. 

2. Use buttons on the Search tab to limit the results further. For example, click 
Location to enter a location so that only appointments with the original 
search text and the specified location display. 

3. When the results show the appointment you are looking for, handle the ap-
pointment as needed. For example, you can double-click it to open and edit 
it or just look at it in the list view. 

4. Click the Close button on the Search tab when finished. 
 

 

 
 
 

 

Another way to find an appointment is to list all your appointments 
in the list view (View, List). Then you can sort the entries by various 
fields. 

You also can set the Recurrence feature for a meeting. 



Editing and Deleting Appointments 
If you just need to change the date, starting time, or ending time of an appoint-
ment, you can use the dragging method. To change the date of an appointment, 
display a view that will show the current date and the new date simultaneously. 
Then drag the appointment to the new date. To change the start time, drag the 
appointment to the new time. To change the end time, drag the bottom border of 
the appointment up or down, as needed. 

 

 

 
 

If you need to edit other details of the appointment, you have to open the ap-
pointment. Sometimes, instead of editing an appointment, you need to delete it 
entirely. If the appointment is a recurring one, you might need to delete all the 
occurrences or just one of them. 
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Editing Details of the Appointment 
To change certain details of an appointment, such as the reminder, location, or 
category, follow these steps: 

1. Navigate to the appointment and double-click it to open it. 

2. Make any changes that are necessary and click the Save & Close button. 

 or 

 If the appointment is a recurring one, click the Go to Series button (shown 
in Figure 9.7), make the necessary changes, and click the Save & Close 
button. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

If you drag a recurring appointment to a new time, only that occur-
rence of the appointment changes. To update the time for the entire 
series, you must edit the details of the appointment as explained 
next. 



 
 
 
 
 
 
 
 
 
 
 

 

Figure 9.7 The Go to Series button appears only in items that have recurrence  
defined. 
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Deleting a Nonrecurring Appointment 
To delete a nonrecurring appointment, follow these steps: 

1. Navigate to the appointment and click it to select it. 

2. Click the Delete button on the Appointment tab on the ribbon. A dialog box 
asks if you are sure want to delete the appointment. 

3. Click the Delete button in the dialog box. 
  

LET ME TRY IT 

Deleting a Recurring Appointment 
To delete only one occurrence of a recurring appointment or to delete all the oc-
currences of a recurring appointment, follow these steps: 

1. Navigate to the occurrence of a recurring appointment that you want to de-
lete, and click to select it. 



2. To delete the single occurrence or the series, click the Delete button on the 
Appointment Occurrence tab on the ribbon and click Occurrence (for just 
the one occurrence) or Series (for all occurrences). Then click Delete in the 
dialog box that opens. 

Printing the Calendar 
When you want to print your calendar to carry with you, you can print it in differ-
ent formats. These formats match the views that you see on the screen: Day, 
Work Week, Week, and Month. Additionally, you can include the task list when 
you print the calendar. 

  

LET ME TRY IT 

Printing the Calendar and Task List 
Before going through the steps to print a calendar, you might want to set your 
page size and orientation. Use the Page Setup command on the File menu to set 
these options. Then, to print the calendar and your task list, follow these steps: 

1. Make sure the calendar is selected in the navigation pane and select the 
categories of appointments you want to include in the printout if you don't 
want to print every appointment in the calendar. 

2. Click File on the menu bar and click Print, or use the keyboard shortcut 
Cmd-P. The Print dialog box opens, as shown in Figure 9.8. 

3. Select the printer from the Printer pop-up menu. 

4. Specify the number of copies to print and the pages to print. 

5. Select an option for Print. Here's where you can choose to print just the 
categories you selected in step 1. 

6. Select a Style from the pop-up menu. 

7. Specify the start and end dates and times. 

8. Select the Task Options that you want if you want tasks to print with the 
calendar. 

9. Select the Page Options that you want. 

10. Scroll through the preview. If everything looks okay, click the Print button.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 

Figure 9.8 If your Print dialog box is not expanded to show all the options, click the 
reveal button. 

 

Using My Day 
My Day is an Outlook component that enables you to see your day at a glance. It 
is, however, a horse of a slightly different color. Although E-mail, Contacts, Cal-
endar, Tasks, and Notes require Outlook to be open while they are running, My 
Day can be running even if Outlook is closed. What makes it even better is that it 
can access Outlook information when Outlook is closed. Figure 9.9 shows the 
different aspects of your day that My Day displays—appointments and tasks. It 
also can search your contact list. 

To open My Day, click the My Day button on the Tools tab on the ribbon. (My 
Day is accessible from every component of Outlook, not just the Calendar.) To 
hide and display the tasks at the bottom of the My Day window, click the button 
with a check mark at the bottom. To display or hide the Contacts search panel, 
click the button that looks like a Rolodex card at the bottom. Use the navigation 
button in the upper right to see the previous day or the next day. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 9.9 In this figure, you can see that My Day is open but Outlook is not, as evi-
denced by the icon for Outlook in the Dock.. 

 

You can customize My Day by setting preferences. To learn more about setting 
preferences, listen to the following audio recording. 

TELL ME MORE  Media 9.4—Setting Preferences for My Day 
Access this audio recording through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

 



10 This chapter covers creating and editing 
tasks and notes in Outlook. 

 
 
 
 
 

Using Tasks and Notes 
Tasks and notes are two components that round out the Outlook application. 
They are not as robust as the other three components (e-mail, calendar, and 
contacts), but they both serve their purposes well. In this chapter, you explore 
the Tasks and Notes windows; learn how to create, edit, and delete tasks and 
notes; and find out how to change the view of tasks and notes. Additionally, this 
chapter shows you how to create a recurring task, mark a task as completed, 
and send a note in e-mail. 

Exploring the Tasks and Notes Windows 
The Tasks and Notes windows are so much alike that this section discusses 
them together. To see the Tasks window, first open Outlook and then click the 
Tasks button in the navigation pane. To see the Notes window, click the Notes 
button in the navigation pane. 

Each window has a navigation pane on the left, of course, and the area on the 
right displays the item list and reading pane. As you probably know by now, the 
reading pane can display to the right of the item list, under it, or not at all. Figure 
10.1 shows the reading pane under the item list for tasks, and Figure 10.2 shows 
the reading pane to the right of the item list for notes. As you might remember 
from other chapters, I recommend displaying the reading pane below because it 
enables you to have more columns displayed in the item list. To configure the 
reading pane, click the Organize tab, click the Reading Pane button, and click 
Right, Below, or Hidden. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 

Figure 10.1 When you position the reading pane under the Task item list, you can 
see more columns in the item list. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 10.2 In this view, the reading pane is positioned to the right of the Notes item 
list. 

 

Using Tasks 
I suppose to-do lists are universal. I know I live by them. In Outlook, you create 
to-do lists in tasks. Using tasks, you can keep track of individual tasks that you 
create, as well as items you have flagged for follow-up, such as e-mail mes-
sages, contacts, or documents. 



Creating Tasks 
Like appointments, tasks can be one-time items or recurring. You can create a 
task with or without a due date, and you can set a date for Outlook to remind you 
about the task. (Overdue tasks appear in the task list in red type.) To help you 
organize your tasks, you can assign priorities and categorize them. 

 

SHOW ME  Media 10.1—Creating a Task 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

  

LET ME TRY IT 

Creating a Task 
To create a task, follow these steps: 

1. Click Tasks in the navigation pane if necessary. 

2. Click the Task button on the Home tab on the ribbon or press Cmd-N. An 
Untitled Task window opens, as shown in Figure 10.3. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 10.3 The name Untitled Task changes to whatever you type as the name of 
the task after you click the Save & Close button. 

 

3. Enter a name for the task. 



4. To set a Due date, click No Date and click a date on the calendar. (Scroll 
the calendar if necessary.) 

5. To set a date and time for a reminder, click None. Click a date on the cal-
endar. Then type the time you want. 

6. To set a Start date, click No Date and click a date on the calendar for the 
date on which the task should start. 

7. Click in the whitespace at the bottom of the window to type additional  
details that pertain to the task. 

8. Click the Categorize button on the ribbon, if desired, and select a category. 

9. Click the appropriate button on the ribbon to set a high or low priority. (Click 
the same button again to remove a priority.) 

10. When finished, click the Save & Close button. 
 

SHOW ME  Media 10.2—Creating a Recurring Task 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 
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Creating a Recurring Task 
To create a recurring task, follow these steps: 

1. Create a new task as instructed in the preceding set of steps, but don't 
save and close the task. 

2. Click the Recurrence button on the ribbon and select a recurrence period, 
or click Custom, define a more specific recurrence period (such as every 
two weeks), and click OK. Figure 10.4 shows the dialog box that you use to 
define a custom recurrence. 

3. Click the Save & Close button. The task appears in the list with a recur-
rence symbol beside it. 

 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

It's important to note that you cannot add a task to the task list by 
synchronizing with iCal, Google, your iPhone, and so on.  



 
 
 
 
 
 
 
 
 
 

 
 
 
 

Figure 10.4 Using the custom options, you can define more complex recurrences, 
such as the last Monday of every month. 

 

Editing and Deleting Tasks 
Of course, it is inevitable that you will need to revise a task. For example, I can't 
stand the pressure of having an overdue task blaring at me in bright red type, so 
I just edit the task and change the due date. Problem solved (…sort of)! 

 

SHOW ME  Media 10.3—Making Changes to a Task 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 
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Making Changes to a Task 
To edit a task, follow these steps: 

1. Double-click the task in the item list to open it. The title of the task is se-
lected for you automatically. If you want to change the name of the task, 
just type the new name and it replaces the selected name. To change just 
a few characters in the name, click in the name and make the revision. 

2. Click in any of the date fields to select a different date. 

3. To delete a date, click in the field and then click the X button that appears 
beside the field. 

4. Make any other changes that you need to make, such as changing catego-
ries, priority, or recurrence. 

5. Click the Save & Close button when finished. 
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Deleting a Task 
To delete a task, follow these steps: 

1. Select the task and click the Delete button on the Home tab on the ribbon. 
A confirmation dialog box opens. 

2. Click Delete in the dialog box. 

Viewing Tasks 
You can control the way items display in the task item list in various ways: 

▪ You can check the boxes in the Home tab for the items you want to display 
in the list, such as Flagged Items, Overdue, and Completed. 

▪ In the item list, you can sort tasks on any column by clicking the column 
heading. Click the column heading again to reverse the sort order. Addi-
tionally, you can right-click a column heading and select or deselect the 
columns you want to show or hide. And finally, you can size the columns by 
dragging the right border on the column heading to the left or right. 

▪ Another way to sort tasks is to use the Arrange By button on the Organize 
tab. Click the button and select the order in which the items should be sort-
ed, such as by due date, start date, or category. The advantage to sorting 
by the Arrange By button is that you can sort on a field that isn't even dis-
played in the item list. 

▪ On the Home tab, you can click the Filters button and select an option that 
displays only certain tasks such as Overdue, Completed, or High Priority. 
(If you filter the list, be sure to click the Filters button again and select Clear 
All Filters when you are finished.) 

▪ In the navigation pane, you can check the categories that you want to see 
and uncheck the categories you want to hide. Only tasks that have been 
categorized with checked categories display in the list. 

Additionally, you can select a task in the item list and edit fields  
directly in the reading pane. 



TELL ME MORE  Media 10.4—Creating Separate To-Do Lists with 
Categories 
Access this audio recording through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

Marking a Task as Complete 
When a task is complete, you can check it off your list by clicking the check box 
next to the task in the list or by selecting the task in the list and clicking the Mark 
Complete button on the Home tab on the ribbon. When a task is completed, it ei-
ther disappears from the list or has a check mark beside it in the list, depending 
on whether you are showing completed items. In Figure 10.5, the completed 
tasks are visible, but notice that in the item list, the task is checked off, and in the 
reading pane, the task has a line through the title. If you don't want to see com-
pleted items on the list, be sure Completed is not checked on the Home tab on 
the ribbon.  

 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 10.5 A completed task has a line drawn through its title in the reading pane. 

 
 

If you mark a task as complete, and you change your mind (or your 
"better half" points out that you didn't do it right, so you have to do it 
over), you can remove the check mark by clicking the check box for 
the task. 



Using Notes 
The Notes component of Outlook gives you a place to "jot down" something you 
want to keep or remember. You also can use notes to park text that you want to 
use somewhere in the future. 

 

SHOW ME  Media 10.5—Creating Notes 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

  

LET ME TRY IT 

Creating Notes 
To create a note, follow these steps: 

1. Click Notes in the navigation pane if necessary. 

2. Click the Notes button on the Home tab on the ribbon or press Cmd-N. A 
new note opens. 

3. Type a title for the note. 

4. Press Tab and type the text of the note. 

5. Use the commands on the Format menu on the menu bar to format text if 
desired. 

6. Assign a category to the note, if applicable. 

7. To insert a picture in the note, click the Picture button on the Home tab on 
the ribbon, and click Photo Browser or Picture from File. Drag the photo or 
clip art from the Media Browser, or navigate to the file and double-click it. 

8. Click the Close button in the upper-left corner, and then click Save. 
 

 

 
 

Editing and Deleting Notes 
To edit a note, double-click it to open it. Make the changes, click the Close but-
ton, and click Save. To delete a note, select the note in the item list. Then click 

As is the case with tasks, you cannot add notes from other sources, 
such as iCal, your iPhone, and so on. 



the Delete button on the Home tab on the ribbon. When the confirmation dialog 
box opens, click Delete. 

Viewing Notes 
When viewing notes in the item list, you can sort notes on any column by clicking 
the column heading and then reverse the sort order by clicking the heading 
again. To show or hide specific columns, right-click a column heading and select 
or deselect the columns you want to show or hide. To make columns wider or 
narrower, drag the right border of the column heading to the right or left. Addi-
tionally, you can sort notes by clicking the Arrange By button on the Organize 
tab. If you have assigned categories to notes, you can filter the notes by category 
by checking the categories in the navigation pane that you want to see and un-
checking the categories you want to hide. 

E-mailing Notes 
If you want to e-mail a note to someone, you have two options. You can send the 
note as the text of a message, or you can send the note as an HTML attachment. 
To send the note as the actual text of the message, select the note and click the 
E-mail button on the Home tab on the ribbon. Outlook makes the name of the 
note the subject of the message and inserts the text of the note in the body of the 
message. All you have to do is supply the recipients and send the message. To 
send the note as an HTML attachment, click the Forward button on the Home tab 
on the ribbon. Then it's up to you to supply the recipients and a subject before 
you send the message. 



11 This chapter shows you how to create 
and present a basic slide presentation.  
 

Getting Started with PowerPoint 
PowerPoint is the Office application that creates slide presentations. Using slide 
presentations, you can present ideas and information one image at a time. As 
the presenter, you have the ability to pace the presentation and take the time to 
explain, discuss, or answer answers on each topic. PowerPoint presentations 
can be simple or quite stylish and elaborate. This chapter introduces you to the 
application and shows you how to create and present a simple presentation. 

 

 To learn about creating more elaborate presentations, see Chapter 12, 
"Creating Sophisticated Presentations." 

Using Themes and Templates 
When you start PowerPoint, the PowerPoint Presentation Gallery opens by de-
fault, as shown in Figure 11.1, unless you have turned off the PowerPoint Pres-
entation Gallery by clicking the Don't Show This When Opening PowerPoint 
check box. This window enables you to select a theme or a template for the 
presentation you want to create. If it doesn't open when you start PowerPoint, 
click the New from Template button, shown later in Figure 11.2, to open it. 

In the navigation pane, you have a choice of three categories: Themes, Tem-
plates, and Online Templates. PowerPoint has more than 50 themes, 15 built-in 
templates, and innumerable online templates for you to use. 

A theme is a collection of slides that use specific fonts, colors, and graphic ele-
ments to help you create a presentation that has a consistent design. Each 
theme provides various layouts that you use to create a new slide. The layouts 
have placeholders for text, graphics, videos, and so on, and you must add your 
own content to these placeholders. If you want to build your own presentation 
from scratch, choose a theme instead of a template. 

 

 

 
 
 
 
 
 

The same themes are available in Word and Excel, so you can cre-
ate a consistent look across documents.  



 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 11.1 The PowerPoint Presentation Gallery gives you access to all the styles 
and templates on your computer as well as those located online. 

 

 
 

If you want to build a presentation quickly, choose an appropriate template in-
stead of a theme. PowerPoint provides several photo album templates as well as 
subject-specific templates. A template is an actual finished presentation. By "fin-
ished," I mean that the presentation contains slides that present a complete idea 
from start to finish. The placeholders contain text and photos that you might very 
well be able to use with only slight additions or modifications. This depends on 
the template, of course. Some presentation templates, such as Charting a 
Course by Wes Moss, even guide you through the process of developing your 
own material to place in the presentation. 

  

LET ME TRY IT 

Selecting a Theme 
To select a theme from the complete set of themes that PowerPoint provides, fol-
low these steps: 

1. Click the New from Template button in the toolbar to open the Gallery. 

2. In the left pane, click the reveal button for Themes if necessary and click 
All. 



3. In the middle pane, click the thumbnail for the theme that you want to use. 
The theme displays in the right pane. Except for the White theme, all other 
themes have three options that you can set if you want to. 

 

 

 
 

4. If you want to change the color scheme, font, or size of the slide, make 
your selections for each from the appropriate pop-up menus. The slides 
represented in the right pane update to reflect your new selections. You 
can click the navigation buttons under the slide to see all the samples. 

5. Click Choose. PowerPoint creates a new slide presentation that it calls 
Presentation1 or Presentation2, and so on. You can give the file a more 
appropriate name when you save it. 

  

LET ME TRY IT 

Selecting a Template 
To select a template from the complete set of templates that PowerPoint pro-
vides, follow these steps: 

1. Click the New from Template button in the toolbar to open the Gallery. 

2. In the left pane, click the reveal button for Templates if necessary and click 
All. Additionally, you can click the reveal button for Online Templates if 
necessary, and click Presentations. 

3. In the middle pane, click the thumbnail for the template that you want to 
use. The template displays in the right pane with three options that you can 
set if you want to. 

 

 

 
 

 

4. If you want to change the color scheme, font, or size of the slide, make 
your selections for each from the appropriate pop-up menus. The slides 

Before selecting a template from the collection that is installed on 
your hard drive, you can move the mouse pointer over the thumb-
nail to see the various slides the template contains. This feature is 
not available for online templates. 

To get an idea of what slides are available in each theme, move the 
mouse pointer across the thumbnail in the middle pane. 



 

represented in the right pane update to reflect your new selections. You 
can click the navigation buttons under the slide to see all the samples. 

5. Click Choose. PowerPoint creates a new slide presentation that it calls 
Presentation1 or Presentation2 and so on. You can give the file a more ap-
propriate name when you save it. 

 

 
 

Exploring the PowerPoint Window 
The PowerPoint window, shown in Figure 11.2, has the standard window ele-
ments: a title bar at the top, a toolbar under the title bar, and then the ribbon. The 
status bar is at the bottom of the window. 

 

 To learn more about how the ribbon works, see "Getting Familiar with the 
Ribbon," in Chapter 1, "Getting Started with Word." 

 
 
 
 
 
 
 
 
 
 
 

You can view the PowerPoint window with three different views: normal, slide 
sorter, and slide show. Use the normal view to create or edit an individual slide. 
Use the slide sorter view to get an overview of your presentation or rearrange 
slides. Switch to the slide show view to see how a particular slide will look when 
played or to play the entire presentation. Press Esc to exit the slide show view. 

Figure 11.2 shows the normal view, which divides the window into three panes. 
The pane on the left is the navigation pane. It toggles between two views: Slides 
(thumbnails of the slides you create) and Outline (the text on all the slides in an 
outline format). The largest pane on the right contains the currently selected 
slide. The pane under the largest pane is the Notes pane. Use it to make notes 
for yourself, or use it to make notes that you will later print and hand out to the 
audience. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Notice in Figure 11.2 that the Layout and Section buttons do not 
have labels. This is because the screen resolution is set at 1024 by 
768 (the resolution required for this book). At higher resolutions, 
PowerPoint shows a label for these buttons. 

The template called Introducing PowerPoint 2011 is a tour of new 
features, and it's well worth a look. 



 
 
 
 
 
 
 
 
 
 
 

Figure 11.2 The PowerPoint window opens by default to the normal view. 

In Figure 11.3, you can see that the slide sorter view shows thumbnails of all the 
slides. If you double-click a thumbnail in the slide sorter view, the slide opens in 
the normal view, where you can edit it. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 

Figure 11.3 The slide sorter view shows thumbnails of all the slides in the  
presentation. 

 

Building the Presentation 
When using a theme for a presentation, you should know that PowerPoint pro-
vides two distinct methods for building a presentation: You can build a presenta-
tion by creating one slide at a time, or you can type or import an outline that 
automatically creates all the slides based on the heading levels in the outline. 
Additionally, you can combine both methods to get the best of both worlds. This 
chapter covers all three methods. 

From this point on, I use a specific theme to illustrate the steps for basic proce-
dures. If you want to follow along with the steps in the next few procedures and 
make sure your screen looks like my figures, create a new presentation using the 
Adjacency theme and choose Breeze for the color scheme. If you're just looking 
up how to do something in this chapter, don't worry; the steps are the same no 
matter what theme you use. 

Creating a Presentation One Slide at a Time 
Using this method, you select the layout for the slide, add the slide, and then add 
the content to the placeholders. With this method, you can see the design of the 
presentation developing. When you create a new presentation using a theme, 
PowerPoint creates the first slide for you using the Title Slide layout. As you add 



slides to the presentation, you have the opportunity to select the layout you want 
a slide to use. 

 

SHOW ME  Media 11.1—Adding a Slide 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

  

LET ME TRY IT 

Adding a Slide 
To add a slide, click the Slides button in the navigation pane and follow these 
steps: 

1. In the navigation pane, click the slide that the new slide should follow. 

2. Click the pop-up button on the New Slide button (located on the Home tab 
on the ribbon) to display your layout choices, as shown in Figure 11.4. All 
themes have the same layout options, but templates can have different 
layouts. The reason is that the layouts are created specifically for each 
template. 

 

 

 
 
 

 
 
 

3. Click the layout you want the new slide to use. The new slide opens in the 
large pane, and the new slide also appears in the navigation pane. 

4. If you find that you want to change to a different layout, click the Change 
the Layout of the Selected Slide button (refer to Figure 11.2). 

 

 

 
 
 
 
 
 
 
 
 
 

Each slide layout comes from a master slide. The default master 
slide contains placeholders, but you can edit the master slides and 
add or delete slide elements. See "Editing a Slide" later in the chap-
ter for more information. 

If you simply click the New Slide button, PowerPoint adds a slide 
that has the same layout as the previous slide. However, if the pre-
vious slide is a Title Slide, PowerPoint is smart enough to know 
that you don't usually have two title slides together, so it adds a 
slide that uses the Title and Content layout. 



 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 11.4 All themes offer the same basic layouts. 

 

 

After you create a slide, you can add the content to the placeholders. Some 
placeholders can hold only text, whereas other placeholders can hold tables, 
charts, photos, and other media. This chapter focuses on text, photos, and clip 
art. Chapter 12, "Creating Sophisticated Presentations," covers the topics of in-
serting tables, charts, audio, and video. 

 

 

 
 

 
 

SHOW ME  Media 11.2—Adding Text to a Placeholder 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

The default text in a placeholder, "Click to add ….," displays only in 
the normal view. A placeholder is invisible in a presentation if you 
have not added content to it. 



LET ME TRY IT 

Adding Text to a Placeholder 
To add text to a text placeholder, follow these steps: 

1. Click in the placeholder and type the text. The text is formatted with the font 
size that is mandated by the theme. 

 

 

 
 

2. To add emphasis or color to a portion of the text, select the text and use 
the Font buttons (Bold, Italic, Underline, Font Color, Font Effects, and so 
on) on the Home tab on the ribbon. To format paragraphs, select the text 
and use the Paragraph buttons (Bulleted List, Numbered List, Line Spac-
ing, and so on) on the Home tab.  

 

 

 
 

LET ME TRY IT 

Adding Clip Art to a Placeholder 
To add clip art to a placeholder, follow these steps: 

If you want to place text on a slide that is not in a placeholder, insert 
a text box by clicking the Text Box button on the Home tab. 

It is possible to type more text than the placeholder can hold. If 
your text is just a little too much for the default size of the place-
holder, edit the text so it fits or increase the width of the place-
holder. (See instructions later in this chapter.) 

Another alternative is to change the font size, but then you are 
messing with the design and creating an inconsistent and (proba-
bly) unprofessional look. I don't recommend this approach even 
though PowerPoint provides a button for you to use to automati-
cally fit text to the placeholder. You shouldn't try to say everything 
on the slide anyway. The slide presentation is just a visual aid for 
your verbal presentation. It should hit the high points, and you 
should fill in the details. 



1. Click the Clip Art Browser button in the placeholder (see Figure 11.5). The 
Media Browser opens to the Clip Art tab if it is not already open (or if the 
Media Browser is open but displaying a different tab, it switches to the Clip 
Art tab). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 11.5 If the placeholder does not have buttons in the middle as shown here, 
the placeholder accepts only text. 

 

2. Drag the clip art that you want into the placeholder. The clip art displays at 
a default size, which might be too large or too small for your purposes. Fig-
ure 11.6 shows clip art that is too large for the placeholder. 

3. Resize the clip art if necessary by using the buttons shown in Figure 11.6.  

4. When finished, click outside the placeholder. 
 

 

 
 

SHOW ME  Media 11.3—Adding a Photo to a Placeholder 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Alternatively, you can open the Clip Art Gallery to insert the clip art 
instead of using the Media Browser. To open the Clip Art Gallery, 
click Insert in the menu bar and click Clip Art, Clip Art Gallery.  



 

 
 
 
 
 
 
 
 
 
 
 
 

Figure 11.6 When clip art is too large for a placeholder, only a portion of the clip art 
displays unless you resize the clip art or the placeholder. 

 
  

LET ME TRY IT 

Adding a Photo to a Placeholder 
To add a photo to a placeholder, follow these steps: 

1. Click the Insert Picture from File button in the placeholder. (Refer to Figure 
11.5.) The Choose a Picture dialog box opens. 

2. Navigate to the file you want and select it, as shown in Figure 11.7. 

3. Click Insert. Photos automatically resize to fill the placeholder, as shown in 
Figure 11.8. 

4. Resize the photo if necessary by using the buttons shown in Figure 11.8. 

5. Use any of the photo formatting techniques on the Format tab that you 
want to apply to the photo, such as Corrections, Filters, Removing Back-
ground, and so on. 

 To learn more about photo formatting techniques, see "Working with  
Photos" in Chapter 4, "Exploring Other Features." 

 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 11.7 The selected photo has a portrait composition, but it will be going into a 
placeholder that is landscape. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 11.8 PowerPoint automatically cropped the photo and resized it to fill the 
placeholder. Refer to Figure 11.7 to see the original, uncropped photo. 

 
 

6. When finished, click outside the placeholder. 
 
 
 
 
 

 

If the photo you want to insert in the placeholder is in iPhoto or 
Photo Booth, you can drag the photo from the Media Browser to 
the placeholder. To open the Media Browser, click the Show or 
Hide Media Browser button on the toolbar or press Cmd-Opt-M. 



 

 

Using the Media Browser 
Because I've mentioned the Media Browser, I feel I must give you a heads-up 
about using it. Don't think that just because you can drag an object from any tab 
in the Media Browser and drop it on a placeholder that the object actually goes 
into the placeholder. A placeholder may not even be able to hold the object you 
drop on it. For example, a placeholder can't hold a shape. This doesn't mean, 
however, that you can't put a shape on a slide. You can. The shape is just free-
floating. 

 

 To learn more about the Media Browser, see "Inserting Media from the 
Media Browser" in Chapter 6, "Creating Documents for Publication." 

Try this little experiment to demonstrate my point. Add a slide using the Title and 
Content layout. Drag a photo from the Media Browser to the placeholder under 
the title. Now drag the green handle at the top of the placeholder to rotate the 
placeholder. The photo rotates with the placeholder because it is indeed inside 
the placeholder. Now delete the photo. The placeholder rights itself automati-
cally. This time drag a rectangular shape from the Media Browser to the place-
holder and rotate the placeholder again. The rectangle does not rotate because 
it's not really in the placeholder. The rectangle is on its own layer on the slide. To 
learn more about working with layers on slides, watch the following video. It 
demonstrates the new three-dimensional reorder feature. 

 
 
 

SHOW ME  Media 11.4—Working with Layers 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

By following all the instructions in this section, you will create one slide. Then you 
can start all over again and create the next slide, and the next slide, until you 
have created all the slides in the presentation. 

Creating a Presentation from an Outline 
The second method for creating a presentation is to type the text of all the slides 
in the Outline pane of the navigation pane. As you type, PowerPoint creates 
each slide for you. 

 

 



 
 

 
 

SHOW ME  Media 11.5—Typing the Outline for a Presentation 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

  

LET ME TRY IT 

Typing the Outline for a Presentation 
To use the outline method, first click the Outline button in the navigation pane of 
the normal view. To type the text for all the slides in the presentation, follow  
these steps: 

1. Click the insertion point to the right of the icon for the first slide (see Figure 
11.9) in the navigation pane and type the title that should appear on the 
slide. By default, this slide uses the Title layout, which has a placeholder for 
a title and subtitle. As you type the title in the navigation pane, the text 
shows in the title placeholder in the large window. 

2. Press Return. PowerPoint generates a new slide that uses the Title and 
Content layout, giving you no chance to type a subtitle on the first slide! 
Press Tab to take back control! PowerPoint deletes the new slide, indents 
the line that you are on in the navigation pane, and redisplays the first slide 
in the large pane. Type a subtitle. 

3. Press Return. Now you can type a second line for the subtitle, but assume 
that you have only a one-line subtitle. 

4. Press Shift-Tab. PowerPoint creates the second slide for you, again using 
the Title and Content Layout. 

5. Type the title for the slide and press Return. Again, PowerPoint roars right 
past the placeholder for the content of the slide. 

6. Press Tab to return to the slide. Type the text for the content. PowerPoint 
automatically formats the text as a bulleted list. Each time you press Re-
turn, PowerPoint creates another bullet point. (If you press Tab, Power-

If you already have the outline created in Word, you can save the 
file in Rich Text Format (.rtf) and use it instead of typing the text. 
Note that the outline must have levels applied to the headings us-
ing the Promote and Demote button in the Outline view. 



Point creates a sublevel bullet.) When finished with the last bulleted item, 
press Return, and then press Shift-Tab. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 11.9 Click the Outline tab in the navigation pane to type the text for all slides. 

 

 

 
 

7. Repeat steps 5 and 6 for each slide in the presentation. When you are on 
the last slide, don't press Return at the end of the last line. 

Creating a Presentation with Both Methods 
Using a combination of both methods may be the most efficient way to create a 
presentation. You can start out by typing the outline, but when a new slide does-
n't use the layout that you want, you can click the Change the Layout of the Se-
lected Slide button on the Home tab on the ribbon and select the layout you want 
to use. After selecting the layout, you can return to the navigation pane and con-
tinue typing the text. 

 

If the content you want to put on a slide does not fit the bulleted list 
format, or you don't like the layout of the slide, you can reformat the 
text or select a different layout. I don't usually worry about this issue 
until after I finish typing the complete outline. 



SHOW ME  Media 11.6—Creating a Presentation with Both  
Methods 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

Saving a Presentation 
When you're saving a PowerPoint presentation, think about how you will use the 
file. If you are going to play the slide show on your computer, it should be fine to 
save the presentation in PowerPoint's default XML file format, which has the ex-
tension .pptx. Additionally, you could save it in the PowerPoint Show format with 
the .ppsx extension. Double-clicking a .ppsx file in the Finder automatically 
opens the file in slide show view. If you might give the file to a user with an older 
version of PowerPoint that doesn't read the XML-based format, use the .ppt file 
format. If you might give the file to someone who doesn't have PowerPoint at all, 
you could save the file as a QuickTime movie so it still runs like a presentation, 
or you could save it in PDF format, which has a page for each slide. 

  

LET ME TRY IT 

Saving a Presentation in Different Formats 
To save a presentation in different formats, follow these steps: 

1. Click File on the menu bar and then click Save (if the file has never been 
saved before) or click Save As. 

2. Enter a name for the file if it has never been saved before or you want to 
change the name. 

3. Select a location where you want to save the file. 

4. Click the pop-up button for Format. Your choices are shown in Figure 
11.10. 

5. Select the format and click Save. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 

 

Figure 11.10 Select the correct format for the presentation when you save it. 

 
 

Modifying the Presentation 
Making modifications to a presentation is not an isolated event. While you are 
creating a new presentation, you are also modifying it. Of course, after a presen-
tation is created and saved, you might need to open it and modify it some more. 
This section covers some of the most common types of modifications. 

Editing a Slide 
Editing a slide covers a lot of territory. You can revise, add, or delete text and 
graphic content on a slide; tweak the layout by adding, moving, or resizing 
placeholders; change the slide to a different layout; and modify the master slide 
layout. 

To edit a slide, you first have to display the slide in normal view. You can select 
the slide in the slide sorter view and then switch to normal view, double-click the 
slide in slide sorter view, or select the slide in the navigation pane in normal view. 
Then make any of the following edits: 

▪ To edit text in a placeholder, click anywhere in the placeholder and use 
text editing or formatting techniques. These techniques are the same as 
those you would use in Word. For example, you can select text and press 



Delete. The formatting buttons for fonts and paragraphs are located on the 
Home tab on the ribbon. 

▪ To modify a photo or clip art in a placeholder, click the graphic to select 
it and use the same techniques to resize or crop as explained earlier in this 
chapter in the "Creating a Presentation One Slide at a Time" section. 

▪ To delete a photo or clip art in a placeholder, select the graphic and 
press Delete. 

▪ To change the size or location of a placeholder, click the placeholder 
and drag a handle to resize it or drag the outline to a new location to move 
the placeholder. Although you also can delete a placeholder, there's really 
no point. Just delete the content of the placeholder and leave the place-
holder there in case you need it later. 

▪ To change the layout the slide uses, select the slide (or multiple slides) 
and click the Change the Layout of the Selected Slide button. Click the lay-
out you want to use. 

▪ To change a master slide layout, click View on the menu bar and select 
Master, Slide Master. In the navigation pane, click the layout you want to 
modify. Make the changes that you want to make, such as moving the 
placeholders, adding graphics, changing the fonts, and so on. The changes 
that you make to the layout are reflected in all slides that have been or will 
be created using the layout. 

TELL ME MORE  Media 11.7—Editing the Master Slide Layouts 
Access this audio recording through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

Deleting a Slide 
You can delete slides in the slide sorter view or in the navigation pane in normal 
view. I like to use the slide sorter view to delete slides because it enables you to 
see more than one slide, and you can verify that you have selected the correct 
slide for deletion by zooming in so you can read the slide. 

To delete a slide in the slide sorter view, click it to select it and then press Delete. 
To delete several slides that are adjacent to each other, select all the slides by 
clicking a slide at one end and Shift-clicking the slide at the other end. To select 
multiple slides that are not adjacent, Cmd-click each slide. In the normal view, 
you use the same steps. Select the slide(s) in the navigation pane (in either the 
Slides pane or Outline pane) and press Delete. 



Duplicating a Slide 
To duplicate a slide, select the slide you want to duplicate either in the slide sort-
er view or in the navigation pane in the normal view. Then click Edit on the menu 
bar and click Duplicate. The keyboard shortcut for this command is Cmd-D. 

Changing the Slide Order 
You can rearrange the order of slides in the normal view or the slide sorter view, 
but you can see more slides in the slide sorter view. In either view, you simply 
drag a slide to a new location. In the normal view, you drag the slide in the navi-
gation pane in either the Slides pane or the Outline pane. 

Hiding a Slide 
To make a slide presentation more versatile, you might want to include slides for 
one audience that you do not include for a different audience. When you don't 
want a slide to show in a presentation, you can hide it before running the slide 
show. To hide a slide, right-click the slide (either in the slide sorter view or in the 
navigation pane in the normal view) and click Hide Slide. PowerPoint dims the 
thumbnail for the slide in the navigation pane and in the slide sorter view. To 
make the slide visible again, right-click the slide again and click Hide Slide to re-
move the check mark. 

Adding Notes to a Slide 
You might recall that the normal view has a pane on the right for adding notes. 
It's under the large pane, and it says, "Click to add notes." Use this pane to type 
any notes to yourself, or use it to add additional information that you intend to 
print to give to the audience. To print the notes, click the Print What pop-up box 
in the Print dialog box and select Notes. PowerPoint prints one slide per page 
with the slide at the top and the notes under it. 

Changing the Theme 
If you have created a presentation using a theme, you can modify the theme by 
selecting different colors, fonts, or backgrounds, or you can switch to a different 
theme. Although it is possible to switch to a different theme if the presentation is 
based on a template, doing so is not advisable. The result is usually a mess. 

To change anything about the theme of a presentation, click the Themes tab on 
the ribbon. You can change the colors, fonts, or background by clicking the  



 

corresponding buttons in the Theme Options section. You can change to a dif-
ferent theme by clicking a new theme in the Themes section. After I have created 
several slides using different layouts, I like to experiment with different themes in 
the slide sorter view. This view gives a great overview of what the presentation 
will look like because it shows all the different layouts I have used with the new 
theme. 

Presenting the Show 
To play the slide show, open the file and then click the Play pop-up button on the 
Home tab on the ribbon. Click Play from Start or click Play from Current Slide. By 
default, the slide show plays in full screen, and you must advance the slides ma-
nually. 

 

 

 
 

To advance to the next slide manually, click the right arrow in the control that 
displays at the bottom-left side of the screen or press the right arrow key. To go 
back to the previous slide, click the left arrow in the control or press the left arrow 
key. When the presentation is finished, press Esc. 

 

 To learn more about presenting slide shows, see "Polishing Your Presen-
tation Skills," in Chapter 12. 

Inevitably, someone in the audience wants a printed copy of the slide show. You 
can prepare for this by printing handouts ahead of time. In the Print dialog box, 
click the Print What pop-up button and select an option for the number of slides 
you want to print per handout page (two, three, four, six, or nine). The Quick Pre-
view shows you what the handout will look like, as shown in Figure 11.11. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Handouts do not include any notes you have included in the  
presentation. 

To change these defaults, click the Set Up Show button on the Slide 
Show tab on the ribbon. 



 
 
 
 
 
 
 
 
 
 
 

 

Figure 11.11 If you select three slides per page, PowerPoint adds lines beside the 
slides for taking notes. 
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This chapter shows you how to add 
transitions, animations, and narration and 
how to save a presentation as a QuickTime 
movie. 

Creating Sophisticated 
Presentations 

PowerPoint slide presentations can be very elaborate and stylish. Using the spe-
cial tools that PowerPoint provides, you can create a very interesting, entertain-
ing, and commanding presentation. You also can become so enamored with the 
features that you overpower the point of your presentation with fancy bells and 
whistles. This chapter shows you how to use some of these special features and 
gives you a little advice along the way to keep you from getting carried away. 

This chapter covers organizing a slide show in sections, creating custom slide 
shows within the same file, and adding actions to perform tasks for you. To en-
hance the slide show, the chapter shows you how to add tables, charts, and 
SmartArt; animate individual slide elements; include music, narration, and video; 
and add transition effects between slides. To improve your final presentation, you 
see how to rehearse, create handouts, set up the show, and present the slide 
show using the Presenter View. 

Grouping Slides in Sections 
Grouping slides in sections is a new feature in Office for Mac 2011. You can cre-
ate sections in any slide show, but the feature is particularly suited to working 
with slide shows that have multiple contributors or a large number of slides. For 
example, you can create sections for each contributor, or you can create sec-
tions for slides in various stages of development, such as Incomplete Data, 
Needs Photo, Check for Accuracy, Delete If Necessary, Finished, and so on. Ad-
ditionally, you can create sections to group similar topics together to help you or-
ganize your slide show and move slides as a group. 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



LET ME TRY IT 

Creating a Section 
To create a section, follow these steps: 

1. Select the slide that should be the first slide in the section. 
 

 

 
 

2. Click the Section button (see Figure 12.1). 

3. Click Add Section. The Rename Section dialog box opens. 

4. Type the name for the section and click Rename. 

When you create a section, PowerPoint creates a bar with the name of the sec-
tion. This bar displays in the navigation pane of the normal view and in the slide 
sorter view. The section title has a reveal triangle that you can click to collapse or 
expand the section, as shown in Figure 12.1. 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

If you don't like the name you gave a section or the purpose of the section 
changes, you can change the name by right-clicking the title bar and selecting 
Rename. Type the new name and click Rename. 

The slides that you put in each section do not have to be in the order in which 
they will be presented, and, in fact, many times they are not, as the case would 
be for sections called Incomplete Slides and Finished Slides. Additionally, sec-
tions do not have to be in any particular order. You can move slides and sections 
in the slide sorter view (my favorite) or in the navigation pane in normal view. To 
move a section in the navigation pane, drag the title bar up or down. To move a 
slide to a different section, drag the slide to the new location in the new section. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Notice in Figure 12.1 that the Section button does not have a label. 
This is because the screen resolution is set at 1024×768 (the reso-
lution required for this book). At higher resolutions, PowerPoint 
shows a label for this button. 

If you add your first section anywhere after the first slide, Power-
Point automatically creates a section called Default Section at the 
beginning of the presentation. 



 
 
 
 
 
 
 
 
 
 

 

Figure 12.1 The first section in the slide sorter view is collapsed. 

 
 
 
 
 

 

 
 
 

While you are working on a presentation, if a section of slides is no longer need-
ed, you can delete the section and all the slides in the section. For example, if 
you have a section called Delete If Necessary, where you put all the slides that 
you want to delete if the presentation gets too long, you can delete them all in 
one fell swoop. 

 

 

 

I usually just hide slides instead of deleting them. You never know 
when you might need them! 

Because PowerPoint numbers slides sequentially, regardless of 
the sections, and renumbers them when you move them around, I 
recommend that you put a temporary number in a text box on each 
slide with the number of its true position in the slide show. Then, 
when you are finished with sections, you can put the slides back in 
the correct order and delete the text boxes with numbers in them. 



 

When a section heading is no longer useful—you have completed all the slides in 
the section, for example—you can delete the section heading. When all section 
headings are no longer useful, you can delete all of them at once, leaving the 
slides intact. Then you can drag the slides into the correct order, if necessary. 
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Deleting Sections 
To delete sections, follow these steps: 

1. Right-click a section or click the section title bar in the navigation pane or in 
the slide sorter view to select it and click the Section button. 

 

 

 
 

2. To delete all sections, click Remove All Sections. 

 To delete only the selected section title, click Remove Section. 

 To delete the selected section title and all slides, click Remove Section and 
Slides. 

Adding Tables, Charts, and SmartArt 
As explained in Chapter 11, "Getting Started with PowerPoint," placeholders that 
can hold tables, charts, photos, and other media have a set of buttons in them, 
as shown in Figure 12.2. The first button inserts a table, the second button in-
serts a chart, and the third button inserts SmartArt. This section looks at each 
one of these elements. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

It is not possible to select more than one section title at a time. 



 
 
 
 
 
 
 
 
 
 
 

 

Figure 12.2 Click the button to insert the corresponding element. 

 

Inserting a Table 
To present information on a slide in a tabular format, insert a table by clicking the 
Insert Table button in the placeholder. Specify the number of columns and rows 
and click OK. PowerPoint inserts a table that has a header row, banded rows, 
and uses colors consistent with the theme (see Figure 12.3). Use the Options 
button on the Tables tab to change the header row and banded rows or to add a 
total row.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 12.3 PowerPoint inserts a table that is consistent with the theme colors. 



 

On the ribbon, use the Home tab to format text in the table, use the Tables tab to 
format the table colors and borders, and use the Table Layout tab to modify the 
structure of the table. To delete a table, click it and press Delete. Other aspects 
of working with tables in PowerPoint are the same as those for working with ta-
bles in Word. For example, if the insertion point is in the last cell in the table and 
you press Tab, PowerPoint creates a new table row. 

 

 To learn more about creating, navigating, and modifying tables, see 
"Working with Tables" in Chapter 3, "Formatting Documents." 

Inserting a Chart 
Charts are quite common in slide presentations. I think it's actually against the 
law to give a presentation that doesn't contain one. They present information in a 
graphic way that is easier to understand and interpret than looking at the raw  
data. 

When you insert a chart on a slide, PowerPoint opens an "internal" Excel sheet 
with sample data, and you must replace the data with the real data. When you 
save the PowerPoint presentation, PowerPoint saves the Excel sheet within the 
PowerPoint file. If you have already created a chart in an existing Excel file, you 
can open the workbook, copy the data range, paste it into the internal Power-
Point sheet, and then create the chart. Another alternative for using a chart from 
an existing Excel file is to create the chart in Excel, copy the chart from the Excel 
file, and paste it directly on a slide in the PowerPoint file. 
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Inserting a Chart 
To insert a chart on a PowerPoint slide, follow these steps: 

1. Click the Insert Chart button in the placeholder. The Chart tab on the ribbon 
opens. 

2. Click the button for the type of chart you want to insert and then select the 
style of the chart. PowerPoint opens an Excel spreadsheet with sample da-
ta in it. 

3. Replace the sample data with the data you want to graph and switch to 
PowerPoint to see the chart. Close the internal Excel worksheet if you are 
satisfied with the chart. If you need to edit the data after closing the work-
sheet, click the Edit button on the Charts tab on the ribbon.  

 



 To learn more about creating charts, see "Working with Charts" in  
Chapter 14, "Enhancing Worksheets." 

Inserting SmartArt 
The SmartArt graphics provide a visual representation of a concept such as a 
process, cycle, hierarchy, or relationship. Like charts, they present information in 
a way that is easier to understand and interpret than reading straight text. 
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Inserting a SmartArt Graphic 
To insert a SmartArt shape, follow these steps: 

1. Click the SmartArt button in the placeholder. The SmartArt tab on the rib-
bon opens. 

2. Click the pop-up button for the type of graphic you want to insert, and then 
click the style you want. 

3. Click each [Text] placeholder in the graphic and type the text you want. 
SmartArt automatically adjusts the size of the font to fit the drawing. 

4. Click anywhere outside the SmartArt graphic when finished.  
 

 To learn more about working with SmartArt, see "Inserting and Working 
with SmartArt" in Chapter 6, "Creating Documents for Publication." 

Using Actions 
Imagine that you are a software designer, and you are giving a PowerPoint pres-
entation on the benefits of using your software. At one point in the presentation, 
you want to launch the actual software so you can demonstrate it. You can do 
this without ever leaving the slide presentation by assigning an action to launch 
the application to an element on the slide, such as a button. When you click or 
mouse over the element, PowerPoint performs the action you have assigned.  

In addition to launching an application (as in this example), an action can hyper-
link to another presentation, file, web page, slide in the current presentation, and 
so on; run a macro; perform an object action (if the action is attached to an em-
bedded object such as a video); or play a sound. The great thing about actions 
is, when you present the slide show, you don't have to perform them at all. It's 
entirely up to you. They are just there if you need them. 

 



SHOW ME  Media 12.1—Assigning an Action 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 
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Assigning an Action 
You can assign an action to a placeholder, graphic, text box, and so on. To as-
sign an action to an element on a slide, follow these steps: 

1. Select the element and click the Slide Show tab on the ribbon. 

2. Click the Action Settings button to open the dialog box shown in Figure 
12.4. The Mouse Click tab is the default tab. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 12.4 Actions that are dimmed are not available for the object you have  
selected. 

3. Click the Mouse Over tab if you prefer to activate the action with a mouse 
over instead of a mouse click. 

4. Select an action from the Action on Click or the Action on Mouse Over box: 



▪ To hyperlink, select Hyperlink To and then select a hyperlink target, as 
shown in Figure 12.5. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 12.5 Hyperlinks can jump to other slides in the same show or go outside the 
presentation to web pages or other files. 

 

▪ To launch an application, click Run Program and then click Select. Navi-
gate to the application file and double-click it. (Most applications are in 
the Applications folder and have the extension .app.) 

▪ To run a macro, click Run Macro and then select the macro from the 
pop-up list. (This option is not available if no macros are saved in the 
PowerPoint presentation.) 

▪ If you have selected an embedded object, click Object Action and click 
an option in the pop-up menu. 

5. To play a sound, click Play Sound and then select a sound such as Drum 
Roll from the pop-up menu or add your own canned laughter by selecting 
Crowd Laughing. 

6. Select Highlight Click if you want to see a border display around the ele-
ment briefly when you click it. 

7. Click OK. 
 

 



 
 

Adding Animation and Transitions 
Slide presentations have been around in one form or another for a long time. An 
apparatus called the Magic Lantern, invented in the 1840s, was the forerunner of 
the slide projector that used 2×2 slides in the 1950s. So people have been yawn-
ing at slide presentations for more than a century. One way to cut down on the 
yawning is to add animation and slide transitions to your presentation. 

Adding Animation to Presentations 
Animations can focus a viewer's attention on a slide as well as make a point. For 
example, if the title of a slide is "Costs Are Spinning Out of Control," you could 
apply an animation to the title that makes the title spin. 

You can apply animation to any element on a slide, and you can animate the en-
trance or the exit of the element as well as emphasize the element while it's on-
screen. The animation can play automatically or when you click the mouse. 

 

SHOW ME  Media 12.2—Animating Slide Elements 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 
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Animating Slide Elements 
To add animation to multiple elements on a slide, follow these steps: 

1. Select the element (or multiple elements) on the slide that should perform 
the animation. It could be a text placeholder, photo, table, SmartArt ele-
ment, and so on. 

PowerPoint also has Action buttons you can add to presentations. 
Many of these buttons are preprogrammed to perform specific ac-
tions when you click them. For example, the Home button is hyper-
linked to the first slide. To insert an Action button, click the Slide 
Show option in the menu bar and point to Action Buttons. Click the 
button you want, and then click the slide. Complete the Action Set-
tings dialog box if necessary and click OK.  



2. Click the Animation tab on the ribbon and click the effect you want to use 
under Entrance Effect, Emphasis Effects, Exit Effects, or Motion. Power-
Point plays the effect for you and places a number in a box on the left side 
of the slide, as shown in Figure 12.6. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 12.6 The animation number displays beside its element on the slide. 

 

3. Click the Start pop-up button in the Animation tab and select On Click, With 
Previous, or After Previous. 

4. Click the Duration pop-up button and specify the number of seconds the 
animation should take. 

5. To see all the effects you have applied to an element, click the Play button 
under Preview in the Animations tab. 

6. Repeat steps 1 through 4 for each element you want to animate. As you 
animate each element on the slide, PowerPoint applies a sequential num-
ber to the animation. 

Changing the Animation Order 
It might take a little tweaking to get just the right sequence of actions when you 
apply more than one animation to a slide. For example, if you apply an exit effect 
to the title of a slide as the first animation, the slide will show the title and then 



the title will exit. Generally, that's not what you want to happen. You want the title 
to display for the entire duration the slide displays. Usually, exit effects are the 
last animations you want to occur. In very elaborate animations, however, you 
might have objects exiting the slide so they can be replaced by other objects. For 
example, using entrance and exit animation, you could display a different photo 
as each new bullet point on a slide displays.  

Animations perform in the order of their numbers. If you get the order of anima-
tions wrong, you can correct them by clicking the Reorder button on the Anima-
tions tab. This button displays the Custom Animation tab in the Toolbox, as 
shown in Figure 12.7. You can move animations up and down to change the  
order and fine-tune other effects as well. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 12.7 You can reorder animations or set effect options and timings on this tab. 

 
 

Deleting an Animation 
To delete an animation in the Custom Animation tab of the Toolbox, select the 
animation and click the button with the X. In the normal view, click the anima-
tion's number (displayed on the left side of the screen, as shown in Figure 12.6) 
and press Delete. Before deleting the animation in the normal view, be sure it is 
the correct animation by checking the ribbon. PowerPoint selects the animation 
on the ribbon when you select the number. 



Adding Transitions Between Slides 
A transition is an animated way to move from one slide to the next. The transition 
you select applies to the viewer's last look at the previous slide and the first look 
at the slide to which you applied the transition. For example, if you apply the Dis-
solve transition to the second slide, when you move from slide one to slide two, 
slide one appears to dissolve as slide two appears to fill in. 

Applying a Transition 
You can apply a different transition to each slide or the same transition to all the 
slides at once. I don't recommend using a different transition on each slide be-
cause it's too distracting and detracts from the information you are presenting on 
the slide. For slide shows with fewer than a dozen or so slides, I recommend you 
use the same transition throughout. For longer slide shows, I sometimes use dif-
ferent transitions for different groups of related slides. Additionally, on long slide 
shows, I like to give the audience a rest and use no transitions on slides that do 
not present a chain of information. 

You can apply a transition to one or more slides at the same time, or you can 
apply a transition that you have already applied to a slide to all the other slides in 
the presentation. 

 

SHOW ME  Media 12.3—Applying a Transition 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 
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Applying a Transition 
You can apply only one transition to a slide. If you apply a transition and then 
apply another one, you have just replaced the first one with the second one. To 
apply a transition to selected slides, follow these steps: 

1. Select the slide or select multiple slides and click the Transitions tab on the 
ribbon. 

2. Click the icon on the ribbon for the transition you want to apply (under 
Transition to This Slide). For example, click Push. 

3. Click the Effect Options button to apply different effects to the transition, as 
shown in Figure 12.8. (If the transition has no effects, this button is dim.) 

 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 

Figure 12.8 The Effect Options are different for each transition. 

 

4. Click the up or down arrows on the duration control on the ribbon to in-
crease or decrease the time it takes for the transition. 
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Adding the Same Transition to All Slides 
PowerPoint makes it easy for you to apply the same transition to all the slides in 
a presentation. Be careful if you use this technique, though, because it overrides 
any transition setting you have set previously for individual slides. To add the 
same transition to all slides, follow these steps: 

1. Apply the transition you want to use to at least one slide and select it or se-
lect a slide that already has the transition you want to use. 

2. Click the All Slides button (under Apply To) on the Transitions tab on the 
ribbon. 

 

 

 
 

 

Deleting Transitions 
To delete a transition, select the slide (or slides) and click the None button on the 
Transitions tab under Transition to This Slide. Now imagine that you have to de-
lete all the transitions that have been added to 100 slides in your presentation. 

Use the All Slides button to your benefit. Apply the same transition 
to all slides, and then go back and change the transitions for indi-
vidual slides. 



Ouch! It would be a pain to delete each one individually. To delete all slide transi-
tions at once, select a slide that has no transition applied to it and click the All 
Slides button (under Apply To) on the Transitions tab on the ribbon. Bada bing, 
bada boom! You're done! 

Adding Audio and Video 
As mentioned earlier, yawning can be a big problem for a slide show audience. 
How about adding a little music to wake up people and keep them interested? 
Video is also a good addition to a slide show because people are much more at-
tentive to video than they are to "flat graphics." 

Adding Audio to a Presentation 
You can add an audio file that plays when you click it and stops playing when 
you move to the next slide. This could be a short music clip or a recorded narra-
tion. You can insert audio from the Media Browser or from a file. To insert audio, 
click Insert on the menu bar and then click Audio, Audio from Browser, or Audio 
from File. If you select Audio from Browser, drag the audio file to the slide. If you 
select Audio from File, navigate to the file and double-click it. PowerPoint places 
a speaker icon on the slide. This is the graphic that you click to play the audio 
when you present the slide show. 

 

 

 
 

To record narration and add it to a slide, select the slide and then click Insert on 
the menu bar. Click Audio, Record Audio. Enter the name for the recording and 
specify the input device and source. Click the Record button, speak into the mi-
crophone, and click Stop when finished. Click Save, and PowerPoint inserts the 
speaker icon on the slide. 

Adding Video to a Presentation 
When you insert a video, PowerPoint automatically sets the action for a movie to 
play when you click the mouse. (See "Using Actions," earlier in this chapter.) 
When you play the slide show, you can point to the video to display controls if 
you want to pause, restart, replay, or adjust the sound for the video. 

 

If you create the presentation on one computer and then present it 
using a different computer, you could have a problem if you have 
downloaded music from iTunes to use in your presentation. If the 
presenting computer isn't authorized, you can't play the music.  
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Inserting a Video 
To insert a video, follow these steps: 

1. Add or select a slide that has a placeholder with the six buttons in the mid-
dle. Refer to Figure 12.2. 

 

 

 
 

2. Click the Insert Video button, navigate to the movie file, and double-click it, 
or you can open the Media Browser to the Movies tab and drag a movie to 
the placeholder. 

Creating and Presenting Custom Slide Shows 
Now imagine that you need to present the same slide show to three completely 
different audiences, but you need a few different slides to address the concerns 
of each audience. To make life easier, you can create the basic slide show and 
add all the slides that you will need for each audience. Then, you can create 
three custom slide shows using the "core" slides, plus the slides for each specific 
audience in each custom show. PowerPoint saves all the custom shows in the 
same file. 
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Creating a Custom Slide Show 
To create a custom slide show, first create a slide show and include all the slides 
you want to use in the different custom shows. Then follow these steps: 

You can display the Media Browser and drag a video to a slide re-
gardless of whether you drag it to a placeholder. The advantage of 
using a placeholder is that PowerPoint inserts the video at a size 
that fits nicely on the slide. 

Note that PowerPoint 2011 cannot play YouTube or Flash files. 



1. Open the PowerPoint file that contains the slide show and click Slide Show 
on the menu bar. 

2. Point to Custom Shows and click Edit Custom Shows. The Custom Shows 
dialog box opens. Click New, and the Define Custom Show dialog box 
opens, as shown in Figure 12.9. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 12.9 A custom slide show can use any number of slides that are present in 
the file. 

3. Enter a name for the custom show. 

4. Select the slides in the Slides in Presentation box that you want to include 
in the custom show and click Add. The Slides in Custom Show box displays 
the slides you added. 

5. To change the order of the slides in the Slides in Custom Show box, select 
a slide and click the up or down arrow to move the slide. 

6. To delete a slide from the custom show, select the slide in the box on the 
right and click Remove. 

7. When all slides are included and in the correct order, click OK and then 
click Close. PowerPoint adds the name of the new custom show to the 
Custom Shows menu. 

Playing a custom show is simply a matter of selecting the show from the Custom 
Shows menu. (Click Slide Show on the menu bar and click Custom Shows.) 



Polishing Your Presentation Skills 
Using PowerPoint's presentation tools, you can become the star of the show. 
You can rehearse your show and time how long it takes you to give the presenta-
tion, or you can record yourself as you make the oral part of the presentation so 
you can listen and critique yourself. Additionally, you can make notes for each 
slide as you practice, and PowerPoint will append them to any existing notes. 
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Rehearsing or Recording the Presentation 
To rehearse or record your presentation, follow these steps: 

1. Click the Slide Show tab on the ribbon. Click the Rehearse button to re-
hearse or click the Record Slide Show button to record your oral presenta-
tion. 

2. Give your oral presentation while you advance the slides. A progress bar at 
the top shows how much of the presentation you have given. The timer re-
sets after each slide so you can see how much time each slide takes. 

3. Click the Pause button if you want to stop for a while—to add some notes, 
for example. 

4. When you advance the last slide, PowerPoint asks if you want to save the 
slide timings. If you click Yes, PowerPoint saves the timings, opens the 
slide sorter view, and displays the timing for each slide under the slide 
icons. If you click No, PowerPoint exits the rehearsal mode. 

 

 

 
 

Presenting with Presenter View 
When you give your presentation, if you can attach two monitors to your Mac, 
you can use the Presenter View on one monitor while your audience sees the 
presentation in full screen on the other monitor. The Presenter View puts you in 
full control by showing you the current slide, the next slide, your elapsed time, 
and your notes, as shown in Figure 12.10. Additionally, you can take more notes 

If your presentation takes longer than the time you have allotted, be 
sure to save the timings so you can see which slides are taking the 
longest to present. 



in the Notes pane as you give the presentation. To use the Presenter View, sim-
ply click the Presenter View button on the Slide Show tab on the ribbon before 
issuing the command to play the show. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 12.10 The Presenter View gives the presenter lots of information about the 
presentation as it is being given. 

While you are presenting the show, you can use the Annotation tool to call atten-
tion to certain points on your slides. To learn more about annotating slides during 
a presentation, listen to the following audio recording. 

TELL ME MORE  Media 12.4—Annotating Slides 
Access this audio recording through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

My Top Five Tips 
I want to end this chapter with five of my favorite tips for making PowerPoint 
presentations: 

▪ Tip 1—I usually make the first slide of a presentation a welcome slide in-
stead of the title of the slide presentation. Then, I start the show before the 
crowd gets there so they can't see me start PowerPoint and load up the file. 



As people walk in, they see the welcome slide, and I leave it on the screen 
while I make my introductory remarks. When I'm ready to start the presen-
tation, I advance to the next slide, which is the title slide for the presenta-
tion. 

▪ Tip 2—I make the last slide in the show blank and leave it onscreen in-
stead of pressing Esc and showing the PowerPoint program. I usually 
make the background of this slide black or the darkest color in the theme 
I'm using. It gives the presentation a "fade to black" feel at the end. It also 
keeps the slide show running so I can go back to a previous slide if some-
one has a question. 

▪ Tip 3—For effect, I like to rotate placeholders that hold photographs. You 
can do this by dragging the green handle at the top of the placeholder. 
Sometimes I even rotate title placeholders. 

▪ Tip 4—If the presentation says it all (in other words, there is no oral pres-
entation that goes with it), I like to add background music to the presenta-
tion. Here's how to do it: First, make sure you have a music file that is long 
enough to play through the entire slide presentation. Select the slide where 
the music should start—generally the title slide. Click Slide Show on the 
menu bar and then click Action Button. Click Sound and drag a button on 
the slide. The Action Settings dialog box opens. Click the Play Sound pop-
up button. Scroll down to the last option and select Other Sound. The file 
navigation dialog box opens. (If necessary, select All Files for Enable in this 
dialog box.) Navigate to the music file and double-click it. PowerPoint ex-
ports a movie file. When the export is finished, click OK in the dialog box. 
 
When you play the slide show, click the sound button you created on the 
slide where the music should start. The music plays until it reaches the end 
of the song or until you stop the slide presentation, whichever comes first. 
You cannot stop the background music during the presentation. You also 
can create a "voice over" by adding narration to any slide. When you click 
the narration object during the presentation, it plays over the background 
music. 

▪ Tip 5—I like to repurpose all the hard work and artistic design I put into 
making a slide show by saving each slide as a .jpg file that I can use in 
other supporting documents. This is so easy to do. You just choose Save 
As and select the JPEG format. PowerPoint automatically saves each slide 
as a separate file. It names the files Slide01.jpg, Slide02.jpg, and so on. 
This works for all the graphic formats the Save As command provides 
(PNG, GIF, BMP, and TIFF). 



13 This chapter introduces the Excel window 
and covers entering and editing data, 
formulas, built-in functions, and printing. 

Getting Started with Excel 
This chapter lays the foundation for working with Excel workbooks by defining 
worksheet terms, explaining the types of data you can enter, and discussing for-
mulas and functions. It covers how to enter data, move around, select cells, copy 
and cut cells, and use relative and absolute cell addresses in formulas. It con-
cludes with information about how to set up a worksheet for printing. 

Exploring the Window 
When you start Excel, the Excel Workbook Gallery, shown in Figure 13.1, opens 
by default. (You can turn off this feature by clicking Don't Show This When Open-
ing Excel.) In this window, you can select a template for the type of workbook 
you want to create. Excel has templates in the following categories: Time Man-
agement, Business Essentials, Personal Finance, Business Finance, and Graph 
Paper. Most of the templates have sample data in them that you can replace with 
your own data. Additionally, templates are available online. 

To select a template, click the category in the left pane, select the template in the 
middle pane, and click Choose. The template called Excel Workbook is a basic, 
blank workbook. Figure 13.2 shows what it looks like. In the figure, you can see 
that the Excel window has the menu bar at the top, then the title bar, a toolbar 
under the title bar, and then the ribbon. This is standard for most Office applica-
tions. 

 

 To learn more about how the ribbon works, see "Getting Familiar with the 
Ribbon" in Chapter 1, "Getting Started with Word." 

Unique to Excel is the formula bar, which is located under the ribbon. Under the 
formula bar is the heading row for the columns. Each column (there are 16,384 
of them) is named with letters. Along the left side of the window is a column of 
numbers that identifies each row, all 1,048,576 of them. On the right side of the 
window is the vertical scrollbar. The large area that looks like a grid contains the 
cells where you enter your data. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 

Figure 13.1 Use the Excel Workbook Gallery to select a template that meets your 
needs. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 13.2 This blank worksheet template enables you to start using Excel quickly. 



The two buttons under the row numbers on the left side of the screen toggle the 
view from normal view to page layout view. To the right of the view buttons, 
above the status bar, you can see controls for navigating through multiple sheets 
(these controls are dimmed in the figure because the workbook has only one 
sheet). Next to the sheet navigation controls is the tab for the sheet. The default 
number of sheets in a new workbook is one, but you can have as many sheets 
as your Mac's memory will allow. Next to the sheet tab is the Insert Sheet button 
(used for adding more sheets), and beside that is the horizontal scrollbar. The 
status bar at the bottom currently displays the view (Normal View), the mode 
(Ready), and the sum of all selected cells. (Only cell A1 is selected, and because 
it has no content, the sum equals zero.) 

Because there is so much going on in the Excel window, I've recorded a video 
tour for you that points out the features of the window. 

 

SHOW ME  Media 13.1—Taking a Tour of the Excel Window 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

Entering and Editing Data in Cells 
A cell is the intersection of a row and column. The address of a cell is its column 
letter(s) followed by the row number. For example, A1 is the cell address of the 
first cell in the sheet. If you have the time to scroll all the way to the right and all 
the way down (which takes a considerable amount of time), you'll find that the 
address of the cell in the lower-right corner of the sheet is XFD1048576. 

To enter data in a sheet like the one shown in Figure 13.2, you must select a cell. 
You can click in a cell to select it or move to the cell using the keystrokes listed in 
Table 13.1. If you want to click in a cell you cannot see on the screen, use the 
vertical or horizontal scrollbars to scroll the worksheet until the cell is in view. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Note that not all keyboards have the Home, End, Pg Up, or Pg Dn 
keys, but Other keyboard combinations, usually involving the Fn 
key, perform the same functions. 



Table 13.1 Navigation Keystrokes 

To Go To  Press 

The next cell to the right Right arrow or Tab 

The next cell to the left Left arrow or Shift-Tab 

The cell directly below Down arrow or Return 

The cell directly above Up arrow or Shift-Return 

The cell in the upper-left corner Cmd-Home 

The cell in the lower-right corner* of the 
active worksheet 

Cmd-End 

Down one screen PgDn 

Up one screen PgUp 

Right one screen Alt-PgDn 

Left one screen Alt-PgUp 

* The intersection of the last column and the last row used in the worksheet is the lower-right corner of 
the worksheet.  
. 
 
 

 

 
 

When you click in a cell to select it, Excel puts a dark blue border around it. After 
you select a cell, you can start typing the data. The data appears in the formula 
bar as you type. When you finish typing, press Return to enter the data and 
move down a cell. Alternatively, instead of pressing Return, you can press Tab to 
enter the data and move to the cell to the right or press the up, left, or right arrow 
to enter the data and move in the corresponding direction. If you make a mistake 
while typing data, press Backspace to erase the character to the left and retype 
the text before you press a key that enters the data. If you change your mind 
completely, press Esc before pressing a key that enters the data. 

If the data you enter is too wide to fit in a cell, one of several things can happen, 
depending on what type of data you enter: 

▪ If the data is text, Excel lets the text use the space of the cells to the right. 
Note, however, that Excel does not actually put the spillover text into the 
adjoining cells. If you enter text in the adjoining cell (or if the adjoining cell 
already has text in it), Excel truncates the text in the cell to the left. 

To enter data in multiple rows very easily, type data in the first cell 
in the row and press Tab to go to the next cell. Repeat until you 
reach the last cell in the row you want to use. Press Return to go to 
the cell in the next row that is directly under the first cell in which 
you entered data on the row above. 



 

▪ If the data is a date or time, Excel fills the cell with pound signs (#). 

▪ If the data is a number, Excel widens the column slightly if the number is 
not too long. If the number is too long, it fills the cell with pound signs (#) or 
converts it to scientific notation, depending on the number format in use. 

 
 
 
 
 
 
 
 

If a cell is not wide enough to display the data, you can fix the problem in several 
different ways. You can widen the column or reduce the font size. If the data is 
text, you can wrap it or start a new line in the cell. 

 

 To learn more about number formats and the methods for fixing data that 
doesn't fit in a cell, see Chapter 14, "Enhancing Worksheets." 

Editing Data 
To edit the data in a cell, select the cell and then click within the text in the for-
mula bar to delete or insert more text. Double-clicking in a cell enables you to 
edit the data directly in the cell. 

Deleting Data 
If you have entered data, and you want to erase it, select the cells containing the 
data and press Delete (see Table 13.2). Note that the Delete key deletes the 
data in the cells, not the cells themselves. 

 
 
 
 
 
 
 
 
 
 
 

Table 13.2 Methods for Selecting Cells 

Cells to Select Method 

Single cell Click the cell. 

Block of cells (also known as a 
range) 

Drag through the block or click one corner of the 
block and Shift-click the opposite corner of the block. 

Noncontiguous group of cells Cmd-click each individual cell and Cmd-drag through 
blocks you want to add to the selected cells. 

A row of cells Click the row heading. 

Adjacent rows Drag through the row headings. 

Scientific notation is a number format used for very large or very 
small numbers such as a trillion or a trillionth. The scientific notation 
for one trillion is 1.0E+12, which means one times 10 to the 12th 
power. 



A column of cells Click the column heading. 

Adjacent columns Drag through column headings. 

Noncontiguous rows Cmd-click each row heading and Cmd-drag through 
adjacent row headings to add to the selected rows.  

Noncontiguous columns Cmd-click each column heading and Cmd-drag 
through adjacent column headings to add to the se-
lected columns. 

. 

Copying, Cutting, and Pasting Cells 
Often it is a convenience to copy cells and paste them in another location. For 
example, if you have typed the names of 12 cities, and you want to create an-
other area that contains the same city names, you can copy the names to the 
new area. 

To copy, select the cells (refer to Table 13.2) and press Cmd-C. To paste the 
cells in the new location, click the cell in the upper-left corner of the new location 
and press Cmd-V. If the new location already has data in it, Excel overwrites the 
data with no warning, so be careful. 

 

 

 
 

 

If the cells you are copying and pasting contain formulas, things can get dicey. 
The results you get when you paste the formulas in the new locations might be 
incorrect. See "Copying Formulas" later in this chapter to find out why. 

Enlisting Excel's Help Entering Data 
If you type Monthly Income in a cell, the next time you start typing Mon… in the 
same column, Excel shows "Monthly Income" in a pop-up. If that is the text you 
intend to type, you can just quit typing and press Return. This is Excel's way of 
helping you with its feature called AutoComplete. If your intent is to type Monthly 
Outgo, you can just ignore the pop-up and keep typing. The next time you type 
Monthly in the same column, Excel lists both choices in the pop-up. You can use 
the arrow keys to select one and press Return. 

 

 

Using practically the same method, you can cut and paste cells. In-
stead of pressing Cmd-C for copy, press Cmd-X for cut. When you 
cut cells, the data is cut, not the cells themselves. Pasting cut cells 
also overwrites existing data, if any, in the new location.  



 

 
 

Another way Excel can help you enter data is to complete a series for you. If you 
enter a recognizable series in a row or column, such as 20, 30, 40 or Jan, Feb, 
Mar or Week 1, Week 2, Week 3, and so on, Excel can complete the series for 
you. Enter enough data for Excel to recognize the pattern (usually two cells is 
enough). Select the cells and point to the fill handle on the lower-right corner of 
the last cell in the selection. When the pointer changes to a black plus, drag the 
handle down (for a column) or to the right (for a row) to fill the number of cells 
you need. I love this feature! What a time-saver! 

 

 

 
 

Entering Comments 
In addition to the text you enter in cells, you also can enter comments. Com-
ments are attached to a cell; they do not appear in a cell. If a cell has a com-
ment, it has a red triangle in the upper-right corner. Mousing over a cell with a 
comment displays the comment. To insert a comment, click the New button on 
the Review tab on the ribbon and type your comment. Click anywhere outside 
the comment to close it. To delete a comment, select the cell with the comment 
and click the Delete button on the Review tab. 

 

 To learn more about reviewing comments, see "Reviewing Worksheet 
Comments" in Chapter 16, "Using Review Features." 

Working with Formulas 
The primary purpose of a worksheet is to perform calculations for you. Of course, 
you have to enter the numbers and the correct formulas. If you change the num-
bers that are referenced by a formula, Excel recalculates the formula for you.  

A formula is a mathematical statement that requires a calculation to produce a 
result. For example, when the teacher asks the first grader, "What is two plus 

If you select only one cell and drag the fill handle, Excel copies the 
data in the cell instead of filling in a series, but you can click the 
AutoFill Options pop-up button and select Fill Series. Excel then 
creates a series with an increment of one.  

Excel does not give you AutoComplete choices when you are typing 
the same data across a row. 



three?" the question itself is a formula. When the first grader says, "Five," the 
student has performed a calculation that produces the answer. If the teacher 
writes the formula on the board, she writes "2 + 3." She uses numbers and an 
arithmetic operator. The operator describes the type of calculation that must be 
performed on the numbers—addition, in this example. Other arithmetic operators 
include – (subtraction), * (multiplication), / (division), % (percent), and ^ (expo-
nentiation). 

 

 

 
 

Constructing a Formula 
When you enter a formula in a cell, you enter it much the same way you would 
write the formula on the board, but you must begin with the equal sign. This tells 
Excel the data is going to be a formula. When you enter the formula, Excel  
doesn't display the formula in the cell like text; it always displays the answer to 
the formula. So, continuing the preceding example, you can enter =2+3, and Ex-
cel will display the number 5 in the cell, as shown in Figure 13.3. (Notice the for-
mula does not have spaces in it.) 

It's really a waste of effort to enter the formula as =2+3 because you might have 
to change one or both of the numbers in cells B1 and B2. If you have to change 
the numbers in the cells to 4 and 5, for example, your formula will not give the 
answer you are looking for. It will still add 2 and 3. To remedy this situation, you 
should enter the formula using the cell addresses of the numbers. Now, the for-
mula would look like this: =B1+B2. If the numbers in the cells change, the for-
mula automatically recalculates to give the correct answer. 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You don't have to capitalize the cell addresses, but Excel always 
displays them with capital letters. 

Exponentiation multiplies a number by itself as many times as the 
number of the exponent. Two raised to the fourth power (2^4) is two 
times two times two times two, which results in 16. 



 
 
 
 
 
 
 
 
 
 

 

Figure 13.3 The formula shows in the formula bar but the answer shows in the cell. 

 

 

Understanding the Order of Precedence 
Are you smarter than a fifth grader? Examine a formula that uses more than one 
operator and find out. So far, you've been looking at a formula that uses only the 
plus operator (+) to add numbers. What if the teacher asks, "What is 5 + 2, times 
3?" You can tell by the teacher's intonation, the slight pause after she says 5 + 2, 
that she wants you to add 5 and 2 and then multiply that result by 3. You know 
the answer is 21! Congratulations! That's right, but you still don't know if you are 
smarter than a fifth grader. Look at the numbers in Figure 13.4. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 13.4 What formula will you enter in cell C3 to add A1 and B1 and multiply the 
result by C1? 

 
 
 
 
 

Think about the formula you would enter in cell C3 to get the answer to the 
teacher's question. If you enter =A1+B1*C1, Excel calculates the answer, and 



the answer is … 30! What happened? Because Excel never makes a mistake, 
the problem must be that the formula is incorrect.  

Here's the problem. You calculated the formula correctly in your head because 
you interpreted the intonation of the teacher. When you entered the formula, you 
failed to communicate that intonation to Excel. To communicate the fact that you 
want Excel to add the first two numbers before it multiplies by 3, you enter the 
formula using parentheses, like this: =(A1+B1)*C1. 

If you do not use parentheses in this formula, Excel is forced to calculate the 
formula based on an immutable law of mathematics called the order of prece-
dence. The order of precedence mandates that certain operations must be per-
formed before others. Here's the order for arithmetic operations: Parentheses 
(working from the inside out if there are parentheses within parentheses), expo-
nentiation, multiplication or division (proceeding from left to right if both are pre-
sent), and finally addition or subtraction (proceeding from left to right if both are 
present). A pneumonic for the order of precedence is "Please excuse my dear 
Aunt Sally." 

To understand order of precedence better, study the following example showing 
how a formula with several operations in it is calculated. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Order of Precedence Explanation 

(10 – (2 + 3 * 2)/2)^2 + 10^3 The formula to calculate. 

(10–(2+6)/2)^2+10^3 The inside parentheses are calculated first, but multipli-
cation takes precedence over addition, so 3 is multiplied 
by 2. 

(10–8/2)^2+10^3 The single operation in the inside parentheses is calcu-
lated, resulting in 8. 

(10–4)^2+10^3 One set of parentheses is left, and it must be calculated 
next, but it has two operations in it. Division takes 
precedence over subtraction, so 8 is divided by 2 with 
the result of 4. 

6^2+10^3 The operation in the parentheses is calculated and  
results in 6. 

36+1,000 Exponentiation has a higher precedence than addition, 
so the formula multiplies 6 times 6 and multiplies 10 
times 10 times 10 for a result of 1,000.  

1,036 The final answer. 
. 



Using a Function 
Now go back for a moment to the first grade teacher who might ask, "What is 1 + 
2 + 3 + 4?" In Excel, you could enter the formula as =A1+A2+A3+A4. What if the 
formula had to add a hundred numbers? Yikes! This is where functions come in. 
In this example, you would use the SUM function. 

A function is a built-in formula—one Excel includes in the application—that per-
forms a more complex calculation based on the arguments you supply. A func-
tion does not use spaces, and it follows this format: 

=FUNCTION_NAME(argument,argument,argument…) 

The format for the SUM function is 

=SUM(number1,number2,number3…) 

If a function uses the arguments number1,number2,number3, you don't have to 
list each number. You have some options. One option is to specify a range as 
the argument. A range is a rectangular block of cells. Figure 13.5 shows how  
Excel denotes a range in the function =SUM(A1:A18). It lists the first cell in the 
range followed by a colon and then the last cell in the range. (It could also be the 
last cell, a colon, and the first cell.) 

Another option is to specify an entire column or an entire row as the argument, 
as shown in Figure 13.6. Excel is smart enough to ignore blank cells and to dis-
regard all data in the column or row that is not a number. The function is 
=SUM(3:3). 

Another option is to use a combination of arguments, as shown in Figure 13.7. 
This function adds the numbers in the range A1:A3 to the number in cell C1 and 
then adds a constant. 

 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

A good way to learn about the built-in functions is to open the For-
mula Builder. Click the Fx in the formula bar, or click View on the 
menu bar and click Formula Builder. The Formula Builder lists all 
the built-in functions by category and describes each one. 



 
 
 
 
 
 
 
 
 
 

 

Figure 13.5 The function shows the range of cells from A1 to A18 as A1:A18. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 13.6 The function adds all the numbers in row 3 and ignores the blank cells 
and cells that contain text. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 13.7 This function use a range, cell address, and a constant as arguments. 

 



Entering a Formula or Function 
Excel provides several ways to enter formulas and functions in a cell: 

▪ Typing—If you type a formula or function directly into a cell, you have to 
know all the cell addresses and type them correctly. This is the easiest way 
to make mistakes, and I don't recommend it. 

▪ Pointing—With this method, you point to the cell addresses and ranges 
and type everything else, such as the name of the function or the operation 
signs. This is the method I recommend. 

▪ Using the Formula Builder—If you double-click a function name in the 
Formula Builder, it helps you build the function. It lists the arguments you 
need and enables you to supply the arguments by typing or clicking a cell 
or range of cells. As you build the function, it displays the result below the 
list of arguments. After you have supplied all the arguments and the result 
looks correct, you can press Return to enter the function in the cell. If you 
already know how to use the function you are entering, this method just 
takes longer. 

 

SHOW ME  Media 13.2—Entering a Formula with the Pointing 
Method 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

  
 
 
 
 
 

LET ME TRY IT 

Entering a Formula with the Pointing Method 
To understand the steps to enter a formula or a function by pointing, think about 
entering the formula =A1*B1+SUM(C1:C10), and follow these steps: 

1. Click in the cell where the result of the formula should display and type an 
equal sign. 

2. Click cell A1. Excel goes into the Point mode (see the indicator in Figure 
13.8) and inserts the address in the formula. 

3. Type an asterisk. Now you are back to Enter mode. 

4. Click cell B1 and type +sum(. 

5. Drag through the range from C1 to C10. 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 13.8 The mode indicator in the status bar displays "Point." 

 

6. Type ) and press Return. 
 

 

 
 

Copying Formulas 
Earlier in the chapter, I warned you that copying cells with formulas could result 
in incorrect formulas in the new locations. The reason is that when you copy and 
paste a formula, Excel rewrites the formula if it contains relative cell references. 
All the formulas and functions discussed so far have used relative cell refer-
ences. 

A relative cell reference is a cell address Excel evaluates in terms of its location 
relative to the location of the formula that references it. Consider the formula 
=A1+A2 entered in cell A3. The position of A1 relative to A3 is that A1 is in the 
same column as A3, and it is two rows above A3. The relationship of A2 to A3 is 
that A2 is in the same column and one row above A3. So for this example, the 

My guess is that the =SUM function is one of the functions used 
most often. Why else would Microsoft give this function its very 
own button on the toolbar and in the Formulas tab? It's the button 
that looks like a capital E. To use the AutoSum button, click in the 
cell where you would normally enter the SUM function (at the bot-
tom of a column of numbers, for example) and then click the Auto-
Sum button. Excel creates the function complete with range, and 
all you have to do is press Return. 



true meaning of the formula =A1+A2 is NOT "add the value in A1 to the value in 
A2," but "add the value in the cell two rows above the formula to the value in the 
cell one row above the formula." If you copy the formula in A3 to B3, Excel 
changes the formula to =B1+B2 because B1 and B2 are the cells in the same 
column as the formula and they are located two rows above and one row above 
the formula. If you copy the formula in A3 to P6, Excel changes the formula to 
=P4+P5. 

In most cases, the change Excel makes when you copy a formula is just what 
you want. For example, if you have 12 columns with 15 numbers in each column, 
and you want to total each column, you can enter the SUM function under the 
first column and copy it to the other 11 columns. Excel copies the formula and 
changes the cell addresses for each column because it realizes that the true 
meaning of the function in the first column is "total the 15 cells directly above 
me." 

 
 
 
 
 
 
 
 
 
 

SHOW ME  Media 13.3—Copying Formulas with Relative Cell  
References 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

In some cases, however, you want the formula always to refer to a specific cell if 
it is copied. For this you must use an absolute cell reference. An absolute refer-
ence for a cell is written with dollar signs, as in $A$1. Figure 13.9 shows an ex-
ample of a formula in cell C2 that multiplies a relative cell address by an absolute 
cell address (=B2*$E$2). The true meaning of the formula is "multiply the value 
in the cell one column to the left times the value in cell E2." If you copy the for-
mula down the column, it will yield the correct results. 

TELL ME MORE  Media 13.4—Using Absolute Cell References 
Access this audio recording through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 

 

Figure 13.9 The absolute address ensures that the formula will always multiply by the 
value in cell E2 no matter where it is copied. 

 

Correcting Formula Errors 
Excel has several ways to inform you when you have or might have made an er-
ror in a formula. If you enter something Excel does not understand or accept in a 
formula, you might see #NAME? or #VALUE! or #DIV/0! in the cell. Additionally, 
you can look for errors by running the Error Checking tool (Tools, Error Check-
ing). 

If you see the name error, it means the formula contains unrecognized text. You 
may have typed the function name incorrectly or typed a cell address as 1 in-
stead of A1. 

If you see the value error, it means one of the cells referenced in the formula 
contains text instead of a value. Functions generally do not result in the value er-
ror because they can evaluate a cell and ignore it if it contains text. Value errors 
generally come from formulas that use the arithmetic operators (+, -, *, /). 

The #DIV/0! error means the formula is dividing by zero—a mathematical impos-
sibility! This error often occurs when you have copied a formula containing a divi-
sion by a cell with a relative reference. After the formula is copied to the new 
location, the rewritten cell address results in a division by an empty cell or a cell 
with text in it, both of which evaluate to zero. 

To check for errors, click the Check for Errors button on the Formulas tab on the 
ribbon. This tool not only points out errors, but also tells you if it finds a formula 



that is inconsistent with the other formulas in its area. For example, if all the for-
mulas in the row compute the sum of the 20 cells above, but one of the formulas 
computes the sum of only 19 cells above, Excel brings this formula to your atten-
tion as being inconsistent. 

Printing a Worksheet 
Some worksheets are never meant to be printed. If yours is, I suggest you set up 
the page options (orientation, size, margins, and so on) before you start entering 
the data. Additionally, you might want to work in page layout view so you can see 
exactly what will print on the page. 

Setting the Page Layout and Print Options 
To set up the page, you can click the Layout tab on the ribbon and then click 
each of the first three buttons under Page Setup (Orientation, Size, and Margins) 
to set the options you want. Then you can use the buttons and controls under 
Print (in the same tab) to set their options. 

One quick way to set all the options at once is to open the Page Setup dialog 
box by clicking File on the menu bar and clicking Page Setup. The dialog box, 
shown in Figure 13.10, has all the options that appear on the Layout tab on the 
ribbon and then some. This section looks at setting the options on each tab of 
the dialog box. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 13.10 The Page Setup dialog box has four tabs that contain all the options 
needed for setting up and printing a worksheet. 

  



LET ME TRY IT 

Setting Page Options in the Page Setup Dialog Box 
To set the Page options, open the Page Setup dialog box (File, Page Setup), 
click the Page tab if necessary, and follow these steps: 

1. Select Portrait or Landscape for the Orientation. 

2. Click Options, specify the paper size, and click OK. 

3. Select a different scaling percentage if you want the data to print larger or 
smaller than its normal size (100%). Decreasing the percent allows Excel to 
print more columns and rows per page. Increasing the percent causes  
Excel to print fewer columns and rows per page. 

4. If you want the data to fit on fewer pages, select the Fit To option and spec-
ify the number of pages wide by the number of pages tall. For example, if 
you select Fit to 1 Page Wide by 1 Tall, Excel reduces the scaling percent 
to whatever is necessary to fit the print range on the page. 

5. If you have multiple pages and you want the first page to start with a num-
ber other than one, enter the number for First Page Number. Note that you 
must physically insert the page number in the header or footer to print. 
(See the "Setting Header/Footer Options in the Page Setup Dialog Box" 
section later in this chapter.) 

6. Select a print quality and click OK. 
  

LET ME TRY IT 

Setting Margins Options in the Page Setup Dialog Box 
To set the Margins options, open the Page Setup dialog box (File, Page Setup), 
click the Margins tab if necessary, and then follow these steps: 

1. Specify the values for Top, Left, Right, and Bottom. 

2. Specify the values for the Header and the Footer. 

3. Click Horizontally or Vertically or both to center the data on the page. (This 
is a bonus option you don't get on the ribbon.) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  



LET ME TRY IT 

Setting Header/Footer Options in the Page Setup Dialog Box 
To set the Header/Footer options, open the Page Setup dialog box (File, Page 
Setup) and click the Header/Footer tab if necessary. Click the pop-up buttons 
under Header and Footer, select one of the default text offerings, and click OK. If 
none of the default selections suits your needs, follow these steps: 

1. Click Customize Header. The Header dialog box shown in Figure 13.11 
opens. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 13.11 The Header dialog box has its own toolbar you can use to insert various 
elements in a header. 

 
 

2. Click in the section where you want to enter text and type the text, or use 
the buttons in the dialog box to insert various items. You can insert the 
page number, the number of pages, the date, the time, a picture, and so 
on. 

3. To format the text, select it and click the Format Text button in the dialog 
box. The Font dialog box opens. Select the options you want and click OK. 

4. Click Customize Footer. The Footer dialog box opens; it is identical to the 
Header dialog box. Follow the instructions in steps 2 and 3 to complete the 
Footer. 

5. Click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  



LET ME TRY IT 

Setting Sheet Options in the Page Setup Dialog Box 
To set the Sheet options, open the Page Setup dialog box (File, Page Setup), 
click the Sheet tab if necessary, and then follow these steps: 

1. To print the same rows at the top on every page that prints, click the button 
at the right end of the Rows to Repeat at Top text box. Select the cells that 
contain the rows you want to print and click the button at the end of the 
box. 

2. To print the same columns on the left side on every page that prints, click 
the button at the right end of the Columns to Repeat text box. Select the 
cells that contain the columns you want to print and click the button at the 
end of the box. 

3. Click the button at the right end of the Print Area box. Select the cells you 
want to print and click the button at the end of the box. 

4. In the Print area, click the other elements you want to print, such as Grid-
lines or Row and Column Headings (the numbers and letters that identify 
the rows and columns). 

5. If you want to print in black and white only, click Black and White. 

6. If you want to print in draft quality, click Draft Quality. 

7. If you have comments in the spreadsheet, click the Comments pop-up but-
ton and select a location where you want them to print. 

8. In Print Order, select either Down, Then Over or Over, Then Down. 

9. Click OK. 
 

 

 
 

Previewing the Sheet Before Printing 
If you have set all the Page Setup options, you are ready to send the data to 
print. Before doing so, you might want to get a quick preview by clicking the Pre-
view button under Print on the Layout tab on the ribbon. The Mac Preview  

You also can quickly set a print area by using a menu command. 
Select the cells you want to print, and click File in the menu bar. 
Then click Print Area, Set Print Area. 



application opens and displays the sheet as a .pdf file. You can use the Next and 
Previous button to go from page to page and use the Zoom buttons to zoom in or 
out on the data. When you are finished previewing the document, click the Close 
button in Preview. 

The only problem you might have now is where the pages break. If you are work-
ing in page layout view, you can see where the pages will break ahead of time 
and adjust them accordingly. If you haven't done that, you should adjust them 
now, before you send the data to print. To insert a page break, click anywhere on 
the row that should start the next page and click the Breaks button on the Layout 
tab. Click Insert Page Break. 

Sending the Sheet to Print 
Finally, you are ready to actually print! Click File on the menu bar and click Print. 
The standard Print dialog box opens. Select your printer, the pages you want to 
print, the number of copies, and so on. When you're ready for liftoff, click Print! 



14 Formatting a spreadsheet and adding 
graphics and charts are the topics of this 
chapter. 

Enhancing Worksheets 
After explaining just the bare basics in Chapter 13, "Getting Started with Excel," 
this chapter covers numerous features and operations that enhance the struc-
ture, format, and usefulness of a worksheet. It shows you how to change the col-
umn widths and row heights; insert, delete, hide, and unhide cells, columns, and 
rows; format text and numbers; edit and create Excel styles; work efficiently in 
very large spreadsheets by freezing and splitting panes; and create charts, spar-
klines, and SmartArt. 

Configuring the Worksheet for Your Data 
In a new, blank worksheet, all the columns are the same width, and all the rows 
are the same height. This is generally not the best configuration for your data. 
When you're entering data in a worksheet, it is quite common to 

▪ Change column width 

▪ Change row height 

▪ Merge cells 

▪ Insert and delete columns and rows 

▪ Insert and delete cells 

▪ Hide columns and rows 

Changing the Column Width 
Notice that column C in Figure 14.1 is much wider than the default width of a col-
umn. If you know you will need a wider column, you can type the text in the col-
umn first and then adjust the width, or you can take an educated guess and 
widen the column before you start entering the data. If you guess wrong, it's a 
simple matter to adjust the width again. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 

 

Figure 14.1 This worksheet has a typical configuration. 

 

To widen a column, point to the separator on the right side of the column heading 
(where it says A, B, C, and so on). When the pointer changes to a double-
headed arrow, drag the separator to the right. Similarly, you can make a column 
narrower by dragging the separator to the left. To change the width of several 
columns at the same time, select the columns first and then drag the right-side 
separator of any column. 

 

 To learn more about how to select columns, see Table 13.2, "Methods for 
Selecting Cells," in Chapter 13, "Getting Started with Excel." 

Another way to adjust the column width is to use AutoFit, a tool that adjusts the 
width to accommodate the length of the longest text in the column. To use Auto-
Fit, select the column or columns, and double-click the right heading separator. 
(The menu command for this feature is Format, Column, AutoFit Selection.) 

It's important to know that all cells in a column (all the way down to the last row in 
the worksheet) are the same width. You cannot change the width of selected 
cells in a column. 



Changing the Row Height 
In Figure 14.1, you can see that the second row is taller than the other rows. This 
creates some space under the title in row 1. 

To increase the height of a row, select the row (or rows) and point to the bottom 
separator in the row headings (1, 2, 3, and so on) on the far left. When the point-
er turns to a double-headed arrow, drag the separator down. Of course, you can 
make a row shorter by dragging the separator up. 

Unlike columns, rows have a kind of built-in AutoFit. They automatically adjust to 
fit the height of the tallest data in the row. Nevertheless, Excel also has an actual 
AutoFit command for rows. You might use the AutoFit command in this situation: 
Say you increase the row height and then decide you want it to be the normal 
height again. You can return the row height to the original by double-clicking the 
bottom separator for the row heading. (The menu command for this is Format, 
Row, AutoFit.) 

 

 

 
 

Merging and Centering Cells 
Notice in the sample worksheet in Figure 14.1 that the title "Start Date" is in a cell 
that spans the width of three columns. Notice also that the text in this cell is cen-
tered. To achieve this effect, select the cells in a row; then click the Merge button 
on the Home tab on the ribbon. If you want to merge the cells but keep the text 
aligned on the left, you can click the Merge pop-up button and click Merge 
Across. To undo the merge, click the Merge button again. 

 

 

 
 

If you merge cells that already have data in them, Excel keeps only the data in 
the upper leftmost cell, but it warns you about this so you can cancel the opera-
tion if necessary. Then before merging, you can copy or enter the data you want 
in the upper leftmost cell. If you make the mistake of merging cells and losing 
data, click the Undo button in the toolbar twice.  

You also can merge blocks of cells. 

The default minimum height of a row accommodates a font size of 
12 points. The built-in AutoFit does not automatically adjust to sizes 
smaller than 12 points. 



Inserting and Deleting Columns and Rows 
Often it is necessary to insert additional columns or rows between existing data. 
To insert a column, click the column heading for the column that should be to the 
right of the new column. Click the Insert button under Cells on the Home tab on 
the ribbon. To insert more than one column at a time, select the same number of 
columns that you want to insert, again selecting the columns to the right of the 
place where the new columns will be inserted, and click the Insert button on the 
Home tab. 

Inserting rows follows the same procedure, but you select the row or rows that 
should be under the new row(s) and then click the Insert button on the Home tab. 
The Insert button knows what to insert, either columns or rows, based on what 
you have selected. 

To delete columns or rows, select the columns or rows and click the Delete but-
ton under Cells on the Home tab on the ribbon. Note that this button deletes the 
actual cells and the data in the cells, not just the data in the cells. 

Also note that when you insert or delete a row or column, an entire row and en-
tire column are inserted or deleted. This change has ramifications if you have a 
large worksheet with other areas of data you can't see on the screen. Inserting or 
deleting a column or row could adversely affect these areas as well as formulas 
that might reference deleted data. 

Inserting and Deleting Cells 
If inserting or deleting a column or row causes a problem with data in other areas 
of the worksheet, your best bet is to insert or delete just the cells you need in the 
one area. 

 

SHOW ME  Media 14.1—Inserting Cells 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

  

LET ME TRY IT 

Inserting Cells 
To insert cells, follow these steps: 

1. Select the cells that occupy the area where you want to insert blank cells. 



2. Click the Insert pop-up button under Cells on the Home tab on the ribbon 
and click Insert Cells to open the dialog box shown in Figure 14.2. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 14.2 When you insert cells, existing cells must shift to make room for them. 

 
 
 

 

 
 

3. Select an option for where Excel should move the adjacent cells and click 
OK. 

 

 

 
 

 
  

LET ME TRY IT 

Deleting Cells 
To delete cells, follow these steps: 

1. Select the cells you want to delete. 

You also can use the Insert pop-up button to insert cells that you 
have copied or cut from some other location. As you know, if you 
paste to cells that already contain data, Excel overwrites the data in 
the cells. 

Note that at lower screen resolutions, the Insert, Delete, and Format 
buttons are combined into one button called Actions. 



2. Click the Delete pop-up button under Cells on the Home tab on the ribbon 
and click Delete Cells. 

3. Select a shift direction and click OK. 

Hiding and Unhiding Columns and Rows 
Sometimes you have columns or rows of data that are necessary, but they do not 
need to display at a particular time. For example, you might have a column in the 
worksheet with constant values in it that you use in certain formulas. When pre-
senting the worksheet onscreen or printing the worksheet, you don't want this 
"behind the scenes" data to show, so you hide it. Notice that column H is hidden 
in Figure 14.1. Excel changes the column headings on either side of a hidden 
column to bright blue to alert you that a column is hidden. 

To hide a column or multiple columns, select the columns, right-click the header, 
and click Hide. To unhide a column, select the two columns on either side of the 
hidden column, right-click the columns, and click Unhide. 

Formatting 
By default, a new blank worksheet uses the font called Calibri at a font size of 12 
points. The alignment is left justified in the cell for text and right justified for num-
bers. Data of any type aligns vertically to the bottom of the cell and uses land-
scape orientation. To override these default settings, you can apply different 
formatting options. 

By default, when you copy a cell that has formatting, Excel also copies the for-
matting and applies it to the cell where you paste it. If you want Excel to do 
something different, you can choose Paste Special from the Edit menu. Addition-
ally, when you insert a row, the cells in the new row take on the formats of the 
cells above them. 

Formatting the Font 
To format the font data uses, select the cells and use the buttons under Font on 
the Home tab on the ribbon, as shown in Figure 14.3. You can change the font 
style or size; apply bold, italic, or underline; change the font color; and so on. 

 

 

 

To specify the font used in the entire worksheet, select all the cells 
in the worksheet by clicking the button above the row numbers (to 
the left of the column headings). 



 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 14.3 Use the Font button on the ribbon to apply formatting to data. 

 
 

Changing the Alignment 
To change the alignment of data, use one of the six alignment buttons under 
Alignment on the Home tab on the ribbon, as shown in Figure 14.4. The three 
buttons on the top row align the text vertically in the cell, and the three buttons on 
the second row align the text horizontally. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 14.4 Some buttons in the Alignment section apply only to cells that contain 
text. 

Changing the Orientation 
The Orientation button under Alignment (refer to Figure 14.4) enables you to as-
sign the different orientations shown in Figure 14.5. You might want to use a dif-
ferent orientation for the text in the cells of a title row.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 14.5 Applying orientation options to a cell causes the size of the row where 
the cell is located to change. 



 

Wrapping Text in a Cell 
As you know, you can type text that is too long for a cell, and Excel allows it to 
"hang over" into the adjacent cell(s). If the adjacent cells have data in them, Ex-
cel truncates the text. Excel doesn't delete the excess text; it merely displays on-
ly the text that will fit in the true width of the cell. To display all the text in a cell, 
you can apply the text wrapping format to the cell by clicking the Wrap Text but-
ton on the Home tab on the ribbon. 

 

 

 
 

Alternatively, you can shrink text to fit in a cell by clicking the Wrap Text button 
and clicking Shrink Text to Fit. Of course, you can make the text so small that it's 
difficult to read using this method. 

Using Number Formats 
When you enter a number in a cell, Excel uses an internal algorithm to automati-
cally apply a format to a cell. Study the examples given in Table 14.1 to better 
understand the number formats that Excel automatically applies to the data you 
enter. 

 
 
 
 
 
 
 
 
 
 
 

Table 14.1 Default Number Formats 
 
If You Enter  

Excel Automatically  
Applies This Format  

And Displays the Number in the Cell 
Like This 

1 General 1 

1.1 General 1.1 

.0015 General .0015 

.00000000000000015 General 1.5E-16 

12000 General 12000 

12,000 Number 12,000 

1/2 Date 2-Jan 

0 1/2 Fraction 1/2 

12% Number .12 

Instead of allowing text to wrap automatically, you can break the 
text manually. As you are entering the data, press Control-Opt-
Return at the point where you want the text to break. 



$100 Currency $100 

$1,200.00 Currency $1,200.00 

1/2/11 Date 1/2/11 

1-2-11 Date 1/2/11 

January 2 Date 2-Jan 

Jan 2 Date 2-Jan 

1:11 Time 1:11 

1:11:11 Time 1:11:11 

In addition to the six formats Excel applies by default, four other formats are 
available for your use: Accounting, Percentage, Scientific Notation, and Special 
(for things such as ZIP Codes and Social Security numbers). And, if that's not 
enough, you can create your own custom format. 

  

LET ME TRY IT 

Changing the Number Format 
If Excel applies a number format you do not want to use, you can change the 
format by following these steps: 

1. Select the cell(s). 

2. Click Format on the menu bar and click Cells. The Format Cells dialog box 
opens, as shown in Figure 14.6. Click the Number tab if necessary. 

3. Select the format you want to use from the Category list and then set the 
options for the format. All categories have options except General. See Ta-
ble 14.2 for details about each format category. 

4. Click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 14.6 You can set all formats for a cell using the Format Cells dialog box. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Table 14.2 Format Options 

Category Options Comments 

General No options Numbers appear exactly as entered 
except for very large or very small 
numbers, which display in scientific 
notation. 

Number Decimal places (specify the 
number of places you want to 
use) 

1000 Separator (,) 

Negative numbers (with a minus, 
in red, or in parentheses) 

 

Currency Decimal places (specify the 
number of places you want to 
use) 

Currency symbol (choice of 
None or multiple international 
symbols) 

Negative numbers (with a minus, 
in red, or in parentheses) 

 



Accounting Decimal places (specify the 
number of places you want to 
use) 

Currency symbol (choice of 
None or multiple international 
symbols) 

This format lines up the currency sym-
bols and the decimal points in the col-
umn. Negative values display in 
parentheses. 

Date Type (3/14/01; Wednesday, 
March 14, 2001; 3/14; 3/14/01, 
and so on) 

Location (Language) 

Calendar Type 

Excel can display dates in other lan-
guages and use different calendars if a 
location has multiple types of calen-
dars. The types vary by language.  

Time Type (1:30:55 PM, 13:30, 1:30 
PM, 1:30:55, 1:30:55 PM, 
3/14/01 1:30 PM, and so on) 

Location (Language) 

Excel can display times in different 
languages. The types vary by lan-
guage. 

Percentage Decimal places (specify the 
number of places you want to 
use) 

 

Fraction Type [Up to one digit (1/4); Up to 
two digits (21/25); Up to three 
digits (312/943); As halves (1/2); 
and so on]  

 

Scientific Decimal places (specify the 
number of places you want to 
use) 

 

Text No options When applied to a number, Excel dis-
plays the number exactly as entered 
but treats the number as text, which 
means the cell has numeric value of 
zero. 

Special Type (ZIP Code, ZIP Code + 4, 
Phone Number, Social Security 
Number, and so on) 

Location (Language) 

The types vary by language. 

Custom Create your own format Use the format codes provided to cre-
ate your own number format. 

. 

Using Styles 
In a fashion similar to Word, Excel has built-in styles you can apply to cells. To 
apply a built-in style, select the cells you want to format and click the Styles  



 

button on the Home tab on the ribbon. Figure 14.7 shows the pop-up menu with 
the built-in styles. Click the one you want to apply. 

 

 To learn more about the benefit of using styles, see "Using Styles" in 
Chapter 3, "Formatting Documents." 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 14.7 Excel provides styles for formatting cell content. 

 
 
 
 
 

If a built-in style is not exactly what you want, you can edit the style. If no built-in 
style is even close to what you need, you can create your own style. 

  

LET ME TRY IT 

Editing an Excel Style 
To edit one of the styles Excel provides for you, follow these steps: 

1. Apply the style you want to edit to a cell. Then with the cell selected, click 
Format on the menu bar and click Style. The Modify Cell Style dialog box 
opens, as shown in Figure 14.8. 

2. Click Format. The Format Cells dialog box opens. (Refer to Figure 14.6.) 

3. Click each tab and set the options you want to include in the style. 

4. When finished, click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 

 

Figure 14.8 Style properties that are set for a style are designated by a check mark  
in the Modify Cell Style dialog box. 

 

SHOW ME  Media 14.2—Creating an Excel Style 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

  

LET ME TRY IT 

Creating an Excel Style 
To create a new style of your own, follow these steps: 

1. Click the Styles pop-up button on the Home tab on the ribbon. 

2. Click New Cell Style. The New Cell Style dialog box opens. It's essentially 
the same as the Modify Cell Style dialog box shown in Figure 14.8. 

3. Type a name for your style in the Style Name box. 

4. Click Format. The Format Cells dialog box opens. (Refer to Figure 14.6.) 

5. Click each tab and set the options you want to include in the style. 

6. When finished, click OK. 

Using Conditional Formatting 
Conditional formatting is a feature that highlights cells using a background fill 
color or creates visual effects for the data with data bars, color scales, or icon 
sets. These formats make it easier to read and interpret data. To learn more 
about conditional formats, listen to the following audio recording. 



TELL ME MORE  Media 14.3—Using Conditional Formatting 
Access this audio recording through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

Working with Large Worksheets 
When a worksheet gets wider or longer than what you can see on the screen, it 
becomes difficult to work with. You find yourself scrolling back and forth or up 
and down to look at your column or row labels to make sure you are entering the 
data in the correct cell. Another difficulty is being able to see two distant ex-
tremes of the worksheet at the same time. Of course, Excel has features for 
overcoming these obstacles. 

Freezing and Unfreezing Panes 
For the problem of scrolling back and forth or up and down to look at your col-
umn or row labels, you can freeze the pane. When you freeze parts of the pane, 
you freeze rows at the top of the sheet, columns on the left of the sheet, or both 
at once. Frozen columns or rows do not scroll off the screen, and you cannot 
click in any cell in the frozen area. 

 

 

 
 

To freeze parts of the pane, first click in an appropriate cell (as explained next), 
and then click Window on the menu bar and click Freeze Panes. 

▪ To freeze rows, click in any cell in the row below the rows you want to 
freeze. 

▪ To freeze columns, click in any cell in a column to the right of the columns 
you want to freeze. 

▪ To freeze both columns and rows, click in the cell that is just below the in-
tersection of the columns and rows (the upper-left corner of the data, in 
other words). 

To unfreeze the columns or rows, click Window on the menu bar and click Un-
freeze Panes. 

You cannot freeze a column or row that is in the middle of unfrozen 
columns or rows. Excel freezes all columns to the left of the column 
you want to freeze and all rows above the row you want to freeze. 



Splitting the Pane 
Using two different methods, you can split the worksheet into two (horizontal) or 
four panes that scroll independently. If you split the window into two horizontal 
panes, each pane scrolls independently on the vertical axis. So if you have a 
worksheet with 1,000 rows in it, you could see rows 1 through 20 in the top pane 
and rows 990 though 1000 in the bottom pane. If you split the window into four 
panes, the two panes on the left scroll together horizontally, and the two panes 
on the right scroll together horizontally. On the vertical axis, the two panes at the 
top scroll together, and the two panes at the bottom scroll together. 

To split the pane into two horizontal panes, drag the split bar in the vertical 
scrollbar (see Figure 14.9). Double-click the split bar to remove the split. To split 
the worksheet vertically and horizontally into four panes, click the button shown 
in Figure 14.9 (under Window on the Layout tab on the ribbon). Drag the split to 
change the size of the panes or drag the split all the way to the top row to create 
two vertical panes. To clear the split, click the button on the Layout tab again. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 14.9 The split bar can divide the window into only two horizontal panes. 

 

Working with Charts and Graphic Elements 
Nothing makes data more understandable than a chart. You can see trends, spot 
the high and low points, see plateaus, and so on. Excel's charting function has 
always been excellent, and the ribbon puts all the charting features right at your 
fingertips. 

Unfortunately, I don't have the space in this book to devote an entire chapter to 
charts. So, to give you as much information as possible, I show you how to cre-
ate some basic charts, then tell you how I tweaked them, and finally, include a 
video that shows you how to make more modifications and enhancements to a 
chart. 



Working with Charts 
Figure 14.10 shows a 3-D, exploded pie chart positioned beside the data in the 
worksheet that it represents. The data range for the chart is A1:B6. Each piece of 
the pie represents a part of the total sales. The chart has a title at the top and a 
legend on the right. To create this chart, I selected the range A1:B6, clicked the 
Chart tab on the ribbon, clicked the Pie button, and clicked 3-D Exploded Pie. 
What could be easier? Excel intuitively knew the title was in cell B1 and the leg-
end was in the range A2:A6. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 14.10 Excel calculates the size of each piece as a percentage of the total. 

 
 
 

Figure 14.11 shows a simple line chart positioned below the data in the work-
sheet that it represents. The data range for the chart is A2:H6. Each line on the 
chart represents a data set; the data sets are in rows 3, 4, 5, and 6 of the work-
sheet. The chart has a title at the top and titles for the x- and y-axes. On the right 
is a legend that tells what color represents each data set. To create this chart, I 
selected the range A2:H6, clicked the Chart tab on the ribbon, clicked the Line 
button, and clicked the Line chart. Then I made a few enhancements. 

Here are the tweaks I made: 

▪ To add a title to the chart, I clicked the Chart Title button and clicked Title 
Above Chart. I selected the default text in the title and typed my own title. 



▪ To add a title on the y-axis (the vertical axis), I clicked the Axis Titles button 
on the Chart Layout tab and clicked Vertical Axis Title, Rotated Title. I se-
lected the default text in the title and typed my own. 

▪ To add a title on the x-axis, I clicked the Axis Titles button and clicked Hori-
zontal Axis Title, Title Below Axis. I selected the default text in the title and 
typed my own. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Figure 14.11 This line graph compares values for four sets of data. 

▪ To show vertical gridlines, I clicked the Gridlines button on the Chart Layout 
tab and clicked Vertical Gridlines, Minor Gridlines. 

▪ To make the scale on the y-axis stop at 100, instead of 120, which was the 
default, I clicked the Axes button on the Chart Layout tab and clicked Verti-
cal Axis, Axis Options. I clicked Scale, changed Maximum to 100, and 
clicked OK. 

SHOW ME  Media 14.4—Modifying and Enhancing Charts 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 



To delete a chart, select it and press Delete. 

Inserting and Deleting Sparklines 
Sparklines, new to Excel 2011 for Mac, are charts that fit in a single cell. The da-
ta for sparkline charts can be in a row or column. 

Figure 14.12 shows a worksheet that uses all three kinds of sparkline graphs: 
lines in column F, bars in row 8, and win/loss in row 23. To make the sparklines 
larger for the line graphs, I increased the row heights and made column F wider. 
I also widened columns H, I, and J so the sparkline graphs in those columns 
would be wider. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 14.12 Sparklines can show patterns that are difficult to see in raw data. 

  

LET ME TRY IT 

Inserting a Sparkline 
To create a sparkline, follow these steps: 

1. Click the Chart tab on the ribbon and click the Line, Column, or Win/Loss 
button under Insert Sparklines. The Insert Sparklines dialog box shown in 
Figure 14.13 opens. 



 

2. Type the data range for the sparkline in the first text box, or click the button 
at the end of the box and select the data range. Then, click the button to re-
turn to the dialog box. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 14.13 Clicking the buttons at the end of the text boxes takes you back into the 
worksheet where you can select a cell or range. 

3. Type the range where you want to place the sparkline graphs, or click the 
button at the end of the box and select the data range. 

4. Click OK. 

To delete sparklines, select the cells that contain them and click the Clear button 
on the Sparklines tab on the ribbon. 

Inserting and Deleting SmartArt 
Although the Excel ribbon has a tab for SmartArt, a SmartArt graphic is not 
something you will insert in a workbook very often. SmartArt is a graphic depic-
tion of a list, a process, a cycle—not a depiction of numeric data. It's not like cre-
ating a chart that actually takes it shape from the data in your worksheet. 

You might use a SmartArt graphic in a worksheet like the one shown in Figure 
14.14. This worksheet shows the results of impact tests of various cars at various 
speeds. The SmartArt simply gives a graphic depiction of the testing process. 

To insert SmartArt, click the SmartArt tab on the ribbon, click one of the buttons 
for the different types of SmartArt such as List or Process, and click the SmartArt 
style you want to insert. To delete SmartArt, select it and press Delete. 

 

 To learn more about working with SmartArt, see "Inserting and Working 
with SmartArt" in Chapter 6, "Creating Documents for Publication." 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 14.14 An example of how SmartArt might be used in a worksheet. 

 

Adding Media 
Using the Media Browser, you can add photographs, audio, video clip art, sym-
bols, or shapes to a worksheet, but you probably won't do it very much. Except 
for symbols, all items you drag from the Media Browser to the worksheet are free 
floating. When you drag a symbol to the worksheet, Excel inserts it in a cell. 

 

 To learn more about working with the Media Browser, see "Inserting Media 
from the Media Browser" in Chapter 6. 



15 This chapter shows you how to work with 
databases and multiple sheets in a 
workbook. It also covers 3D formulas.  

Working with Databases and 
Multiple Worksheets 

In this chapter, you learn about sorting and filtering databases; adding, renam-
ing, deleting, copying, moving, hiding, and unhiding worksheets; grouping work-
sheets; and entering 3D formulas in workbooks that have multiple worksheets. 

Creating a Database 
A database is really nothing more than a list, and studies have shown that mak-
ing lists is one of the main things for which people use an Excel worksheet. A da-
tabase can be a single column, but normally it has several columns, such as the 
one shown in Figure 15.1.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 15.1 The database shown here has 10 fields and more records than you can 
see on the screen. 

 



Each column in the database is a field, and each row is a record. A field is one 
specific piece of data, such as last name or part number, and a record is a set of 
all the fields that pertain to one item, such as a person's name, address, phone 
number, email address, and Social Security number. The field names appear 
above the columns of data. Excel refers to these labels as headers. 

 

 

 
 

Sorting Data 
Sorting data puts the data in a certain order, depending on the type of sort you 
perform. Essentially, all sorts are either ascending or descending. You can sort 
text from A to Z or from Z to A; numbers from highest to lowest or lowest to high-
est; and dates and times from oldest to newest or newest to oldest. 

  

LET ME TRY IT 

Sorting a Database on One Field 
To sort data on a particular column, such as by the Last Name column, follow 
these steps: 

1. Click any cell in the column of data that you want to sort by. 
 
 

 

 
 

 

2. Click the Sort pop-up button on the Standard toolbar, or press Cmd-Shift-R. 

3. Select the sort option you want to use. Excel sorts the records. 
 

If the data you want to use in Excel exists in a database applica-
tion, such as FileMaker Pro, you might be able to import it. Before 
typing it all yourself, find out whether the source can export the 
data in a form that you can import, such as comma-separated. 
FileMaker Pro is one of the applications that produces data Excel 
can import. 

If your data is arranged in a way that might cause the sort to in-
clude data that it shouldn't, select the complete range of data that 
you want to sort instead of clicking in a single cell and use a cus-
tom sort. (See "Sorting a Database on Multiple Fields" later in this 
chapter.) 



 
 

SHOW ME  Media 15.1—Sorting a Database on Multiple Fields 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

  

LET ME TRY IT 

Sorting a Database on Multiple Fields 
Sometimes you need to sort data on multiple fields. In the example in Figure 
15.1, you might want to sort by Last Name, the first level, and then First Name, 
the second level. To sort on more than one field, follow these steps: 

1. Select the range of cells you want to include in the sort. 

2. On the Standard toolbar, click the Sort pop-up button and click Custom 
Sort. The Custom Sort dialog box opens, as shown in Figure 15.2. 

3. The last sort you performed (if any) appears at the top of the box. Click the 
Remove Level button (the button with the minus) if necessary and then 
click the Add Level button (the button with the plus). 

4. Click the pop-up button under Column and select a field. Click the pop-up 
button under Order and select the order if necessary. Repeat this step for 
each level you add to the sort. 

5. Click OK. 

In addition to sorting on data values, Excel can sort on the cell color, font color, 
or cell icon. These are conditional formats you might have applied to create vis-
ual effects for your data. 

TELL ME MORE  Media 15.2—Sorting on Conditional Formatting 
Access this audio recording through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

If there is anything significant about the order in which you input 
the records in the list, you might want to include a field for number-
ing each record consecutively. Then if you sort the database, you 
can return the data to its original entry order by sorting on the re-
cord number field. 



 
 
 
 
 
 
 
 
 
 
 

 

Figure 15.2 The option My List Has Headers is selected by default. 

 

Filtering a Database 
Filtering your data is a method of specifying criteria so that only the records that 
meet the criteria display in the sheet. When you filter data, Excel hides the re-
cords that don't meet the criteria and redisplays them when you remove the filter. 
After you filter data, you can sort it, copy it to another location, print it, and so on. 

In the database shown in Figure 15.1, you could filter the data to meet these 
specifications: Employees in the Sales department since 2002. To do this, you 
would have to filter on the Department and Year fields. 

 

SHOW ME  Media 15.3—Filtering Data 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 
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Filtering Data 
To filter data in a database, follow these steps: 

1. Select the range of cells in the database, including the header row. 
 

 

 
 

If your database is set up in such a way that the header row is in 
row 1 or there is at least one blank row above the header, you do 
not have to select the database range. You can click in any cell in 
the database. 



2. Click the Filter button on the Standard toolbar or press Cmd-Shift-R. Excel 
adds pop-up buttons to all the headings. 

3. Click the pop-up button for the field on which you want to filter. The window 
shown in Figure 15.3 opens. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 15.3 The name of the field, Last Review, appears at the top of the window. 

 

4. Click the Choose One pop-up button and click an operator (Equals, Does 
Not Equal, Begins With, Contains, Before, After, and so on). 

5. Depending on the type of field and the operator you select, either fill in the 
blank field next to Choose One or select a value from the list. Again, de-
pending on the operator you selected, you might be able to specify an And 
or Or option (see Figure 15.4). Excel filters the list immediately and adds a 
filter icon to the field's pop-up arrow button. 

 

 

 
 

6. To filter the data further, repeat steps 3, 4, and 5 for as many additional 
fields as needed. 

7. When finished specifying filters, click the Close button to close the filter 
window. 

To remove filtering, click in any cell in the database and click the Filter button on 
the Standard toolbar. 

 
 
 
 
 

If the field is a date field, the list groups values under the year and 
month. To see the values, click the reveal button by the year or 
month. 



 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 15.4 The Before operator selected in this filter allows for additional And or Or 
criteria. 

 

Working with Additional Sheets 
By default, a new, blank workbook has only one sheet. You can add more sheets 
as you need them. I like to use different worksheets to organize data. I might 
have a sheet to track my time, separate sheets to track each project I'm working 
on, and a sheet to summarize everything. I can go quickly to the appropriate data 
by clicking the tab for the sheet. 

Adding and Renaming Sheets 
To add a worksheet, click the Insert Sheet button, located to the right of the last 
sheet tab. (It has a plus sign on it.) You might have to scroll to see the Insert 
Sheet button if you already have quite a few sheets. A new worksheet opens, 
and Excel positions it to the right of the last sheet. The generic name of a new 
worksheet is Sheetn, where n equals the total number of worksheets in the work-
book. 

 

 

 
 

When you have several sheets in the workbook already, you can 
add a number of new sheets at once by selecting multiple existing 
sheets before you click the Insert Sheet button. Excel adds new 
sheets equal to the number of sheets you selected. 



Generic sheet names are not very helpful, but you can rename sheets with more 
significant names. To rename a sheet, right-click the sheet tab, and click Re-
name or simply double-click the sheet tab. Then type the new name and press 
Return. You can name sheets with very short names or with complete sentences 
if you want. I recommend you keep the names as short as possible so the tabs 
take up a minimum amount of space. When the tabs fill up the space allotted to 
them, you have to use the scrolling buttons on the far left of the tabs to navigate. 

 

 

 
 

Deleting a Sheet 
To delete a sheet, right-click the sheet and click Delete. Excel warns you that the 
data in the sheet will be permanently deleted. (This means that clicking the Undo 
button will not retrieve the deleted sheet and its data.) Click OK to delete or click 
Cancel if you need to reconsider. 

Copying a Sheet 
If you have a sheet that you want to use as a template for another sheet, to run 
some different what-if scenarios, for example, you can copy a sheet. To copy a 
sheet, right-click the sheet and click Move or Copy. Click the Create a Copy 
check box, and click OK. The new sheet uses the name of the original sheet with 
a "2" appended. You can rename the sheet (as explained earlier) and move it to 
a different location (as explained next). 

Moving a Sheet 
To move a sheet, drag the sheet tab to the left or right. A black line with an arrow 
at the top marks the location of the sheet as you drag it. Drop it in the desired  
location. 

Hiding and Unhiding a Sheet 
If you have so many sheets that you are constantly having to scroll left and right 
to select the sheet you want, you might want to hide some of the sheets you 
aren't using all the time. Another reason you might want to hide a sheet is simply 
to hide it from a viewer. For example, if you are giving a presentation with the 

To make room for the display of more sheet tabs, drag the horizon-
tal scrollbar to the right to make it smaller. 



workbook, and you don't want the audience to know about some of the other 
sheets in the workbook, you can hide them for the presentation. 

To hide a sheet, right-click the sheet tab and click Hide. To unhide a sheet, right-
click any sheet tab and click Unhide. A dialog box displays with a list of all hidden 
sheets. Select the one you want to unhide and click OK. (Unfortunately, you can-
not select more than one sheet at a time to unhide.) 

Working with Grouped Sheets 
In Figure 15.5, you see a sheet that lists the quarterly sales by city for the year 
2011. Notice there is a sheet for 2010 and 2009. All the sheets are identical in 
layout. To save yourself lots of time, you can create the layout for all sheets at 
the same time by grouping the sheets before you start entering the titles, column 
and row headings, and formulas.  

 

 

 
 

 
 

Grouping Sheets 
When you group sheets, any changes you make to one sheet are made in every 
sheet in the group. These changes include entering and formatting text; inserting 
or deleting columns or rows; changing column widths, row heights, alignment; 
and so on. For this reason, Excel displays an indicator to the right of the file 
name in the title bar to remind you that you are in the Group mode, as shown in 
Figure 15.5. 

To set up the example like the one in Figure 15.5, first insert all the sheets you 
need in the workbook. In the example, I needed two more sheets. Rename each 
sheet with an appropriate name. In this case, I named each tab with the corre-
sponding year. Group the sheets by clicking the sheet tab for the first sheet in the 
range and then Shift-clicking the last sheet. (You also can do this from the oppo-
site end, clicking the last sheet in the range and Shift-clicking the first sheet.) The 
sheet you click first when selecting the sheets for the group will be the sheet that 

This method of creating multiple sheets with the same layout has 
an advantage over simply creating one as a template and copying 
it. Invariably, once you have copied the template, you need to 
tweak it. Then you have to delete the first copies and copy the 
original again. When sheets are grouped, you can tweak all of 
them at once.  



is on top. You can enter data on that sheet or click any sheet tab in the group 
and enter data on that sheet. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 15.5 All three sheets are grouped, and sheet 2011 is on top. 

 
 

Ungrouping Sheets 
If you need to make a change to just one sheet, you should ungroup the sheets, 
make the change, and then group your sheets again to continue making changes 
to all sheets at once. In the example in Figure 15.5, the title on each sheet is 
"Sales for." To add the appropriate year in each title, you would ungroup the 
sheets, add the year to the title on each sheet, and then group the sheets again. 
To ungroup the sheets, right-click any sheet tab in the group and click Ungroup 
Sheets, or click any visible tab of a sheet not included in the group. 

 

 

 
 

You must pay close attention while you are working in groups. You 
can easily get distracted and do a little something on a sheet that is 
not in the group and then return to the task at hand thinking you 
are still working in Group mode. When you click a sheet that is not 
in the group, you automatically ungroup. 



Using 3D Formulas 
Workbooks that have a purpose similar to the example in Figure 15.5 often have 
a summary sheet that calculates all the data in the individual sheets. When 
sheets have data in identical cells or ranges of cells, you can use 3D formulas to 
perform calculations on all the data. A 3D formula is one that references the 
same cell or range on multiple spreadsheets. 

Using the Proper Syntax for 3D Formulas 
A 3D formula references the cells in multiple sheets by listing the range of sheets 
(using their names) followed by the cell address or range address. It uses a co-
lon to denote a range of sheets and cell addresses, and it uses an exclamation 
point to separate the sheet range from the cell addresses. Notice the syntax for a 
typical SUM formula: 

=SUM(Sheet1:Sheet3!A2:B5). 

This formula adds the values in the cell range from A2 to B5 on Sheet1, Sheet2, 
and Sheet3. 

For the workbook shown previously in Figure 15.5, you could add a sheet to cal-
culate all the totals for each city for the three-year period. In Figure 15.6, you see 
the summary sheet that totals or summarizes the sales for all three years. The 
SUM formula in cell B3 looks like this: 

=SUM(2011:2009!B3). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 15.6 The SUM formula adds Atlanta's first quarter values for 2011 through 
2009. 

Entering 3D Formulas by Pointing 
In the "Entering a Formula or Function" section in Chapter 13, "Getting Started 
with Excel," you saw how to use the pointing method to enter one-dimensional 
formulas and functions. You also can use the pointing method to enter 3D formu-
las. 

 

SHOW ME  Media 15.4—Using the Pointing Method for 3D  
Formulas 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

  

LET ME TRY IT 

Using the Pointing Method for 3D Formulas 
You generally enter a 3D function on a sheet that summarizes all the other 
sheets. Because you might have been grouping the sheets before working on 
just the summary sheet, be sure you are not in the Group mode before you start. 
To enter a 3D function by pointing, follow these steps: 

1. Click in the cell on the summary sheet where the function should be en-
tered and type the beginning of the function, as in =sum(. 



2. Click the tab of the first sheet in the range. 

3. Shift-click the tab of the last sheet in the range. 

4. Click the cell or select a range. 

5. Type the close parenthesis and press Return. 



16 This chapter covers the collaborative 
editing and reviewing tools in Word, Excel, 
and PowerPoint. 

Using Review Features 
The two chapters in this section relate to working with others on the same files. 
This chapter covers the techniques of editing files (Word documents, Excel 
workbooks, and PowerPoint presentations) so that everyone who is working on a 
file can see the edits that have been made and so that the edits can ultimately be 
discarded or incorporated in the final version. 

Examining the Editorial Process 
Whether you're writing a legal contract, creating a worksheet for the company's 
new budget, or building a slide presentation to present your new idea to the Ex-
ecutive Leadership Team, it's always better to have a second set of eyes look at 
your work before you submit the final version. This is the underlying principle of 
the editorial process, which in its simplest form involves the following steps: 

1. An author creates a file and sends it to an editor (or multiple editors) to edit. 

2. The editor edits the file and sends it back to the author for approval. 

3. The author reviews the edits and makes the final decision about what 
changes to keep or discard in the final version. 

To facilitate the editorial process, Office provides Review tools. These tools in-
clude Comments, which allow editors to make comments without entering text di-
rectly in the body of the file; Track Changes, which call attention to edits using 
different colors; and Accept, Accept All, Reject, and Reject All buttons, which in-
corporate edits or delete edits automatically (with absolutely no additional work 
on the author's part). Office also attaches information to each edit that lists the 
edit, the editor's name, and the date and time of the edit. 

 

 

 
 

The Review tools that Office supplies for the editorial process come in slightly dif-
ferent flavors in each of the three main file-producing applications: Word, Excel, 

The editor's name is retrieved from the computer owner's contact in 
the Outlook Address Book. 



and PowerPoint. The next three sections take a close look at how to use Review 
tools in each application. As you might expect, the Review tools reside on the 
Review tab on the ribbon. This chapter focuses on this tab exclusively. 

Reviewing Word Documents 
The Review tools are the most robust in Word, which is what you would expect, 
because the majority of files that go through an editorial process are Word files. 
Figure 16.1 shows part of the Review tab in Word.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 16.1 Use Word's Review tab to assist in tracking and reviewing edits. 

 
 
 
 
 
 
 

 

 
 

To explain the reviewing features in Word, I follow the processes that both the 
author and the editor go through. Each heading in this section is preceded by the 
words Author or Editor to distinguish who does what, and I select you to play the 
starring role of the author. 

Author: Getting a Document Ready for an 
Editor 

Before you send your completed document to an editor, you can turn on Track 
Changes so that Word will mark any changes the editor makes to the document. 
This step is not absolutely necessary because the editor can turn on Track 
Changes before making edits, but if you give this control to the editor, the editor 
can turn them off just as easily! If you turn on Track Changes, you also can pro-
tect the document so that the editor cannot turn off Track Changes. This protects 
your original text so that nothing is accidentally changed without being marked as 
a change.  

 
 
 
 
 
 
 
 

If you are using a low screen resolution, some of the button labels 
do not display on the ribbon. Refer to Figure 16.1 for the button 
names used in the following sets of steps if you need help finding a 
button. 



 
 
 
 
 
 
 
 
 
 
  

LET ME TRY IT 

Turning On and Protecting Track Changes in Word 
To turn on Track Changes and then protect the document so Track Changes 
cannot be turned off, follow these steps: 

1. Open the document you want to send to the editor and make any last 
changes you want to make before turning on Track Changes. 

2. Click the Review tab on the ribbon and click the Track Changes button. The 
button changes to On. 

3. Click the Document button under Protection. The Protect Document dialog 
box opens, as shown in Figure 16.2. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 16.2 Tracked Changes is selected by default. 

 

4. Type a password to ensure that no one can turn off Track Changes without 
the password and click OK. 

5. Retype the password and click OK. The Track Changes On/Off switch be-
comes inaccessible on the ribbon. 

 

 

 
 

If you are not worried about protecting track changes, you can sim-
ply click OK in step 4 instead of typing a password, and the dialog 
box closes.  



Editor: Making Changes to the Document 
If the author has not turned on Track Changes, that is the first step the editor 
should take. If this feature is already turned on, all the editor has to do is start in-
serting text, deleting text, moving text around, and so on. If the editor needs to 
tell the author something or ask a question, the editor can insert a comment in-
stead of typing directly in the document. 

Word emphasizes each change the editor makes in some way. For example, de-
pending on the preferences you have set and the markup view you select, Word 
might show inserted text in a different color type and underline it or show it in a 
balloon in the right margin space; it might show deleted text in place with strike-
through or in a balloon in the right margin space. (See Figure 6.3 for a picture of 
balloons.) 

 

 

 
 

  

LET ME TRY IT 

Inserting a Comment in Word 
To insert a comment, follow these steps: 

1. Click in the document in an appropriate place. For example, if the comment 
refers to a particular paragraph, click at the beginning or end of the para-
graph. 

2. Click the New button under Comments on the Review tab on the ribbon. 
(Refer to Figure 16.1.) 

3. Type the text of the comment in the comment balloon and then click back in 
the document. 

Author: Reviewing the Edits 
When you get the document back from the editor, you can give the document a 
quick read-through to get an idea of what the editor changed. First, you should 
make sure that all markups are showing so you get a complete overview. Click 
the Show Markup button and make sure that all options are checked. (Of course, 

To set preferences for Track Changes, click Word on the menu bar 
and click Preferences, and then click Track Changes. Set the pref-
erences and click OK. 



if you just want to concentrate on one type of edit or just on comments, you can 
uncheck the markups that you don't want to see.) 

Next, click the button above the Show Markup button and select the view. You 
can view the document in four different ways, as described in Table 16.1. 

 
 
 
 
 
 
 
 
 
 
 

Table 16.1 Markup Views 

View Description 

Final Showing Markup Shows inserted text in place and deleted text in 
a balloon in the margin 

Final Shows what the final version will look like if you 
accept all the editor's changes 

Original Showing Markup Shows inserted text in a balloon in the margin 
and deleted text in place with strikethrough  

Original Shows the document with no edits 
. 

When you start scanning the document for edits, look for the vertical bars in the 
left margin. Word inserts these bars beside areas that have edits. Figure 16.3 
shows a document that has been marked up with Track Changes turned on. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 16.3 Word refers to the boxes in the right margin as "balloons." 

 
 

After you get a sense of how you will proceed, you can begin accepting and re-
jecting changes and comments. If the edits are few and you like all of them, or 
you don't like any of them, you can accept or reject all changes at once: 

▪ To accept all changes, click the Accept pop-up button, and click Accept 
All Changes in Document. 



▪ To reject all changes, click the Reject pop-up button, and click Reject All 
Changes in Document. 

Note that using this all-or-nothing method does not accept or reject comments. If 
you have comments that you want to review, use the Next button (in the Com-
ments section on the ribbon) to go to each one. To delete a selected comment, 
click the Delete button on the ribbon or the Delete button in the Comment  
balloon. 

 

SHOW ME  Media 16.1—Reviewing Each Edit and Comment in 
Word 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 
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Reviewing Each Edit and Comment in Word 
If you need to make a decision to either accept or reject each edit or comment, 
you can go through the document one item at a time by following these steps: 

1. Turn off Track Changes so you can make your own edits in the document 
as you go along. 

2. Start at the beginning of the document and click the Next button (in the 
Changes section, not the Comments section). Word moves to the first edit 
or comment. 

3. Do one of the following: 

▪ Click the Accept button on the ribbon or in the balloon in the margin. 
Word incorporates a change or leaves a comment in place and moves to 
the next item in the document. 

▪ Click the Reject button on the ribbon or in the balloon in the margin. 
Word returns the text to original or deletes the comment and moves to 
the next item in the document. 

▪ Click the Next button on the ribbon. Word skips the change and moves 
to the next item in the document. 

4. Repeat step 3 until you have processed all the edits and comments. Word 
displays a notice when there are no more comments or tracked changes in 
the document.  



Reviewing Excel Workbooks 
Figure 16.4 shows part of the Review tab on the Excel ribbon. As you can see, 
it's quite a bit different from Word's Review tab. This section on Excel follows the 
same format of explaining the process from both the author's and editor's view-
points. You are still the star of the show, playing the role of the workbook author. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 16.4 The Review tab in Excel doesn't have all the buttons you find on Word's 
Review tab, but at least they all have names! 

 

Author: Getting a Workbook Ready for an 
Editor 

Before you send your workbook out for review, you can turn on Track Changes. 
Turning on Track Changes automatically turns on workbook sharing, and Excel 
reminds you that the workbook is in Shared mode by displaying [Shared] beside 
the filename in the title bar. 

  

LET ME TRY IT 

Turning on Track Changes in a Workbook 
To turn on Track Changes, follow these steps: 

1. Click Track Changes on the Review tab and click Highlight Changes. The 
Highlight Changes dialog box opens, as shown in Figure 16.5. 

2. Click Track Changes While Editing. 

3. Set options for When, Who, and Where and click OK. 

After you turn on Track Changes, it's also a good idea to protect the changes. 
Doing so makes the Track Changes command inaccessible so that you cannot 
turn it off without unprotecting the feature. Protecting the Track Changes feature 
discourages someone from turning it off and sends the message, "I prefer that 
you leave Track Changes on while you are handling this document." 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 
 
 
 
 
 

 

Figure 16.5 Highlight Changes On Screen is selected by default in this dialog box. 

  

LET ME TRY IT 

Protecting Track Changes 
To make the Track Changes command inaccessible, follow these steps: 

1. Click the Share Workbook button on the Review tab. 

2. Click Protect Shared Workbook. 

3. Click Sharing with Track Changes and click OK. 

If you want to make sure that no one but you turns off Track Changes, you can 
password-protect the workbook. You might want to do this if several editors are 
editing the worksheet online simultaneously. If anyone turns off Track Changes 
during the editorial process, Excel removes the workbook from shared use, and 
users who are making edits simultaneously to the document will not be able to 
save their changes. You cannot rectify the situation by turning Track Changes 
back on again. 

 

SHOW ME  Media 16.2—Turning On and Protecting Track 
Changes in Excel 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

 



LET ME TRY IT 

Turning On and Protecting Track Changes in Excel 
To password-protect and turn on Track Changes, follow these steps: 

1. Open the workbook and make any last changes before turning on Track 
Changes. 

2. Click the Review tab on the ribbon and click Share Workbook. 

3. Click Protect Shared Workbook. The Protect Shared Workbook dialog box 
opens. 

4. Click Sharing with Track Changes. 

5. Enter a password and click OK. 
 

 

 
 

6. Reenter the password and click OK. This step simultaneously turns on 
Track Changes, protects the document so no one can turn off Track 
Changes, and saves the document. At this point, you might want to set op-
tions for When, Who, and Where, as described earlier. 

Excel highlights changes to a worksheet in the following ways: 

▪ It displays a colored triangle in the upper-left corner of an edited cell. 

▪ It changes the column and row headings to red type for an edited cell. 

▪ It puts a colored outline around an entire column or row that has been  
inserted. 

▪ It displays a thick colored line where a column or row has been deleted. 

▪ It puts a red triangle in the upper-right corner of a cell with a comment. 

Unlike Word, Excel doesn't highlight every type of change made in a worksheet. 
For example, Excel doesn't highlight the following changes: 

▪ Font or alignment changes 

You can add a password only when the workbook is unshared at 
the time of protection. So, if you want to add a password, you must 
not turn on Track Changes first because this automatically puts the 
workbook in Shared mode. Protecting a workbook automatically 
turns on Track Changes and makes the option to turn it off inac-
cessible. 



▪ Number format changes 

▪ Change to the width of a column 

▪ Change to the height of a row 

Editor: Making Changes to the Workbook 
If the author has turned on Track Changes, all the editor has to do is start editing. 
The editor can make changes on any sheet in the workbook, and Excel keeps 
track of the changes. If the author has not turned on Track Changes, then, of 
course, the editor should. 

Like Word, Excel attaches a pop-up to every edit or comment. The pop-up con-
tains the edit, the editor's name, and the date and time of an edit. The editor 
should ensure that this information is correct by making sure his or her name ap-
pears correctly in Outlook Contacts and that the computer has the correct date 
and time. 

If the editor needs to ask questions or make a suggestion, the editor can insert a 
comment. Excel attaches the comment to a cell, and a cell can have only one 
comment. Note that the Comment feature is not always used as an editing fea-
ture. You can add comments to a worksheet for other purposes. 
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Inserting a Comment in a Worksheet 
To insert a comment, follow these steps: 

1. Click in the cell that should be associated with the comment. 

2. Click the New button under Comments on the Review tab on the ribbon. 

3. Type the text of the comment in the comment box, and then click back in 
the worksheet. A red triangle appears in the upper-right corner of the cell. 

 

 

 
 

To delete a comment, click the cell that has the comment and click 
the Delete button on the Review tab. 



Author: Reviewing the Worksheet Edits 
When you get the workbook file back from the editor, you can open the Highlight 
Changes dialog box (Tools, Track Changes, Highlight Changes) and set the  
options for the highlighting you want to see. For example, you can choose to see 
all edits made by everyone, or you can choose to see only the edits made by a 
particular editor. 

For a very detailed look at the changes, you can look at the history that Excel 
keeps from the time Track Changes is turned on until it is turned off. You can see 
this history on a separate sheet.  
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Viewing the History Sheet 
To view the history sheet, follow these steps: 

1. Save the workbook if any changes have been made. 

2. Click Track Changes on the Review tab and click Highlight Changes. 

3. Uncheck When, Who, and Where. 

4. Click List Change on a New Sheet and click OK. Excel creates a new, pro-
tected sheet called History, as shown in Figure 16.6. 

5. To delete the sheet, open the Highlight Changes dialog box again and un-
check List Changes on a New Sheet. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 16.6 The history on the sheet is for a specific date and time, as shown in  
row 8. 

 



 

After looking at the changes to the workbook, you can accept or reject all of them 
at once, or cycle through each change and accept or reject each one individually. 

 

SHOW ME  Media 16.3—Accepting and Rejecting Changes in  
Excel 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

LET ME TRY IT 

Accepting and Rejecting Changes in Excel 
To accept or reject changes, follow these steps: 

1. Click Track Changes on the Review tab on the ribbon. 

2. Click Accept or Reject Changes. The Select Changes to Accept or Reject 
dialog box opens, as shown in Figure 16.7. When and Not Yet Reviewed 
are automatically selected. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 16.7 The Who box lists names of individual editors who have edited the work-
book. 

 

3. Check the Who box, which has Everyone automatically selected, and then 
click OK. The first change displays in the dialog box, and the area is high-
lighted on the worksheet, as shown in Figure 16.8. 

4. Do one of the following: 

 To review edits one by one, click Accept or Reject. Excel accepts the edit 
or reverts to the original and then goes to the next edit. (Note that Excel 
has no Next or Previous button that enables you to skip an edit. You must 



make a decision on every edit or click Close to stop the process.) Repeat 
this step until finished. 

 Click Accept All or Reject All. (You can click either of these buttons at any 
time.) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 16.8 You might need to move the dialog box to see the highlighted area on 
the worksheet. 

  

LET ME TRY IT 

Reviewing Worksheet Comments 
The process to accept or reject changes in a worksheet excludes comments. To 
perform a separate review for comments, follow these steps: 

1. Click in cell A1 to begin searching for comments from the beginning of the 
worksheet. 

2. Click Next (in the Comments section on the Review tab). 

3. To delete the comment, click the Delete button (in the Comments section) 
and click the Next button to go to the next comment. To keep the comment 
and go to the next one, click Next.  

Reviewing PowerPoint Presentations 
PowerPoint cannot track changes directly in a PowerPoint presentation. If you 
want someone to edit your presentation so you can review the changes and ac-
cept or reject them, you have to give the editor a copy of the file. The editor 
makes changes in the copy, adds comments, and gives the file back to you. The 
changes the editor makes in the copy are not highlighted in any way, but you can 
view any comments the editor inserted. (They show up as numbered yellow 
boxes on the slides.) You can review all the comments one at a time and delete 



them when appropriate, but to review the edits, you must first perform a compari-
son between the two files. In the comparison process, PowerPoint lists the differ-
ences in the two files, and you can go to each item and accept or reject it. 

 
 
 
 
 
 
 
 
  

LET ME TRY IT 

Inserting a Comment on a Slide 
To insert a comment, follow these steps: 

1. In normal view, select the slide that should contain the comment. 

2. If you want to place the comment close to an element on the slide, click the 
element. 

3. On the Review tab, click the New button. A yellow note opens. 

4. Type the comment and click the Close button in the note. The note appears 
as a numbered yellow box. (If you selected a slide element in step 2, the 
note appears close to the element.) 

  

LET ME TRY IT 

Reviewing Comments in a Presentation 
To review comments, follow these steps: 

1. Click the Review tab, click the Next button, and read the comment. 

2. At this point, instead of deleting the comment, I like to read all the com-
ments in the file to get an overview; therefore, I recommend that you click 
the Next button to go to each comment. Click the Previous button to back 
up and reread a comment. After reading all the comments, you will have a 
better idea of what you want to do with each comment. 

3. Return to the first slide and click the Next button. If you want to delete the 
comment, click the Delete button and select Delete Comment. (If you've 
read all the comments and know you want to delete them all, select Delete 
All Comments in Presentation after you click the Delete button.) 

4. If you don't delete all comments at once, continue going to the next com-
ment and deleting as necessary. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



SHOW ME  Media 16.4—Comparing and Reviewing Presentations 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

 
 
 
 
 
 

LET ME TRY IT 

Comparing and Reviewing Presentations 
To compare a file and an edited copy of the original file and then accept or reject 
the changes, follow these steps: 

1. Open the original file in PowerPoint. 

2. On the Review tab on the ribbon, click Compare, navigate to the copy of 
the file that contains the edits, and double-click the file. PowerPoint com-
pares the two files and opens the Compare Changes window, as shown in 
Figure 16.9. PowerPoint goes to the first slide in the presentation that has a 
change and shows the slide from the edited version at the bottom of the 
Compare Changes window. This window lists all the differences between 
the two presentations using a hierarchical list with reveal buttons that ex-
pand or collapse the changes on each slide. Each slide and each change 
on a slide has its own Accept and Reject buttons in the listing. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 16.9 Click the reveal button beside any item in the list to expand the item. 



3. Select a change listed under the slide number and click the Accept or Re-
ject button for the selected change. Alternatively, if you want to accept or 
reject all the changes on one slide, click the Accept or Reject button on the 
slide number level. (Every item in the hierarchical listing remains in the list 
even after you accept or reject it.) 

 

 

 
 

 

4. Click the next slide number. PowerPoint automatically expands the slide to 
show the changes. Repeat step 3. 

5. Continue selecting slides and accepting or rejecting changes until you pro-
cess all changes. 

6. Click the Close button in the Compare Changes window and click End 
Comparison. Any changes you did not accept are discarded. 

Sometimes it is not possible to Reject a change. For example, if the 
change is a deletion of a slide, PowerPoint gives you an Accept 
button, but the Reject button is inaccessible. In this case, you just 
ignore the change to reject it. 



17 This chapter covers collaboration features 
of Office for Mac 2011.   

Collaborating 
This chapter tells you about several methods of collaborating that Office for Mac 
2011 provides. It covers Microsoft Document Connection and cloud computing, 
broadcasting a PowerPoint presentation on the Microsoft PowerPoint Broadcast 
Service, and using Remote Desktop. 

 

 

 
 

Surveying the Collaboration Landscape 
In Office for Mac 2011, Microsoft offers many new and enhanced collaboration 
features. Following are the ones discussed in this chapter: 

▪ Co-authoring—The ability for multiple users to simultaneously work on the 
same file from different computers. While users are working simultane-
ously, they can see who else is working at the same time and see the 
changes they make to a file because the file updates automatically with all 
edits. Users can protect areas they are working on from being edited by 
other collaborators and can resolve editing conflicts.  
 
Note that co-authoring is supported in Word and PowerPoint within Office 
for Mac 2011, but co-authoring in Excel is supported only in the Excel Web 
Application. Conversely, the Word and PowerPoint Web Applications do 
not support co-authoring. 

▪ SharePoint and SkyDrive—Microsoft cloud storage services where users 
can store, access, edit, and save changes to their files. SharePoint is a cli-
ent/server application that large corporations may purchase and provide to 

Cloud computing is the Internet-based provision of shared re-
sources, software, and information provided to users on demand. 
Most cloud computing infrastructures are built on servers. Share-
Point and SkyDrive are the two Microsoft cloud computing servers, 
but SharePoint is beyond the scope of this book, so the emphasis 
in this chapter is on SkyDrive. 



their users. SkyDrive is a server that Microsoft makes freely available to the 
public at large. SkyDrive, part of the Windows Live services, enables you to 
have 25GB of online storage, and you can use it for co-authoring. Microsoft 
Document Connection is the Office for Mac 2011 application that you use 
to access either of these cloud services. 

▪ Rich Presence Everywhere—Valuable presence information about con-
tacts based on a contact's calendar activity. I'm not sure if "everywhere" 
accurately describes this feature, but it is available in Outlook and, when 
you are co-authoring, in Word and PowerPoint. 
 
Presence is the key factor in determining whether a person is available for 
real-time communication and collaboration. Office retrieves the information 
directly from the Exchange server so the information is available to a user 
whether or not the user has Outlook running. Office updates the information 
automatically as a user's status changes. Users who are not on an Ex-
change Server can receive some limited information about users who are 
collaborating if both users are logged in to Messenger or Communicator. 

▪ Office Web Applications—Versions of Word, Excel, and PowerPoint that 
run on the Web via SharePoint (must be configured for Web Apps on 
SharePoint 2010) or SkyDrive. 

▪ Presentation Broadcasting—Presenting a presentation on the Web to 
multiple users simultaneously. 

▪ Remote Screen Sharing—The ability to give control of your computer to a 
remote user. 

Using Microsoft Document Connection 
The Office for Mac 2011 application that connects with SharePoint and SkyDrive 
is Microsoft Document Connection. Using this application, you can upload files to 
the cloud server, and then open, edit, and share them with other users. Each file 
that you upload to the server has a URL that you can send to another user as a 
hyperlink to open the file. 

Before you can use the Document Connection application to connect to the 
server, you must have a valid login and password for a SharePoint server (usu-
ally supplied by the SharePoint administrator) or a Windows Live ID for SkyDrive. 

 

 

 
  

If you don't have a Windows Live ID, do a web search for "windows 
live id" and sign up for one. It's free! 



LET ME TRY IT 

Connecting to SkyDrive 
To connect to SkyDrive, follow these steps: 

1. Launch the Document Connection application.  

2. Click Add Location on the toolbar. 

3. Click Sign in to SkyDrive. 

4. Enter your Windows Live ID and password. 

5. Click Connect. The location displays under SKYDRIVE in the navigation 
pane, and the folders you have on SkyDrive display in the right pane. By 
default, you start with a folder on SkyDrive called, in true Microsoft form, 
My Documents. This protected folder is not accessible by anyone but you. 
If you want to make files accessible to other users for reading or editing, 
you must create a folder on SkyDrive that has the corresponding permis-
sion rights and put the files in that folder. 

 

 

 

Exploring the Document Connection Window 
Figure 17.1 shows the Document Connection window. The toolbar at the top has 
buttons for adding, editing, and reading files. Some of the buttons on the toolbar 
are specific to SharePoint. They include New File, Upload, Check Out, Check In, 
and Discard. 

Under the toolbar is the navigation pane on the left and the navigation bar on the 
right, just above the list pane. By default, the navigation pane lists the following 
categories: FILES, SHAREPOINT, and SKYDRIVE. The two folders you see un-
der FILES—Drafts and Favorite Files—are also default folders. (The Drafts folder 
lists documents you have checked out on SharePoint. The folder is not accessi-
ble on SkyDrive.) 

When you make a connection to SharePoint or SkyDrive, the connection name 
appears under the appropriate category in the navigation pane, as shown in the 
figure. The buttons at the bottom of the navigation pane (with a plus and minus 
on them) add or remove locations. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Even if you have more than one Windows Live ID, you can make a 
connection with SkyDrive with only one account at a time. 



 
 
 
 
 
 
 
 
 
 
 

 

Figure 17.1 The files in the list pane are located in the My Document folder. 

 

The list pane on the right shows the names of folders and files for the selected 
location. You can navigate through the folders in this pane by using the naviga-
tion bar above it. 

 

SHOW ME  Media 17.1—Touring the Document Connection  
Window 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

Putting Files on SkyDrive 
Before putting files on SkyDrive, you might want to go to Windows Live on the 
Web, log in, and go to SkyDrive to create some folders because you can't do this 
in Document Connection. When you create new folders on SkyDrive, you can 
create protected folders that only you can access, or you can create folders with 
permission levels that allow other users to access the files in various ways.  

 

 



 
 

After you organize SkyDrive with the folders you need, you can use two different 
methods to upload files to those folders. You can upload files from Document 
Connection or save files directly to the SkyDrive from within Word, PowerPoint, 
or Excel. 

 

SHOW ME  Media 17.2—Uploading Files to a SkyDrive Folder 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

  

LET ME TRY IT 

Uploading Files to a SkyDrive Folder 
Although you have a total of 25GB of available storage space on SkyDrive, Mi-
crosoft restricts you to uploading files no larger than 50MB each. To upload a file 
to a folder on SkyDrive, follow these steps: 

1. Open Document Connect and connect to SkyDrive, if necessary. 

2. Open the folder on SkyDrive where you want to add the file by double-
clicking the folder in the list pane. 

3. On the Document Connection toolbar, click the Add File button, navigate to 
the file you want to add to SkyDrive, select it, and click Upload. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

Additionally, you can drag files from the Finder to the list pane of 
Document Connection. 

When you create a folder, you set permissions to specify who has 
the right to view a file and who has the right to add files, edit files, 
and delete files. 



LET ME TRY IT 

Saving a File Directly to SkyDrive 
Another way to add files to SkyDrive is to save a file directly to SkyDrive just as 
you would save a file to your hard drive. You can save a Word, Excel, or Power-
Point file to SkyDrive by following these steps: 

1. When the file is open in its application, click File on the menu bar, point to 
Share, and click Save to SkyDrive. 

2. Type your Windows Live ID and password. 

3. Click Sign In. 

4. Type a different name for the document in the Save As text box if desired. 

5. Select the folder on SkyDrive where you want to save the file. 

6. Click Save. 

Working with Files in the Cloud 
One big advantage to storing files in the cloud, whether you're using SharePoint 
or SkyDrive, is that you can work on the files from any computer anywhere if it 
has an Internet connection and a web browser. The computer doesn't even need 
to have Microsoft Office installed because you can use Microsoft Web Apps to 
edit the files. 

The Web Apps are not as robust as the Office applications, so unless you spe-
cifically need to use the Web Apps, you might prefer to edit files on SharePoint or 
SkyDrive with the Office applications via Document Connection. 

Working with documents on SharePoint is a little more sophisticated than work-
ing with documents on SkyDrive. As I mentioned earlier, SharePoint is beyond 
the scope of this book, but you can learn more about working with documents on 
SharePoint by listening to the following audio recording. 

TELL ME MORE  Media 17.3—Working with Documents on 
SharePoint 
Access this audio recording through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  



LET ME TRY IT 

Editing a File on SkyDrive via Document Connection 
To open and make edits to a file that is stored on your SkyDrive, follow these 
steps: 

1. Open Document Connection, open the folder on SkyDrive that contains the 
file, and select the file you want to edit. 

2. Click the Edit button. The file downloads to your computer and opens in the 
appropriate application. 

3. When finished editing, save the file. The file saves back on SkyDrive, not 
your computer. 

 

 

 
 

  

LET ME TRY IT 

Saving a SkyDrive File to Your Computer 
To save a SkyDrive file to your local computer, follow these steps: 

1. Open Document Connection, open the folder on SkyDrive that contains the 
file, and select the document. 

2. Click File on the menu bar and then click Save As. The filename appears in 
the Save As text box. Change the filename if you want to or just use the 
same name. 

3. Navigate to the folder on your computer where you want to save the file 
and click Save. The file is no longer associated with the file on SkyDrive. 

Collaborating on SkyDrive Files 
When you are collaborating with other users on one of your files, you are working 
on a file that is in a shared folder on the cloud. You have given other users per-
mission to edit the file (using commands in SkyDrive) and have sent them the 
URL of the file so they can open and edit the file. (To get the URL of a file, select 

You can add files that you use frequently to the Favorites folder in 
the navigation pane by dragging them from the SkyDrive folder to 
the Favorites folder. 



the file from within Document Connection, click Edit on the menu bar, and click 
Copy Link.) The collaborating authors open the file in Word or PowerPoint by 
clicking File on the menu bar, clicking Open URL, entering the URL you have 
supplied to them, and clicking Open. 

If you are working on a Word file at the same time as another user, you can 
avoid conflicts in editing by blocking other authors from working on complete sec-
tions of the document. When you're finished with the sections, you can release 
them. If you don't want anyone else ever to work on a section, you can keep it 
blocked until the document is final. 

 

 

 
  

LET ME TRY IT 

Blocking Other Authors 
To block other authors from editing a section of a Word document, follow these 
steps: 

1. Open the document on SkyDrive. (Click File, Open URL, enter the URL, 
and click Open.) 

2. Select the section you want to block. 

3. Click the Review tab and click Block Authors. An icon appears beside the 
section, as shown in Figure 17.2. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

To unblock the sections, click the Block Authors button, and then 
save the file. 

Text is blocked automatically at the paragraph level. No other au-
thor can simultaneously edit within the same paragraph as another 
author. 



 
 
 
 
 
 
 
 
 
 
 

 

Figure 17.2 The Block Authors icon reminds you that you have a section locked. 

 

Broadcasting a PowerPoint Presentation 
Another way to collaborate with remote users is to broadcast a PowerPoint pres-
entation on the Web. You upload the presentation to the web host (Microsoft 
PowerPoint Broadcast Service, a free service of Microsoft) and send the URL of 
the file to the remote users. The users click the link or type it into their browser 
and then follow along in their web browsers as you give the oral presentation 
(probably on a conference call). This is a great way to have a meeting, launch a 
new product, train people on a process, and so on. It's so easy for everyone in 
the audience—no techie stuff involved for the viewers! 

 

SHOW ME  Media 17.4—Presenting a PowerPoint Presentation on 
the Web 
Access this video file through your registered Web edition at 
my.safaribooksonline.com/9780132174718/media. 

  

LET ME TRY IT 

Presenting a PowerPoint Presentation on the Web 
To present a presentation on the Web, follow these steps: 

1. Open the PowerPoint presentation you want to present. 



2. Click the Slide Show tab on the ribbon and click the Broadcast button under 
Play Slide Show. The Broadcast Slide Show dialog box opens, as shown in 
Figure 17.3. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 17.3 PowerPoint Broadcast Service is provided free by Microsoft. 

 
 

3. Click Connect. The file uploads to the Microsoft PowerPoint Broadcast Ser-
vice, and the link for the show displays in the dialog box, as shown in Fig-
ure 17.4. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 17.4 The URL of the slide show displays in the box on the left. 

 

4. Click Send in E-mail, and an e-mail message opens in Outlook. The file-
name is inserted for Subject and the link to the file appears in the body of 
the message. Address the message to the remote users who will view the 
file and click Send. Alternatively, you can click Copy Link and paste the link 
in some other form of communication, such as an instant message. 



5. When everyone has had time to receive the link and click on it (you would 
know this if you were on a conference call), click Play Slide Show. 

 

 

 
 
 
 
 
 

6. When you finish with the show, press Esc as you normally would. 

7. Click the End Broadcast button (in the yellow bar under the ribbon) to dis-
connect all viewers and click End Broadcast in the warning dialog box. 

Remote Desktop 
The application called Remote Desktop Connection facilitates desktop sharing 
and viewing via the instant message application Communicator 8, which is the 
corporate equivalent to the personal application called Messenger. With Remote 
Desktop Connection, a user can initiate or accept a desktop sharing session with 
a remote user. During the session, either user can control the other's desktop. 
This is a good way to provide hardware or software support to a user. 

The Remote Desktop Connection application does not work with Microsoft Mes-
senger, but Mac users who don't have Communicator don't need to feel left out in 
the cold. If you have Mac OS X Snow Leopard, you can already share your desk-
top via iChat and even make video presentations. For more information on shar-
ing your computer or using iChat Theater, refer to my book titled Using Mac OS 
X Snow Leopard, published by Que. 

You can make a presentation with two computers and use the Pre-
senter View just as you are able to do with a live audience. 
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